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A Alfamídia Prow dá Boas Vindas aos seus clientes e deseja um 
excelente treinamento.  

 

- Suporte pós-treinamento via e-mail (3 consultas por 90 dias após o término do curso) para tirar 
dúvidas do 

Benefícios ao aluno 

conteúdo ministrado em aula, através do e-mail matricula@alfamidia.com.br ; 

- Acesso a extranet www.alunoalfamidia.com.br para verificação de agenda e pontos do 
PROGRAMA FIDELIDADE; 

- Convênio com o estacionamento do prédio (desconto); 

- Avaliações de acompanhamento e final de curso (em cada módulo) durante todo o treinamento, 
garantindo a qualidade do curso. 

Observações Importantes 

- É obrigatório que sejam salvos todos os trabalhos efetuados durante a aula, no servidor indicado 
pelo instrutor. 

- Não é permitido entrar em sala de aula com alimentos ou bebidas de qualquer espécie ou fumar 
nas dependências da Alfamídia Prow; 

- Não é permitida a instalação de outros Hardwares ou Softwares que não sejam os utilizados em 
treinamento; 

- O preenchimento da avaliação final de curso/módulo é condição obrigatória para que o aluno 
possa acionar a garantia do curso, conforme previsto na ficha de matrícula; 

- Somente será fornecido certificado ao aluno com assiduidade igual ou superior a 75% do 
treinamento; 

- Qualquer necessidade de alteração na agenda ou cursos contratados inicialmente, consulte os 
Termos de Contratação na Ficha de Matrícula; 

- Contatos com a Alfamídia Prow podem ser feitos através dos e-mails: 

matricula@alfamidia.com.br  – dúvidas após contratação 

info@alfamidia.com.br  – novas contratações

mailto:matricula@alfamidia.com.br�
http://www.alunoalfamidia.com.br/�
mailto:matricula@alfamidia.com.br�
mailto:info@alfamidia.com.br�
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Unidade 1  
Organização do Curso 

1.1 Sobre o Curso 
O curso Adobe Dreamweaver CS4: Desenvolvimento de Websites apresenta aos alunos 
as principais características deste software, visando prepará-los tanto para criar páginas 
HTML simples quanto entender códigos HTML que venham a encontrar. 

Designers dificilmente criarão seus layouts diretamente em HTML, utilizando 
geralmente ferramentas de edição de páginas – como o Dreamweaver – ou ferramentas 
de manipulação de imagens – como o Photoshop. Entretanto, é comum ser necessário 
ajustar os layouts gerados, editando diretamente no HTML, seja para pequenas 
modificações, seja para aplicar recursos que a ferramenta não contempla. Este curso 
também dá uma base mais aprofundada para entender as potencialidades de ferramentas 
de edição de páginas e as restrições de layout impostas pela linguagem HTML 

 

1.2 Estrutura do Curso 
As primeiras unidades apresentam a ferramenta Dreamweaver, uma ferramenta 
profissional para edição de páginas HTML. Apresentam, também, vários elementos da 
linguagem HTML, intercalando com exercícios e exemplos práticos, para melhor 
absorção do conteúdo. 

As unidades seguintes mostram uma visão do CSS e Divs, que permitem controlar o 
layout das páginas HTML de forma muito mais eficiente e precisa. Durante todo o curso 
o aluno construirá um site completo com este software. 

As unidades finais demonstram como gerenciar o site, a partir de modelos e itens de 
biblioteca. Também, é apresenta a aba Spry. 
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Unidade 2 
Introdução ao HTML e Web Standards 

2.1 A Linguagem HTML e a Internet 
A Internet teve início nos Estados Unidos em 1969 sob o nome de ARPANET. 
Composta inicialmente de quatro computadores interligados, ela tinha como finalidade 
demonstrar as potencialidades da construção de redes usando computadores dispersos 
em uma grande área. Em 1972, 50 universidades e instituições militares já possuíam 
conexões. 

Hoje a Internet é uma arquitetura de software e hardware interligados que são mantidas 
por organizações comerciais e governamentais. Uma de suas principais características é 
que não possui um proprietário único, responsável pelo seu funcionamento. Existem 
apenas associações e grupos que se dedicam a desenvolver protocolos e procedimentos 
para suportar a interligação entre os computadores, ratificar padrões e resolver questões 
operacionais. 

Um dos principais elementos que levaram a popularização da Internet foi a World Wide 
Web (teia de abrangência mundial), também conhecida como WWW. Trata-se de uma 
nova forma dos usuários navegarem pelas informações e arquivos disponíveis nos vários 
computadores ligados a Internet. O modelo WWW é tratar todos os dados da Internet 
como hipertexto, isto é, vinculações entre diferentes documentos, para permitir que as 
informações sejam exploradas interativamente e não apenas de uma forma linear. 

A principal linguagem que popularizou a Web, e que ainda é a linguagem mais utilizada 
é o HTML (Hypertext Markup Language), uma linguagem criada com o objetivo de 
formatar informações de um texto e definir os hiperlinks entre um texto e outro, ou seja, 
os pontos de vinculação entre documentos. 

Hoje existem diversas ferramentas que permitem navegar na Internet e visualizar as 
páginas HTML. Estas ferramentas são popularmente conhecidas como navegadores ou 
browsers. Da mesma forma, existem também inúmeros editores visuais, dos quais o 
Adobe Dreamweaver é o mais utilizado, que gravam arquivos no formato HTML. 

2.2 As limitações do HTML 
A linguagem HTML originalmente tinha como propósito apenas definir a estrutura de 
um documento e os hiperlinks entre documentos. Assim, ela permitia especificar quando 
iniciava e terminava um parágrafo, definir títulos, subtítulos, listas numeradas, textos em 
itálico e negrito e outras características semelhantes. 

Quase que imediatamente após seu surgimento, porém, novos recursos começaram a ser 
criados, principalmente voltados para a construção de layouts mais sofisticados. Neste 
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momento surgiram recursos para especificar imagens de fundo, alinhar elementos em 
tabelas, posicionar imagens, entre outros. Muitas destas novidades eram iniciativas das 
empresas que desenvolviam os principais navegadores utilizados na internet, o que 
muitas vezes obrigava o Web Designer a criar páginas diferentes para cada navegador, 
para aproveitar ao máximo os novos recursos recém lançados. 

Dois problemas tiveram sua origem derivada deste contexto: a falta de uma 
padronização, pois diferentes empresas criavam novos recursos próprios para o HTML, 
e a mistura entre layout e conteúdo. Ambos, problemas endereçados pelos Web 
Standards, como será visto ao longo deste curso. 

2.3 Os Web Standards 
O W3C (World Wide Web Consortium), juntamente com outros grupos e organismos 
reguladores, estabeleceu tecnologias para criação e interpretação de conteúdo para a 
Web, visando resolver de forma definitiva os problemas mencionados anteriormente. 

Estas tecnologias, a que chamamos Web Standards, têm como objetivo principal fazer 
com que o conteúdo desenvolvido dentro destes padrões possa ser visualizado 
independente do equipamento (computador, PDA, celular), do tipo do navegador (IE, 
Mozilla, Opera, Netscape, etc.)  e da forma (banda de conexão) com que o usuário 
estiver acessando a Internet. É um conceito de acessibilidade estendido. 

Um dos objetivos dos Web Standards é a separação do conteúdo, definido através de 
linguagens estruturais como XHTML e XML, e do layout, definido através de 
linguagens de apresentação, em particular o CSS (Cascading Style Sheet). Outros Web 
Standards, como o DOM (Document Object Model) e o ECMAScript 262 (versão 
padrão do JavaScript) são voltados para a programação em páginas Web. 

2.4 W3C 
O que é o W3C? 
O World Wide Web Consortium (W3C) é um consórcio de indústrias dedicado em levar 
a Web ao seu potencial máximo. Fundada em 1994 por Tim Berners-Lee (inventor da 
Web), o W3C tem mais de 450 organizações associadas, incluindo Microsoft, América 
Online (incorporou a Netscape Communications), Apple, Adobe, Macromedia, Sun 
Microsystems e uma variedade de outras empresas fabricantes de hardware e software, 
provedores de conteúdo, instituições acadêmicas e empresas de telecomunicações. O 
consórcio tem o apoio (estrutura física e intelectual) de três instituições de pesquisa: 
MIT nos EUA, INRIA na Europa e Keio University no Japão. 

Qual a sua função?  
O W3C desenvolve especificações abertas (padrões) para aumentar a interoperabilidade 
de produtos relacionados com a Web. As recomendações do W3C são desenvolvidas por 
grupos de trabalhos originados das organizações membros e experts convidados. 
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2.5 Por que Entender o HTML? 
O HTML é uma linguagem de marcação utilizada para criar e formatar páginas ou 
documentos Web. Com o tempo passou a ser utilizado para descrever a estrutura dos 
documentos. O HTML permite criar documentos com componentes como cabeçalhos 
(h1, h2,...), parágrafos (p), quebras de linha (br), tabelas (table, tr, td, th), listas (li, ul, 
ol), imagens (img) e links (a). Uma tecnologia complementar foi criada, o Cascading 
Style Sheets (CSS), responsável pela apresentação (formatação visual) dos documentos. 

Novas especificações HTML não serão mais definidas. HTML 4.1 é o último padrão 
HTML, e agora substituído pelo XHTML 1.0. No entanto, o XHTML não é 
substancialmente diferente do HTML, sendo na verdade um subconjunto do HTML que 
segue as regras do XML. Assim sendo, ao dominarmos o HTML, estaremos também 
adquirindo os conhecimentos necessários para desenvolver também em XHTML. 

2.6 Conceitos Básicos de HTML 
Quando um browser exibe uma página HTML, ele lê um arquivo texto (que pode ser 
aberto em qualquer editor de texto) com o conteúdo do site e marcações, chamadas tags, 
que informam os elementos da página e sua formatação. 

As marcações do HTML - tags - consistem do sinal (<), (o símbolo de "menor que"), 
seguida pelo nome da marcação e fechada por (>) ("maior que").  

De um modo geral, as tags aparecem em pares, por exemplo, <h1> Cabeçalho</h1>. O 
símbolo que termina uma determinada marcação é igual àquele que a inicia, antecedido 
por uma barra (/) e precedido pelo texto referente.  

No exemplo, <h1> avisa ao cliente Web para iniciar a formatação do primeiro nível de 
cabeçalho e </h1> avisa que o cabeçalho acabou. 

Há tags que não exigem o fechamento, funcionando – via de regra – com ou sem a 
definição de uma tag de fechamento, como é o caso da tag de definição de parágrafo 
<p>. O padrão mais recente de uso do HTML, entretanto, recomenda que esta tag seja 
sempre fechada, para termos um padrão mais próximo do utilizado em XHTML, como 
será explicado a seguir.  

Outras tags efetivamente não têm marcações de final, como a tag <br> que apenas 
define uma linha em branco, e a tag <hr> que exibe uma linha divisória. 

Este tutorial tem por objetivo mostrar como criar e exibir páginas HTML. Tais páginas 
são criadas a partir de arquivos texto ASCII, contendo caracteres de marcação da 
linguagem HTML. Uma vez criados, estes arquivos são salvos com uma extensão .html 
ou .htm 
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2.7 Tags Básicas 
A seguir apresentamos as tags básicas de uma página HTML, que são suficientes para 
criar uma página mínima. Nas lições seguintes apresentaremos diretamente exercícios 
que incluirão novas tags que permitirão controlar diversas características da página. 

Estas e todas as futuras tags são mostradas dentro de uma estrutura de tabela, para 
facilitar sua consulta, e são repetidas em anexo ao final deste material, de forma a 
facilitar seu uso no futuro como material de referência. 

 
TAG O QUE FAZ 

<!-- comentário --> Insere comentários nas páginas 

<html> Toda página HTML deve estar entre o tag de início de um 
documento HTML e o tag de fim deste documento.  

<head> Envolvem a seção de cabeçalho do documento, no qual são 
especificadas informações que não são exibidas na página, 
como título do documento e informações sobre o assunto da 
página. 

<title> Indica o título do documento para o Browser. Geralmente os 
Browsers apresentam este título na barra de título da sua Janela 
no Windows 

<body> Envolvem a seção de corpo do documento. Aqui fica o conteúdo 
principal da Home Page. Opcionalmente podemos indicar um 
arquivo de imagem para formar o fundo, usando a opção: 
BACKGROUND. 

<br> Insere uma quebra de linha 

2.7.1 Exemplo de HTML com Tags Básicas 

Todo documento HTML deve ser identificado como HTML ( <html>...</html> ), ter 
uma área de cabeçalho ( <head>...</head> ) com o nome do documento ( <title> </title> 
), um título principal e uma área definida como corpo ( <body>...</body> ) do conteúdo 
do documento. Como o exemplo a seguir, basico.html: 

 
<html> 
<head> 
<title>Minha primeira página</title> 
</head> 
<body> 
<!-- aqui temos um comentário que não aparecerá no browser --> 
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Minha primeira página 
</body> 
</html> 

 

2.7.2 Principais Tags HTML 

<br> Quebra de linha; 

<p> Parágrafo; 

<strong> Negrito; 

<em> Itállico; 

<h1> Padrão para títulos. Pode ser de <h1> a <h6>; 

<hr> Marca uma linha horizontal para dividir partes da página; 

<div> Tag de divisão lógica; 

<ul> Listas com marcadores; 

<ol> Listas numeradas; 

<li> Item da lista 

<img> Insere imagem 

<a> Define link 

<table> Tag para criar tabelas; 

<tr> Tag para criar linha da tabela; 

<td> Tag para criar célula da tabela; 

<form> Define um formulário; 

2.8 Cores em HTML 
A definição de cores já foi vista como atributo da tag <font>. Entretanto, para 
efetivamente utilizarmos as cores de forma eficiente no código HTML e necessário 
entender como as mesmas são especificadas na linguagem. 

O uso de cores em HTML pode ser feito através de duas formas básicas, utilizando o 
nome em inglês de algumas cores específicas ou fazendo uso do código hexadecimal 
RGB. O segundo método é mais recomendável, pois permite a definição de todas as 
cores possíveis. 

Exemplos de uso de cores em fonte: 
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<font color= “#000000”>texto em preto</font> 
<font color=”#ffffff”>texto em branco</font> 
<font color=”#ff0000”>texto em vermelho</font> 

 

Nos exemplos acima, valores diferentes de código permitem a definição de cores 
diferentes. É importante entendermos como estas cores são formadas para podermos 
manipular estes códigos, porém na prática geralmente normalmente será utilizado algum 
editor visual para escolher a cor desejada, como a Dreamweaver, por exemplo. 

As cores são definidas pela composição de 3 pares de algarismos, cada um 
representando um valor entre 0 e 255. O primeiro destes pares representa a quantidade 
de vermelho na cor, o segundo a quantidade de verde e o terceiro a quantidade de azul. 
A primeira dificuldade para entender esta codificação se dá pelos números estarem em 
hexadecimal, ou seja, ao invés dos números serem representados com números de 0 a 9, 
são representados por estes números mais as letras A,B,C,D,E,F. 

Felizmente não é essencial entender o mecanismo matemático para converter os 
números, sendo suficiente para a maioria dos casos ter uma noção dos números mais 
utilizados, como mostra a tabela abaixo: 

 
Número codificado 
em hexadecimal 

Valor do mesmo 
em decimal 

00 0 

33 51 

66 102 

99 153 

CC 204 

FF 255 

Estes números são importantes, pois são os únicos utilizados para criar cores chamadas 
web safe que são as cores exibidas pelos browsers em monitores com 256 cores 
configuradas. 
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Unidade 3 – XHTML 

 

 

 

 

 

Razões para existir o XHTML 

Regras de Sintaxe 

Página básica XHTML 

Listas 

Links 

Tabelas 
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Unidade 3 
XHTML 

3.1 Razões para Existir o XHTML 
Existem diferentes tipos de navegadores no mercado atual: alguns rodam Internet em 
computadores pessoais, outros estão instalados em celulares e outros dispositivos 
móveis. É importante que o desenvolvedor tenha em mente que as páginas criadas por 
ele devem ser compatíveis com esses diferentes tipos de tecnologia. É aí que entra o 
XHTML, uma variação do HTML, mas que é estrito e claro como o XML. 

O navegador de um telefone celular, por exemplo, não tem recursos para interpretar uma 
página com HTML mal formatado, ou seja, que tem tags sem finalização ou com aspas 
faltando. A vantagem do código XHTML é que ele não permite nenhum erro, caso 
contrário o documento não será válido. 

Novas especificações HTML não serão mais definidas. HTML 4.01 é o último padrão 
HTML, e agora substituído pelo XHTML 1.0. Desenvolver em XHTML não é 
substancialmente diferente de desenvolver em HTML, mas oferece diversos benefícios, 
principalmente para aplicações mais complexas. O XHTML 1.0 é uma definição de 
HTML em conformidade com as regras do XML. Isso quer dizer que utilizando XHTM 
temos a vantagem de poder utilizar plenamente o HTML, e o poder de manipular 
informações com XML. 

Obs: Dentro do site do W3C (World Wide Web Consortium, em www.w3c.org) existe 
uma ferramenta para validação de documentos eletrônicos da internet. Ela pode ser 
usada tanto para XHTML como para XML ou HTML. O utilitário analisa o documento 
e, caso exista algum erro, informa qual o problema e em qual linha ele se localiza, 
facilitando assim a vida dos desenvolvedores. O endereço da ferramenta é: 
http://validator.w3.org. 

Exemplo: 
 

<?xml version=”1.0” encoding=”iso-8859-1”?> 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
“DTD/xhtml1-transitional.dtd”> 
<html xml:lang=”pt-BR” lang=”pt-BR”  
xmlns=”http://www.w3c.org/1999/xhtml”> 
<head> 
<title> Uso de XHTML </title> 
</head> 
<body> 
 <p>Minha primeira página </p> 
</body> 
</html> 
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Inicialmente precisamos saber que os trechos em destaque servem para informar ao 
navegador que a página se trata de XHTML e que o idioma usado é o português. Esses 
trechos de código precisam estar em todas as páginas XHTML. 

Os documentos XHTML devem ser salvos com as extensões .htm ou .html da mesma 
maneira que os documentos HTML normais. 

3.2 Regras de Sintaxe 
Antes de começar a criar as páginas em XHTML é importante que entendamos os 
principais conceitos desse padrão. A estrutura básica é bastante semelhante à do HTML, 
mas existem algumas regras que precisam ser seguidas sempre. 

3.2.1 Caixa Baixa 

Uma delas é o tipo de caixa (letras maiúsculas ou minúsculas) usado nas tags. O HTML 
permite o uso de caixa alta, enquanto que em XHTML apenas podem ser utilizadas 
letras minúsculas: 

Certo:  
<title> 

Errado: 
<Title> 
<TITLE> 

3.2.2 Elementos sem Conteúdo 

Alguns elementos não possuem conteúdo algum. Para eles, existe uma sintaxe especial. 
Em vez de inserir uma tag de fechamento logo após a tag de abertura, é colocada uma 
barra (/) antes do fechamento da tag inicial para indicar ao navegador que esse elemento 
foi terminado. 

Exemplo:  
<br /> 

A tag <br> no HTML não tem conteúdo. É utilizada para realizar uma quebra de linha. 
No XHTML, essa mesma tag deve ser utilizada como no exemplo anterior para ser 
válida. 

O espaço que aparece antes da barra é necessário para que o código seja suportado por 
navegadores mais antigos, que irão simplesmente ignorar o espaço e o que estiver depois 
dele. 
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3.2.3 Aninhamento 

Uma outra regra rígida do XHTML é a que diz respeito ao aninhamento, ou seja, como 
os elementos se organizam dentro de outros elementos. Como no XML, um elemento 
precisa estar completamente dentro do outro para que o aninhamento esteja correto e o 
documento seja válido. 

Errado: 
 <em>Alfamídia<b>Prow</em></b> 

Assim, como nesse exemplo, o código será inválido. Para ser válido em XHTML o 
código anterior deverá ser escrito da seguinte maneira: 

Correto: 
<em> Alfamídia <b> Prow </b> </em> 

3.2.4 Valores dos Atributos 

Os valores de atributos, em XHTML, devem estar sempre entre aspas: 

Correto: 
<table width="100%"> 

Incorreto: 
<table width=100%> 

 

Além disto, os elementos sempre devem ter um valor definido: 

Incorreto: 
<dl compact> 
<input checked> 
<input readonly> 
<input disabled> 
<option selected> 
<frame noresize> 

 
Correto: 

<dl compact="compact"> 
<input checked="checked" /> 
<input readonly="readonly" /> 
<input disabled="disabled" /> 
<option selected="selected" /> 
<frame noresize="noresize" /> 
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3.2.5 Atributo NAME 

O HTML 4.01 define um atributo NAME para elementos como a, applet, frame, iframe, 
img, e map.  

No XHTML, o atributo NAME foi descontinuado, sendo substituído pelo atributo ID. 
Para manter a compatibilidade com browsers mais antigos, aconselha-se utilizar os dois 
atributos. 

Incorreto: 
<img src="figura.gif" name="figura1" /> 

 
Correto: 

<img src="figura.gif" id="figura1" /> 
<img src="figura.gif" id="figura1" name="figura1" /> 

3.2.6 Elementos Obrigatórios 

Existem quatro elementos que os documentos XHTML precisam obrigatoriamente 
conter. O código HTML, que é mais flexível, permite que alguns desses elementos 
sejam omitidos, mas no XHTML eles devem estar sempre presentes. São eles: 

<html> 
<head> 
<title> 
<body> 

Cada um desses elementos possui a sua tag específica para fechamento e devem ser 
declaradas em uma ordem conforme visto no primeiro exemplo desse capítulo. 

3.2.7 Declaração DOCTYPE 

A tag DOCTYPE é usada para declarar o DTD (Document Type Definition) de um 
documento XHTML. Um DTD é uma coleção de declarações que define a estrutura, 
elementos e atributos que podem ser usados em um determinado tipo de documento. 
Assim, um documento XHTML, para funcionar, precisa ser válido segundo as regras de 
um dos DTDs disponíveis para o padrão: 

 

Strict 
Use essa declaração para criar uma página baseada apenas em HTML (sem CSS). Esse 
tipo de DTD garante que seu documento XHTML poderá ser visto pelo maior número 
possível de dispositivos. 

 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 strict//EN”  



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

23                                    2009  Alfamídia LTDA. 
 

 http://www.w3c.org/TR/xhtml1/DTD/xhtml1-strict.dtd> 

 

Transitional 
Essa é a declaração que deve ser usada quando pretendemos utilizar folhas de estilo 
(CSS) em sua página de Internet, as Cascading Style Sheets, para melhorar a aparência 
dos documentos de seu site. Em geral, devemos apenas usar esse tipo de DTD quanto 
tem certeza de que os usuários terão acesso a navegadores que reconhecem CSS. 

 

3.3 Página básica XHTML: xhtml.html 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Minha primeira página XHTML</title> 
</head> 
<body> 
<!-- aqui temos um comentário que não aparecerá no browser --> 
HTML para designers. 
<br />Curso de Web Design. 
</body> 
</html> 

 

3.4 Listas 
Em determinadas situações podemos desejar organizar informações de uma página 
HTML em listas.  

Observe as tags HTML  para listas e os exemplos a seguir: 
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<ol> Marca o início e o fim de uma lista ordenada. Recebem na 

primeira linha um número ou letra.  

Atributos: 

Start = especifica o número  a partir do qual os itens 
começam a ser contados. Ex: <ol start=3> 

Type = modifica o tipo do numerador  que pode ser: 
número, letras ou algarismo romano. 

<ul> Marca o início e o fim de uma lista não ordenada, ou seja, 
os itens da lista recebem símbolos na primeira linha.  
Atributos 

Type = modifica o tipo do marcador (símbolo), que pode ser:  

Circle = um círculo vazio.               

Disc =  um círculo cheio.                

Square = um quadrado cheio         

<li> Marca um item de uma lista, ordenada ou não ordenada. 

 

Neste exercício trabalharemos com listas ordenadas e marcadores. Assim como em uma 
carta ou qualquer outro documento comum, precisamos listar tópicos através de 
símbolos ou números. 

Para entender isto, acompanhe com o instrutor os exemplos a seguir: 

3.4.1 Listas Simples – Exemplo 1 

Confira este primeiro exemplo de uma lista simples: lista1.html. 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Listas</title> 
</head> 
<body> 
<h3>Isto é uma lista</h3> 
<!-- Início dos Numeradores --> 
<ol> 
<li>Item 1 </li> 
<li>Item 2 </li> 
<li>Item 3 </li> 
</ol> 
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<!-- Fim dos Numeradores -->   
<hr width=”50%” size=”5” align=”left”> 
<!-- Início dos Marcadores --> 
<ul> 
<li>Item 1 </li> 
<li>Item 2 </li> 
<li>Item 3 </li> 
</ul> 
<!-- Fim dos Marcadores --> 
</body> 
</html> 
 

 

3.4.2 Listas Simples – Exemplo 2 

Para fixar melhor o conceito de listas, vamos apresentar um segundo exercício. Digite a 
listagem a seguir e salve como lista2.html. 

 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Listas</title> 
</head> 
<body> 
<h3>Isto é uma listagem iniciando no número 4</h3> 
<ol start="4"> 
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<li>Item 1 </li> 
<li>Item 2 </li> 
<li>Item 3 </li> 
</ol> 
<h3>Isto é uma listagem com letras</h3> 
<ol type="a"> 
<li>html  </li> 
<li>para designers </li> 
<li>alfamídia </li> 
</ol> 
<h3>Isto é uma listagem em algarismo romano</h3> 
<ol type="i"> 
<li>html </li> 
<li>para designers </li> 
<li>alfamídia </li> 
</ol> 
<h3>Esta é uma listagem em algarismo romano a partir do número 3</h3> 
<ol type="i" start="3"> 
<li>html </li> 
<li>para designers </li> 
<li>alfamídia </li> 
</ol> 
</body> 
</html 
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3.4.3 Listas com Subníveis 

Vamos terminar esta lição com mais um exemplo. Desta vez, faremos uma listagem com 
subníveis. Para entender isto, digite a listagem a seguir, e salve como lista3.html 

 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Listas</title> 
</head> 
<body> 
<h3>Listagem e sublistagem</h3> 
<ol><!-- início do numerador --> 
<li>Item 1 
<ul><!-- início do marcador dentro do numerador --> 
<li type=disc>Item 1.1 
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<li type=disc>Item 1.2 
<li type=disc>Item 1.3 
</ul><!-- fim do marcador dentro do numerador--> 
<li> Item 2 
<ul><!-- início do marcador dentro do numerador--> 
<li type=square >Item 2.1 
<ul><!--início do marcador dentro do marcador--> 
<li type=circle>Item 2.1.1 
<li type=circle>Item 2.1.2 
<li type=circle>Item 2.1.3 
</ul><!-- fim do marcador dentro do marcador --> 
<li type=circle>Item 2.2 
<li type=circle>Item 2.3 
</ul><!-- fim do marcador dentro do numerador--> 
<li> Item 3 
</ol><!-- fim do numerador--> 
</body> 
</html> 

 

 

3.5 Links 
Hiperlink é o elemento fundamental da navegação pela internet. O conceito é simples: 
selecionando-se determinado elemento em uma página Web, somos levados para uma 
nova página. 
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Para criarmos um site precisamos fazer uso destes links para estabelecer a ligação entre 
as páginas, de forma que, através de um único clique sobre a frase ou imagem, 
navegaremos para algum lugar no site ou na WEB. 

Sintaxe:  

<a></a>: delimitar o link 

Href: referencia a página que se deseja abrir 

Target = _blank: abre a página em uma nova janela no browser 

3.5.1 Adicionando Links de E-mail 

Adicionar um link de e-mail à sua página é uma maneira de fornecer aos usuários um 
método de entrar em contato com alguém para falar sobre as informações 
disponibilizadas em seu site.  

Um link de correio eletrônico abre uma nova janela de mensagem no programa de 
correio eletrônico associado ao navegador do usuário Adicionando Links de E-mail 

Adicionar um link de e-mail à sua página é uma maneira de fornecer aos usuários um 
método de entrar em contato com alguém para falar sobre as informações 
disponibilizadas em seu site.  

Um link de correio eletrônico abre uma nova janela de mensagem no programa de 
correio eletrônico associado ao navegador do usuário. 

Ex.: <a href=”mailto:email@provedor.com.br”>E-mail</a> 

3.5.2 Exemplo de Links: links.html 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  

http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 

<html xmlns="http://www.w3.org/1999/xhtml"> 

<head> 

<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 

<title>Links</title> 

</head> 

<body> 

<a href="index.htm">Home</a> -   

<a href="texto.htm">Texto</a> -  

<a href="contato.htm">Contato</a> 

<br /> 

<br /> 

<br /> 
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Email para Sugestões clique <a href="mailto:teste@teste.com.br"> Aqui</a> 

</body> 

</html> 

 

 
 

3.6  Tabelas 
O recurso de tabelas foi originalmente criado, no HTML, com o objetivo de organizar 
informações e exibir dados na forma de planilhas.  

Esta técnica está caindo em desuso, porém, pois com o HTML 4.1 e o CSS é possível 
controlar de forma bastante precisa a diagramação de um site sem ter que utilizar as 
tabelas como um subterfúgio. Nas próximas unidades serão apresentadas técnicas de 
diagramação sem o uso de tabelas (tableless design), enquanto que nesta unidade o foco 
é no uso de tabelas para a exibição de informações em planilhas. 

3.6.1 Construindo Tabelas 

Tabelas são definidas, em HTML, com a definição das linhas e, dentro das linhas, das 
células de cada coluna. Com apenas 4 tags, vistas na tabela seguinte, é possível definir 
diversos tipos de tabelas: 
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<table> Define uma tabela. Antes e depois de uma tabela, acontece 
sempre uma quebra de linha. 

Atributos 

Border: define espessura da borda da tabela 

Cellspacing: espaço entre cada célula 

Cellpadding: distância entre borda e conteúdo de cada célula. 

Width: largura da tabela, em pixels ou valor percentual 

<tr> Define uma linha normal da tabela (table row). 

Atributos 

Align: valores left, right e center definem o alinhamento 
horizontal. 

Valign: valores top, middle e bottom definem o alinhamento 
vertical. 

<td> Esta é a marcação que define cada célula de uma tabela. As 
células de uma tabela devem sempre aparecer entre as 
marcações de linhas (<tr> e </tr>). Como padrão, o texto nas 
células é alinhado a esquerda.  

Atributos 

Align: valores left, right e center definem o alinhamento 
horizontal. 

Valign: valores top, middle e bottom definem o alinhamento 
vertical. 

Nowrap: não há quebra de linhas dentro das células 

Colspan: número de colunas que a célula irá ocupar 

Rowspan: número de linhas que a célula irá ocupar 

Width: largura da célula, em pixels ou valor percentual 

<th> Desta forma são definidos os títulos de uma tabela. Estes 
podem ser posicionados em qualquer célula. A diferença entre 
a marcação de célula e título de célula é que o título aparece 
em negrito. 

Atributos: os mesmos apresentados acima, para td 

3.6.2 Exemplo de uma Tabela Simples 

O exemplo tabelas1.html abaixo mostra uma tabela utilizando as tags apresentadas. A 
figura em seqüência apresenta a imagem desta página: 

<table border=1> 
<!-- linha 1--> 
<tr> 
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<td>Itens/Mês</td> 
<th>Janeiro</th><th>Fevereiro</th><th>Março</th> 
</tr> 
<!-- linha 2--> 
<tr> 
<th>Usuarios</th><td>80</td><td>93</td><td>120</td> 
</tr> 
<!-- linha 3--> 
<tr> 
<th>Linhas</th><td>3</td><td>3</td><td>5</td> 
</tr> 
</table> 

Como foi dito, a tabela é construída linha a linha. Observe os comentários no código 
acima. 

 

 
 
 

Borda maior (border) 
<table border=5>  
<tr> 
<td>teste1</td> <td>teste2</td> <td>teste3</td> 
</tr>  
<tr> 
<td>teste4</td> <td>teste5</td> <td>teste6</td> 
</tr> 
</table>  
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3.6.3 Tabelas Mais Sofisticadas 

As marcações das tabelas, podem apresentar resultados diferentes, se acompanhadas de 
alguns atributos mostrados na tabela anterior. Vamos ver os principais em exemplos 
práticos: 

Exemplo de alinhamento horizontal (align) 
<table border=1> 
<tr> 
<td>Primeira célula</td><td>Segunda célula</td><td>Terceira célula</td> 
</tr> 
<tr> 
<td align=center>centro</td> 
<td align=left>esquerda</td> 
<td align=right>direita</td>  
</tr></table> 

 
Célula em várias colunas (colspan) 
<table border=1> 
<tr> 
<td colspan=3>3colunas</td> 
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<td>normal</td> 
<td>normal</td> 
</tr>  
<tr> 
<td>col 1</td> 
<td>col 2</td> 
<td>col3</td> 
<td>col 4</td> 
<td>col 5</td>  
</tr> </table>  

 
 

Célula em várias linhas (rowspan) 
<table border=1> 
<tr> 
<td rowspan=3>3 linhas</td> 
<td>col 2</td> 
<td>col 3</td> 
<td>col4</td> 
<td>col5</td>  
</tr>  
<tr> 
<td>col 2</td> 
<td>col 3</td> 
<td>col4</td> 
<td>col 5</td>  
</tr> 
<tr> 
<td>col 2</td> 
<td>col 3</td> 
<td>col4</td> 
<td>col 5</td>  
</tr> 
</table> 
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3.6.4 Layers - DIV 

O comando DIV é utilizado para criar um contêiner, que isola o seu conteúdo do restante 
dos elementos da página. Fazendo uma analogia que pode facilitar este conceito: utilizar 
o comando DIV é como fazer uma caixa de texto no MS Word®. 

Este é um comando importante principalmente quando se está utilizando o Internet 
Explorer. Essa é a forma básica usada para criar camadas dentro do Internet Explorer, 
através do posicionamento de atributos que serão tratados mais adiante. Embora este 
comando seja reconhecido pelo Netscape Navigator, ele depende do elemento layer para 
a criação de camadas. 

Dentro da tag que abre o DIV pode-se adicionar o atributo class e alterar o estilo 
aplicado àquela região do documento. Um comando DIV sempre tem uma quebra de 
linha incorporado, à semelhança do comando P. 

Exemplo: 
<html> 
<head> 
<title> Uso do Comando DIV com o atributo Class </title> 
<style type = “text/css”> 
h1 {color: red} 
#variacao {background: yellow} 
.altcolor{background: yellow; color: green; 
font-weight: bold} 
</style> 
</head> 
<body> 
<h1> Cabeçalho com Estilo Normal </h1> 
texto<br> 
texto<br> 
<h1 id = ”variacao”>  
Cabeçalho com Estilo e uso do ID variacao  
</h1> 
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<div class = altcolor> 
 Parágrafo utilizando DIV e a classe altcolor. O elemento DIV sempre insere uma quebra de linha no 
texto.  
</div> 
 
</body> 
</html> 
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Unidade 4 – Introdução a Estilo CSS 

 

 

 

 
 

O CSS 

Benefícios em utilizar CSS 

CSS para separar conteúdo da apresentação 

Páginas com semântica correta 

Sintaxe do CSS 

Aplicando estilos a uma página 

Formas de utilização dos seletores 
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Unidade 4 
Introdução a Estilos CSS 

4.1 O CSS 
O CSS (Cascading Style Sheets ou Folhas de Estilo em Cascata) é uma linguagem de 
formatação proposta pelo W3C. Visa remover a formatação dos documentos (X)HTML, 
separando conteúdo e  formatação. 

A especificação inicial, chamada CSS1, tornou-se uma recomendação do W3C no final 
de 1996 e define praticamente todos os estilos de apresentação utilizados hoje em dia. A 
segunda versão da especificação, chamada CSS2, foi aprovada em 1998 e acrescentou 
vários estilos novos, principalmente na área de posicionamento e tabelas. Uma nova 
versão está em desenvolvimento e espera-se que seja aprovada em um futuro próximo. 

Todos os browsers atuais, o Internet Explorer 7, Netscape Navigator 7, Mozilla Firefox 
1, Opera 7 e Safari suportam o CSS. Entretanto o suporte ao CSS Nível 2 foi 
implementado em níveis diferentes, o que torna a adoção dos conceitos de 
posicionamento via CSS, ou Tableless, como é conhecido, ainda  um pouco complicado, 
necessitando muitas vezes de truques de correção, conhecido como CSS Hacks.  

Algumas considerações sobre CSS: 

• Os estilos definem para o browser como devem ser exibidos os elementos do 
(X)HTML. 

• Os estilos são geralmente definidos em folhas de estilo. 

• O CSS foi implementado na versão HTML 4.0 para resolver o problema de separação 
entre conteúdo e formatação. 

• Os estilos quando armazenados em folhas de estilo externas (arquivos.css) e 
compartilhadas entre documentos do mesmo website, poupam muito trabalho e 
simplificam enormemente a manutenção do site. 

• Definições de estilo múltiplas serão refletidas em cascata em uma definição resultante 
final. 

4.2 Benefícios em Utilizar CSS 
Utilizar CSS além de ser essencial para o XHTML para garantir a separação entre 
conteúdo e formatação, possibilita inúmeros benefícios a desenvolvedores e usuários:  
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• Produtividade aumentada. 

• Facilidade em criar sites com identidade visual unificada e coerente. 

• Facilidade em fazer mudanças em todo o site – basta alterar um arquivo CSS invés de 
mudar todas as páginas HTML. 

• Arquivos mais leves => download mais rápido => experiência de usuário melhorada. 

• Menos código na página => mais fácil codificar. 

• Permitir que visitantes alterem suas preferências definindo estilos dinamicamente. 

• Mais acessível para uma ampla variedade de aparelhos.  

• Mais controle sobre o código - interpretação do código na ordem correta para os leitores 
de tela. 

• Disponibiliza versões para impressão sem duplicação de conteúdo, somente alternando 
o CSS. 

• Permite formatar elementos do HTML como formulários e barras de rolagem, 
impossível via atributos HTML. 

• Permite controlar aspectos visuais como tipo e cor de borda, posicionamento, 
visibilidade e margens – propriedades inexistentes no HTML. 

4.3 CSS para Separar Conteúdo da Apresentação 
Uma das metas ao se utilizar os conceitos do Web Standards é remover toda a 
apresentação do código (X)HTML, deixando-o limpo e semanticamente correto.  

Enquanto o (X)HTML define a estrutura, O CSS fica responsável pela formatação visual 
e posicionamento de elementos dentro de uma página Web. 

Utilizando CSS, um desenvolvedor pode definir elementos da apresentação (o layout, 
fontes, cores, bordas, etc), independentemente da marcação do documento Web. Os 
estilos podem (e devem, na maioria dos casos) serem definidos em um documento 
separado com extensão .css e compartilhados entre todos ou um grupo de documentos 
relacionados do mesmo website. Desta forma, alterar ou implementar novos estilos é 
tarefa fácil, bastando para isso alterar somente um arquivo do projeto, já que ele está 
referenciado entre diversos documentos, sendo renderizado dinamicamente na medida 
em que o browser carrega o arquivo de definições ou a folha de estilos externa (.css). 

Ao separar formatação do conteúdo, estamos tornando o código semanticamente correto. 
Ou seja, não utilizando marcação de conteúdo (HTML) para formatação (uso incorreto). 
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Outra vantagem na separação é a possibilidade de tornar disponível o mesmo conteúdo 
para múltiplos devices (aparelhos) sem necessidade de duplicar o conteúdo, alterando 
somente a formatação (CSS). Isto inclusive pode ser feito de forma dinâmica ou 
utilizando linguagem script (Javascript, por exemplo). Entre os devices que suportam 
conteúdo Web podemos citar: 

• Browsers. 

• Impressoras. 

• PDAs (Personal Digital Assistants). 

• Telefones Celulares. 

• Equipamentos wireless. 

Para obter uma demonstração do que pode ser conseguido visualmente por meio de um 
design baseado em CSS, acesse o site Zen Garden, onde diferentes desenvolvedores 
criaram para o mesmo conteúdo (documento HTML), diferentes arquivos CSS, 
resultando em documentos com o design 100% diferentes entre si.  
Vale a pena conferir! http://www.csszengarden.com/tr/portuguese/ 

4.4 Páginas com Semântica Correta 
Uma marcação semanticamente correta utiliza elementos HTML para o seu objetivo 
definido. Um HTML bem estruturado tem significado semântico para um amplo número 
de User Agents (navegadores sem folhas de estilo, navegadores baseados em texto, 
PDAs, sites de busca, etc.). 

Utilizar código semanticamente correto é uma forma de organizar e estruturar a 
informação na Web. 

Devemos utilizar HTML padrão e evitar fazer com que os elementos HTML se pareçam 
com outros elementos HTML. Ou seja:  

• Para cabeçalhos e títulos, utilize elementos de header começando com o <h1> para o 
título de maior importância. 

• Para títulos em tabelas, utilize a tag <th> em vez da tag <td>. 

• Para listas, utilize elementos de lista <li>, <ol> e <ul>. 

• Para o layout, utilize a tag <div> em vez de <table>. 

Conceito concebido pelo físico inglês Tom Berners-Lee, o criador do World Wide Web, 
cuja proposta, ainda em desenvolvimento, por um grupo de pesquisadores do W3C, por 
ele liderado, é estruturar todo o conteúdo disponível na Internet. Essa estruturação será 

http://www.csszengarden.com/tr/portuguese/�
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baseada num conjunto de regras, que permitirá a localização eficiente e precisa da 
informação desejada.  

 

Por mais sofisticados que sejam os mecanismos de buscas, atualmente existentes, todos, 
sem exceção, oferecem para cada solicitação um grande número de páginas, que, em sua 
maioria, não atendem às necessidades do usuário. Esse é, então, obrigado a verificar uma 
a uma, até encontrar exatamente o que procura.  

A Web semântica se propõe objetivar essa busca, de modo que o conteúdo exato seja 
encontrado em uma única consulta. Esse conceito baseia-se na inserção, em cada 
arquivo da Web, de tags personalizadas, definidas pela linguagem XML e, com isso, 
indexar toda a informação disponível de forma precisa. A localização exata da 
informação que se busca estará a cargo de agentes. O conceito de Web semântica prevê 
ainda o uso de RDF, um padrão de descrição, composto por trios de informação, em que 
cada unidade terá função própria, como sujeito, verbo e objeto, em uma frase.  

Para cada diferente significado de uma palavra e sua função numa frase será criada uma 
identificação (URI). O maior desafio da Web semântica é a padronização desses URIs. 
Para isso prevê-se o uso de ontologias, que fornecerão aos agentes o vocabulário 
necessário para identificar de modo preciso a informação que se busca. 

A tempo: URL significa Uniform Resource Locator, ou Identifier, no caso de URI. 
Servem para localizar qualquer recurso na Internet. 

4.5 Sintaxe do CSS  
A sintaxe do CSS é uma sintaxe de marcação, definindo o elemento(s) a ser formatado, a 
propriedade e o valor: 

 
body  { 
    font-size : 70%; 
    color : #000000; 
    background-color : #F1F1F1; 
    margin : 0; 
} 

As informações sobre os estilos podem ser armazenadas: 

• Interno - No cabeçalho de um documento HTML. 

• Inline ou Em Linha - Junto a uma determinada tag. 

• Externo – Em um documento .css separado vinculado ao documento HTML através de 
uma referência externa no cabeçalho do documento. 
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4.6 Aplicando Estilos a uma Página 
Como mencionado, existem 3 formas de aplicar estilos a uma página HTML, que 
veremos a seguir: 

4.6.1 Aplicando Estilos a Toda a Página HTML 

Neste caso, utilizamos as tags HTML <style> e </style> dentro da seção de cabeçalho 
(<head>) de uma página: 

 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Utilizando CSS em uma página HTML</title> 
 
<style type=”text/css”> 
seletor 
{ 
    propriedade: valor; 
} 
</style> 
 
</head> 
<body> 
</body> 
</html> 

4.6.2 Aplicando Estilos à apenas uma Tag HTML Específica 

Para isso utilizamos o parâmetro style, que pode ser utilizado por praticamente qualquer 
tag HTML 

 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Utilizando CSS em uma tag HTML</title> 
</head> 
<body> 
<font style=”propriedade: valor;”>Teste de Estilos</font> 
</body> 
</html> 
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Neste caso específico dispensamos o seletor, pois estamos aplicando o estilo diretamente 
em uma tag. 

4.6.3 Utilizando um Arquivo de Estilos Externo 

Esta é a forma mais utilizada pelos profissionais, pois com ela podemos aplicar diversos 
estilos diferentes a diversas páginas HTML. 

Primeiramente é criado o arquivo de estilos, que deve ser salvo com a extensão .css: 

 
Arquivo 1: estilos.css 
seletor 
{ 
    propriedade: valor; 
    propriedade: valor; 
} 
 
seletor 
{ 
    propriedade: valor; 
} 

Feito isto, criamos um arquivo HTML que fará referência ao arquivo de estilos que será 
utilizado através da tag <LINK>: 

Arquivo 2: estilos.html 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Utilizando css em um arquivo externo</title> 
<link rel=”stylesheet” type=”text/css” href=”estilos.css”>  
</head> 
<body> 
</body> 
</html> 

4.7 Formas de Utilização dos Seletores 
Como vimos anteriormente, um seletor pode ser o nome de uma tag HTML, um grupo 
de tags, uma classe ou um ID. Veremos agora exemplos práticos de como utilizar cada 
caso: 
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4.7.1 Aplicando Estilos a uma Tag: 

Primeiro devemos definir à qual tag queremos aplicar os estilos. Neste exemplo 
alteraremos o estilo das tags <FONT>: 

 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Alterando o estilo da tag font</title> 
 
<style type=”text/css”> 
font 
{ 
    propriedade: valor; 
} 
</style> 
 
</head> 
<body> 
<font> Esta tag recebe os estilos definidos no cabeçalho.</font> 
<br><br> 
<font> Esta tag também recebe os estilos que foram definidos.</font> 
</body> 
</html> 

 
Note que qualquer tag <FONT> contida nesta página automaticamente receberá 
aplicação dos estilos definidos. 

4.7.2 Definindo Estilos para mais um Grupo de Tags 

Semelhante ao primeiro caso, sendo que nosso seletor será uma lista de tags, separadas 
por vírgulas (,). Agora veremos como podemos aplicar estilos as tags <FONT> e <P> 
utilizando apenas uma definição de estilo: 

<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Alterando o estilo da tag font</title> 
 
<style type=”text/css”> 
font, p 
{ 
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    propriedade: valor; 
} 
</style> 
 
</head> 
<body> 
<font> Esta tag recebe os estilos definidos no cabeçalho.</font> 
<br><br> 
<font> Esta tag também recebe os estilos que foram definidos.</font> 
<p> 
Este parágrafo recebe os estilos definidos no cabeçalho. 
Qualquer outra tag p utilizada nesta página também os receberá. 
</p> 
</body> 
</html> 

4.7.3 Definindo uma Classe de Estilos 

Para definirmos uma classe de estilos, devemos iniciar o seletor por um ponto (.) e a(s) 
tag(s) que forem receber estes estilos devem fazer referência a esta classe através do 
parâmetro CLASS. 

Veja no exemplo a seguir a aplicação de uma classe de estilos à apenas uma tag 
<FONT>: 

 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Alterando o estilo da tag font</title> 
 
<style type=”text/css”> 
.estilo1 
{ 
    propriedade: valor; 
} 
</style> 
 
</head> 
<body> 
<font class=”estilo1”> Esta tag recebe os estilos definidos na classe estilo01. Note que o valor do 
parâmetro class não possui o ponto.</font> 
<br><br> 
<font> Esta tag não recebe os estilos que foram definidos, pois não possui o parâmetro class.</font> 
</body> 
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</html> 
 

4.7.4 Aplicando Estilos a uma palavra ou a um grupo pequeno de 
palavras 

Se tiver necessidade de aplicar estilo somente a uma palavra ou a um grupo pequeno de 
palavras dentro de um parágrafo, utiliza-se o comando <span>. 

Sintaxe: <span [class = “class_name”]> Texto </span> 

Exemplo: 
<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title> Uso do Comando SPAN com o atributo Class </title> 
<style type = "text/css"> 
.altcolor { 
   color:#FF0000} 
 
.destaque { 
   color:#0000FF; 
   font-size:14px } 
</style> 
</head> 
<body> 
 
Pode-se inserir quantos comandos SPAN forem necessários para criar <span class="altcolor"> efeitos 
visuais </span> diferentes. <br /> 
Podemos utilizar o comando SPAN para salientar uma <span class="destaque"> palavra.</span> 
Também é útil para destacar <span class="destaque"> mais de uma palavra. </span> 
</body> 
</html> 

4.7.5 Definindo um ID de Estilos 

Um ID de estilos é idêntico a uma classe, pois também possui a função de agrupar 
diversos estilos em uma única estrutura nomeada. Existem apenas duas diferenças entre 
um ID e uma classe: 

- IDs são iniciados pelo caractere sustenido (#). 

- IDs são referenciados pelo parâmetro ID 

Veja no exemplo a seguir a aplicação de um ID de estilos à apenas uma tag: 
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<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.0 Transitional//EN”  
http://www.w3c.org/TR/xhtml1/DTD/xhtml1-transitional.dtd> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<title>Alterando o estilo da tag font</title> 
 
<style type=”text/css”> 
#estilo1 
{ 
    propriedade: valor; 
} 
</style> 
 
</head> 
<body> 
<font id=”estilo1”> Esta tag recebe os estilos definidos no id estilo01. note que o valor do parâmetro id 
não possui o sustenido.</font> 
<br /><br /> 
<font> Esta tag não recebe os estilos que foram definidos, pois não possui o parâmetro id.</font> 
</body> 
</html> 

 
A tabela abaixo apresenta os principais atributos com suas descrições, valores e como 
usamos no código: 

 
Atributo Descrição Valores Permitidos Exemplos 

background Especifica uma 
imagem de 
segundo plano 
ou cor. 

URL ou o código 
da cor 

{background:#33
CC00} 

border Especifica a 
lateral da borda 
que sofre o efeito 

top / left / right / 
center 

{border-left} 

border-color Especifica a cor 
da borda. 

Nome ou código da 
cor. 

{border-color: 
blue} 

border-style Especifica o 
estilo da borda. 

dotted / dashed / 
solid / double / 
none / grove / ridge 
/ inset / outset 

{border-style: 
grove} 

border-width Especifica a 
largura da borda. 

thin / thick / 
medium 

{border-width: 
medium} 
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color Especifica a cor 
do texto. 

Nome ou código da 
cor. 

{color: blue} 

font-family Seleciona o tipo 
de fonte. 

Nome da fonte (de 
acordo com o 
Windows) 

{font-family: 
courier} 

{font-family: arial} 

font-size Ajusta o tamanho 
da fonte. 

points (pt) 

inches (in) 

centimeters (cm) 

pixels (px) 

{font-size: 12pt} 

font-style Aplica o efeito 
itálico. 

normal 

italic 

{font-style: italic} 

font-weight Ajusta a 
espessura da 
fonte. 

extra-light 

light 

demi-light 

medium 

demi-bold 

bold 

extra-bold 

{font-weight: 
bold} 

{font-weight: 
extra-bold} 

line-height Especifica a 
distância entre as 
linhas. 

points (pt) 

inches (in) 

centimeters (cm) 

pixels (px) 

percentage(%) 

{line-height: 24pt} 

margin-left Ajusta a distância 
da margem da 
esquerda. 

points (pt) 

inches (in) 

centimeters (cm) 

pixels (px) 

{margin-left: 5in} 

margin-right Ajusta a distância 
da borda direita 
da página. 

points (pt) 

inches (in) 

centimeters (cm) 

pixels (px) 

{margin-right: 
1cm} 
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margin-top Ajusta a distância 
da borda superior 
da página 

points (pt) 

inches (in) 

centimeters (cm) 

pixels (px) 

{margin-top: -
20px} 

text-align Especifica o 
alinhamento do 
texto. 

left 

center 

right 

{text-align: right} 

text-decoration Aplica efeitos no 
texto. 

none 

underline 

italic 

line-trough 

{text-decoration: 
none} 

text-indent Especifica a 
distância entre o 
texto e a margem 
esquerda. 

points (pt) 

inches (in) 

centimeters (cm) 

pixels (px) 

{text-indent: 
0.5in} 
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Unidade 5 – Introdução ao Tableless 
Design 

 

 

 

Tableless 

Problemas no Design com Tabelas 

Design Tableless – CSS Box Model 

Um exemplo de Tableless Design 
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Unidade 5 
Introdução ao Tableless Design 

5.1 Tableless 
O HTML é uma linguagem estrutural, ou seja, é - ou deveria ser - usada para estruturar 
textos através de tags. A tag table deveria ser usada tão somente com a finalidade de 
apresentar dados dentro de uma tabela com linhas e colunas (tabular data). 

Mas desde que as tabelas foram implementadas no HTML elas têm sido amplamente 
usadas para montagem de layouts e muito comumente para definir um layout de uma 
página web em colunas. Ao fato de que este uso das tabelas contraria sua finalidade (seu 
propósito semântico) somam-se ainda várias outras desvantagens, entre elas destaca-se a 
dificuldade de um parsing adequado na renderização das tabelas em determinados 
contextos (usuários com necessidades especiais, agentes de usuários ou browsers com 
restrições). 

5.2 Problemas no Design com Tabelas 
Podemos enumerar diversos problemas quando utilizamos tabelas para definir o layout 
de uma página: 

 
• Misturar informações de apresentação com o conteúdo da página. 
• Isto torna o tamanho desnecessariamente grande, pois os usuários terão que fazer o 

download desta informação de apresentação (50 a 80% do tamanho do arquivo), a cada 
página visitada. 

• Necessidade de banda do servidor é muito maior, principalmente em sites com tráfego 
intenso. Isto influencia negativamente o curso de hosting. 

• Alterações no layout ou na estrutura são extremamente complexas (trabalho manual) e 
demoradas, influenciando o custo de manutenção do projeto. 

• Torna-se complicado manter uma padronização visual ao longo de um projeto mais 
extenso. 

• Páginas baseadas em tabelas são muito menos acessíveis a usuários com necessidades 
especiais e, também, equipamentos móbile como celulares e PDAs. 

5.3 Design Tableless – CSS Box Model 
A solução proposta pela W3C e pelo conceito de adoção dos Web Standards é a 
substituição das tabelas de layout (tabelas aninhadas e imagens Gifs para espaçamento) 
por containers definidos dentro do conceito ou modelo de caixa do CSS, o CSS Box 
Model. 
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O entendimento do Box Model é o primeiro fundamento para desenvolvimento de 
layouts via CSS .  

Box Model é o nome que se dá ao conjunto de propriedades CSS que criam uma área 
retangular em torno de um elemento do HTML. Ele é composto pelo uso das 
propriedades: margin, border, padding (preenchimento interno) e width (largura). O 
height (altura) também participa do Box Model, embora seja recomendado que o 
conteúdo é que define a altura de um elemento. 

O Box Model ou Modelo de Caixas foi definido pelo W3C nas recomendações para o 
CSS1 publicadas em 1996. O trecho e a figura a seguir foram extraídos da tradução para 
o português da citada recomendação e definem o Box Model.  

"O CSS1 adota como modelo de formatação uma seqüência simples de caixas, na qual 
cada elemento formatado ocupa uma ou mais destas caixas. Todas as caixas possuem um 
conteúdo central com áreas opcionais adjacentes formando as margens, bordas e 
espaçadores (padding)." 

 
Quando definimos uma cor ou imagem para background (fundo), ele será visualizado 
somente na área que compreende o conteúdo e o padding definido. A área da margem 
não é afetada, sendo que o fundo sempre será transparente. 

5.4 Um Exemplo de Tableless Design 
É importante uma compreensão dos recursos à disposição de Web Designer e do 
Programador para estruturar um site. 

Observe o exemplo abaixo, que visa mostrar um layout completo, ainda que simples, 
utilizando a técnica de Design sem Tabelas: 

Tableless1.html 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1" /> 
<title>CSS - Tableless</title> 
<style type="text/css"> 
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<!-- 
body { 
 margin:0 0 5px 0; 
 padding:0; 
 font:12px Verdana, Arial, Serif; 
} 
#topo{ 
 width:auto; 
 height:50px; 
 padding:3px 0 0 0; 
 background-color:#CCCCFF; 
 border-top:1px solid #666666; 
 border-bottom:2px solid #666666; 
 text-align:center; 
} 
#conteudoEsq { 
 position:absolute; 
 width:190px; 
 top:80px; 
 left:5px; 
 padding-bottom:20px; 
} 
#colEsq { 
 background:#9966FF; 
 border-bottom:1px solid #666666; 
} 
#sepEsqcolCentral { 
 margin-left:200px; 
 padding-left:2px; 
 background:#666666; 
} 
#colCentral {     
 background:#EEE6FF; 
 padding:2px 10px 20px; 
 text-align:justify; 
} 
--> 
</style> 
</head> 
<body> 
<div id="topo"> 
  <h3>Empresa de Exportação</h3> 
</div> 
<div id="conteudoEsq"> 
  <h3>Menu</h3> 
  <ul> 
    <li>home</li> 
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    <li>produtos</li> 
    <li>empresa</li> 
    <li>contato</li> 
  </ul> 
</div> 
<div id="colEsq"> 
 <div id="sepEsqcolCentral"> 
  <div id="colCentral"> 
   <h3>Nossa Empresa</h3> 
   <p>Nossa empresa oferece todo o tipo de serviços de exportação. Exportamos 
pregos, parafusos,  
 
computadores, caminhões, e tudo mais que você pode ter interesse em enviar para fora do país. 
Cobramos barato, garantimos a  
 
entrega e temos os melhores prazos do mercado</p> 
  </div> 
 </div> 
</div> 
</body> 
</html> 

Observe o resultado no browser e estude com o instrutor como os elementos CSS 
definiram o layout da página: 

 
 



 

55                        2009  Processor Alfamidia LTDA. 
 

Unidade 6 – Conhecendo a Interface do 
Dreamweaver CS4 

 

 

 

Sobre o Adobe Dreamweaver 

Abrindo o Dreamweaver 

Área de trabalho do Dreamweaver 

Ferramentas Select, Hand e Zoom 

Barra de Ferramentas Standard 
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Unidade 6 
Conhecendo a Interface do Dreamweaver 

CS4 

6.1 Sobre o Adobe Dreamweaver 
O Dreamweaver é o software mais utilizado pelos profissionais de webdesign. Com ele, 
podemos desenvolver sites com facilidade e tecnologia e poder optar em utilizar tanto 
um ambiente para designers quanto um ambiente para desenvolvedores.  

O Dreamweaver CS4 está totalmente voltado para a Web 2.0, com maior suporte ao CSS 
e trazendo modelos de sites. 

 

6.2 Abrindo o Dreamweaver 
Clicar no menu Iniciar > Programas > Adobe Master Collection CS4 > Adobe 
Dreamweaver CS4. 
Na tela inicial do Dreamweaver, podemos abrir os últimos itens que trabalhamos, criar 
novas páginas e criar itens a partir de exemplos: 
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É possível desativar a página inicial selecionando a opção: Don’t Show Again, na parte 
inferior da tela. Caso contrário, sempre que não houver uma página aberta, o 
Dreamweaver exibirá essa página. 

6.3 Área de Trabalho do Dreamweaver  
A área de trabalho deste software pode ser personalizada conforme a necessidade do 
usuário. Como padrão, temos a seguinte apresentação: 
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- Barra de Aplicativos: A parte superior da janela do aplicativo contém o alternador da 
área de trabalho, os menus e outros controles do aplicativo.  

- Barra de ferramentas do documento: Contém botões e menus pop-up que oferecem 
visualizações da janela do documento (como as visualizações Design e Código), várias 
opções de visualização e algumas operações comuns, como a visualização em um 
navegador.; 

- Janela do documento: Aparece quando abrimos uma página. Essa é a área em que 
projetamos a página; 

- Grupo de painéis: Ajudar a monitorar e modificar seu trabalho. Os exemplos incluem 
o painel Inserir, o painel Estilos de CSS e o painel Arquivos. Para expandir um painel, 
clique duas vezes na aba correspondente. 

- Painel Properties: Permite visualizar e alterar diversas propriedades do objeto ou 
texto selecionado. Cada objeto tem propriedades diferentes. O Painel Properties não é 
expandido por padrão no layout Codificador da área de trabalho. 

- Seletor de tags: Localizado na barra de status, na parte inferior da janela Documento. 
Mostra a hierarquia de tags em torno da seleção atual. Clique em qualquer tag da 
hierarquia para selecionar a tag e todo seu conteúdo. 

- Painel de Arquivos: Permite gerenciar arquivos e pastas, que podem fazer parte de um 
site do Dreamweaver ou estar em um servidor remoto. O painel Arquivos também 
permite acessar todos os arquivos do disco local, assim como o Windows Explorer 
(Windows) ou o Finder (Macintosh). 
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- Painel Inserir: Contém botões para inserir vários tipos de objetos em um documento, 
como imagens, tabelas e elementos de mídia. Cada objeto é uma parte do código HTML 
que permite definir vários atributos à medida que são inseridos. Por exemplo, podemos 
inserir uma tabela clicando no botão Tabela do painel Inserir. Também podemos inserir 
objetos usando o menu Inserir em vez do Painel Insert. 

6.4 Ferramentas Select, Hand e Zoom 
Do lado direito da barra Seletor de tags temos as ferramentas: 

 
Select: permite selecionar elementos na página. 

Hand: move a página quando o zoom está maior que 100%. 

Zoom: aumenta a página até 6400%. As teclas de atalho CTRL + e CTRL - funcionam 
para aumentar ou diminuir o zoom da página. 

Se o zoom estiver em 400%, por exemplo, podemos dar um duplo clique na ferramenta 
Select e a página retornará a um zoom de 100%. 

 

6.5 Barra de Ferramentas Standard 
Essa barra de ferramentas contém alguns comandos usados com freqüência: 

 
Para habilitar esta barra vá até o menu: View > toolbars > Standard. 

Na primeira parte deste grupo de ferramentas temos: New, Open, Browser in Bridge, 
Save, Save all e Print Code.  

Na segunda parte temos: Cut, Copy e Paste. 

E na última parte temos os comandos de Undo (desfaz) e Redo (refaz) 

 

6.6 Visão geral da barra de ferramentas de documento 
A Barra de Ferramentas Documento contém botões que permitem alternar rapidamente 
entre visualizações diferentes do documento. A barra de ferramentas também contém 
alguns comandos comuns e opções relacionadas à visualização do documento e à sua 
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transferência entre sites locais e remotos. A ilustração abaixo mostra a barra de 
ferramentas Documento expandida. 

 

      A      B      C         D           E                     F             G  H   I   J  K   L    M  
A. Mostrar visualização de código B. Mostrar visualizações de código e do projeto C. 
Mostrar visualização do projeto D. Visualização dinâmica E. Visualização dinâmica de 
código F. Título do documento G. Gerenciamento de arquivos H. Visualizar/depurar no 
navegador I. Atualizar visualização de design J. Opções de visualização K. Auxílios 
visuais L. Validar markup M. Verificação de compatibilidade do navegador 
As seguintes opções aparecem na barra de ferramentas Documento: 

Mostrar visualização de código: Exibe somente a visualização Código na janela 
Documento. 

Mostrar visualizações de código e do projeto: Divide a janela Documento entre as 
visualizações Código e Design. 

Quando selecionarmos essa visualização combinada, a opção Visualização de design 
visível é ativada no menu Opções de visualização. 

Mostrar visualização do projeto: Exibe somente a Visualização de design na janela 
Documento. 

Nota: Se estivermos trabalhando com XML, JavaScript, CSS ou outros tipos de arquivo 
baseados em código, não poderemos visualizar os arquivos na Visualização de design e 
os botões Design e Dividir serão desativados. 
Visualização dinâmica: Exibe uma visualização do documento baseada no navegador, 
interativa e não editável. 

Visualização dinâmica de código: Exibe o código real usado pelo navegador para 
executar a página. 

Título do documento: Permite inserir um título para o documento, a ser exibido na 
barra de título do navegador. Se o documento já tiver um título, esse título será exibido 
nesse campo. 

Gerenciamento de arquivos: Exibe o menu pop-up Gerenciamento de arquivos. 

Visualizar/depurar no navegador: Permite visualizar ou depurar o documento em um 
navegador. Selecione um navegador no menu pop-up. 

Atualizar visualização de design: Atualiza a Visualização de design do documento 
depois de serem feitas alterações na Visualização de código. As alterações feitas na 
Visualização de código não aparecem automaticamente na Visualização de design até 
que realizemos determinadas ações, como salvar o arquivo ou clicar nesse botão. 
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Nota: Também são atualizados recursos de código que dependem de DOM (Modelo de 
objeto de documento), como a possibilidade de selecionar tags de abertura e 
fechamento de um bloco de código. 
Opções de visualização: Permite definir opções para as Visualizações de código e de 
design, incluindo a definição de que visualização desejamos que apareça por cima da 
outra. As opções do menu são válidas para a visualização atual: Design, Código ou 
ambas. 

Auxílios visuais: Permite usar diferentes auxílios visuais para projetar as páginas. 

Validar markup: Permite validar o documento atual ou uma tag selecionada. 

Verificação de compatibilidade do navegador: Permite verificar se o CSS é 
compatível com navegadores diferentes. 

 

6.6.1 Visão geral da Janela Documento 

A Janela Documento mostra o documento atual. É possível selecionar qualquer uma das 
seguintes visualizações: 

 
Visualização de Design: Um ambiente de design para o layout visual da página, a 
edição visual e o desenvolvimento rápido do aplicativo. Nessa visualização, o 
Dreamweaver exibe uma representação visual completamente editável do documento, 
semelhante à visualização da página em um navegador. 

Visualização de Code: Um ambiente de codificação manual para gravação e edição de 
código HTML, JavaScript, de linguagem de servidor (como linguagem PHP ou 
linguagem de markup ColdFusion (CFML)) e qualquer outro tipo de código. 

Visualização Split: Permite ver as visualizações Código e Design para o mesmo 
documento em uma única janela. 

Visualização Live View (visualização dinâmica): De modo semelhante à Visualização 
de design, o Live View exibe uma representação realista de como seu documento será 
exibido em um navegador, e permite que interajamos com o documento exatamente da 
maneira como faria em um navegador. O Live View não é editável. No entanto, 
podemos editar no Code e atualizar o Live View para exibir suas alterações. 

Visualização Live Code: Disponível apenas durante a exibição de documento na 
Visualização dinâmica. O Live Code exibe o código real que o navegador usa para 
executar a página, e pode alterar dinamicamente a maneira como interage com a página 
na Visualização dinâmica.O Live Code não é editável. 
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Quando uma janela Documento está maximizada (a padrão), as abas aparecem na parte 
superior da janela, mostrando os nomes de arquivo de todos os documentos abertos. O 
Dreamweaver exibe um asterisco após o nome do arquivo se tivermos feito alterações 
que ainda não foram salvas. 

Para acessar um documento, devemos clicar na aba correspondente. 

O Dreamweaver também exibe a Barra de Ferramentas Arquivos abaixo da aba do 
documento (ou abaixo da barra de título do documento, se estivermos exibindo 
documentos em janelas distintas). Documentos relacionados são associados ao arquivo 
atual, como arquivos CSS ou JavaScript. Para abrir um desses arquivos relacionados na 
janela Documento, devemos clicar no respectivo nome de arquivo na barra de 
ferramentas Arquivos relacionados. 

 
 

6.7 Visão geral da barra de ferramentas Padrão 
A barra de ferramentas Padrão contém botões para operações comuns nos menus 
Arquivo e Editar: Novo, Abrir, Navegar no Bridge, Salvar, Salvar tudo, Imprimir 
código, Recortar, Copiar, Colar, Desfazer e Refazer. Use esses botões do mesmo modo 
como utilizaria os comandos de menus equivalentes. 

Para mostrar essa barra, clicar no item de menu View > Toolbars > Standards. 
 

6.8 Visão geral da barra de status 
A barra de status, na parte inferior da janela Documento, fornece informações adicionais 
sobre o documento que está sendo criado. 

 
   A          BC D   E      F       G        H 

A. Select tag B. Select Tool C. Hand Tool  D. Zoom Tool  E. Set magnification F. Menu 
pop-up Tamanho da janela G. Download Size/Download Time H. Indicador de 
codificação 
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Select tags: Mostra a hierarquia de tags em torno da seleção atual. Clique em qualquer 
tag da hierarquia para selecionar a tag e todo seu conteúdo. Clique em <body> para 
selecionar o corpo inteiro do documento. Para definir os atributos class ou ID de uma tag 
no seletor de tags, clique com o botão direito do mouse (Windows) ou com a tecla 
Control pressionada (Macintosh) na tag e selecione uma classe ou ID no menu de 
contexto. 

Select Tool: Ativa e desativa a ferramenta Mão. 

Hand Tool: Permite clicar no documento e arrastá-lo na janela Documento. 

Zoom Tool e set magnification: Permite definir um nível de ampliação para o 
documento. 

Menu pop-up Tamanho da janela: (Não disponível na Visualização de código.) 
Permite redimensionar a janela Documento para dimensões predefinidas ou 
personalizadas. 

Download Size/Download Time: Mostra o tamanho aproximado do documento e o 
tempo de download estimado da página, incluindo todos os arquivos dependentes, como 
imagens e outros arquivos de mídia. 

Indicador de codificação: Mostra a codificação de texto do documento atual. 

 

6.9 Visão geral do painel Inserir 
O painel Inserir contém botões para criar e inserir objetos, como tabelas, imagens e 
links. Os botões são organizados em várias categorias, que podem ser alternadas pela 
seleção da categoria desejada no menu pop-up Categoria. Categorias adicionais 
aparecem quando o documento atual contém o código do servidor, como documentos 
ASP ou CFML. 
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Algumas categorias têm botões com menus pop-up. Ao selecionar uma opção em um 
menu pop-up, essa opção se transforma na ação padrão do botão. Por exemplo, se 
selecionarmos Alocador de espaço de imagem no menu pop-up do botão Imagem, na 
próxima vez que clicar no botão Imagem, o Dreamweaver vai inserir um alocador de 
espaço de imagem. Sempre que selecionamos uma nova opção no menu pop-up, a ação 
padrão do botão muda. 

O painel Inserir está organizado nas seguintes categorias: 

Categoria Common Permite criar e inserir os objetos usados com mais freqüência, 
como imagens e tabelas. 

Categoria Layout Permite inserir tabelas, elementos de tabelas, tags div, quadros e 
widgets do Spry. Podemos também escolher duas visualizações para tabelas: Padrão 
(opção padrão) e Tabelas expandidas. 

Categoria Forms Contém botões para criar formulários e inserir elementos de 
formulários, incluindo widgets de validação do Spry. 

Categoria Data Permite inserir objetos de dados do Spry e outros elementos dinâmicos 
como conjuntos de registros, regiões repetitivas e formulários de inserção e atualização 
de registros. 

Categoria Spry Contém botões para criar páginas do Spry, incluindo objetos de dados e 
widgets do Spry. 

A categoria do InContext Editing Contém botões para criar páginas do InContext 
Editing, incluindo botões para Regiões editáveis, Regiões repetitivas e gerenciamento 
CSS. 

Categoria Text Permite inserir uma variedade de tags de formatação de texto e de lista, 
como b, em, p, h1 e ul. 
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Categoria Favorites Permite agrupar e organizar os botões do painel Inserir usados com 
mais freqüência em um lugar comum. 

 

6.10 Visão geral do painel Arquivos 
Use o painel Arquivos para visualizar e gerenciar os arquivos no site do Dreamweaver. 

 
Ao visualizar sites, arquivos ou pastas no painel Arquivos, podemos alterar o tamanho 
da área de visualização e expandir ou reduzir o painel Arquivos. Quando está reduzido, 
o painel Arquivos exibe o conteúdo do site local, o site remoto, o servidor de teste ou o 
repositório SVN como uma lista de arquivos. Quando expandido, ele exibe o site local e 
o site remoto, o servidor de teste ou o repositório SVN. 

Para os sites do Dreamweaver, também podemos personalizar o painel Arquivos 
alterando a visualização (site local ou remoto) que aparece por padrão no painel 
reduzido. 

 

6.11 Visão geral do painel Estilos CSS 
O painel Estilos CSS permite rastrear as regras e propriedades CSS que afetam o 
elemento de página selecionado atualmente (modo Atual) ou as regras e propriedades 
que afetam o documento inteiro (modo Tudo). Um botão de alternância na parte superior 
do painel Estilos CSS permite alternar entre os dois modos. O painel Estilos CSS 
também permite modificar propriedades CSS no modo Tudo e no modo Atual. 
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Para redimensionar qualquer painel, arraste as bordas entre os painéis. No modo Atual, o 
painel Estilos CSS exibe três painéis: o painel Resumo para seleção que exibe as 
propriedades CSS da seleção atual do documento, o painel Regras que exibe o local das 
propriedades selecionadas (ou regras em cascata para a tag selecionada, dependendo da 
seleção) e o painel Propriedades que permite editar propriedades CSS para a regra que 
define a seleção. No modo Tudo, o painel Estilos CSS exibe dois painéis: o painel Todas 
as regras (na parte superior) e o painel Propriedades (na parte inferior). O painel Todas 
as regras exibe uma lista de regras definidas no documento atual, bem como as regras 
definidas nas folhas de estilo anexadas ao documento atual. O painel Propriedades 
permite editar propriedades CSS para todas as regras selecionadas no painel Todas as 
regras. 

Qualquer alteração efetuada no painel Proprieties é aplicada imediatamente, permitindo 
que seja visualiza enquanto trabalhamos. 
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Unidade 7 – Iniciando o Projeto de um 
Website 

 

 

 

Definindo um Site Local 

Criando uma nova página HTML 

Salvando uma página HTML 

Preferências do browser 
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Unidade 7 
Iniciando o Projeto de um Website 

7.1 Definindo um Site Local 
No Dreamweaver, o termo “site” refere-se a um armazenamento local ou remoto para os 
documentos que pertencem a um site. Um site do Dreamweaver facilita a organização e 
o gerenciamento de todos os documentos da Web, o carregamento do seu site em um 
servidor Web, o rastreamento e a manutenção de links, além do gerenciamento e o 
compartilhamento de arquivos. Devemos definir um site para aproveitar todos os 
recursos do Dreamweaver. 

O Dreamweaver define uma estrutura muito parecida com a estrutura de pastas para 
organizar os arquivos de um website. Uma maneira mais eficiente de gerenciar os 
arquivos de um site.  

Para criarmos um Site no Dreamweaver, devemos clicar no item de menu: Site > 
Manages Sites. 

  

ou acesse o atalho na barra de menus.  

Na janela Manage Sites, clicar no botão New > Site. 
Na janela de Site Definition escolher a opção: Advanced. 
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- Site Name: o nome do site; 

- Local Root Folder: localização, no disco rígido, da pasta que contém os arquivos do 
site; 

- Default Images Folder: pasta que o Dreamweaver usa para armazenar as imagens 
adicionais em nosso site; 

Por exemplo, se colocarmos uma imagem de nossa área de trabalho em uma página, o 
Dreamweaver a incluirá na pasta de imagens padrão definida. 

- HTTP Address: (opcional) é a URL do site. O Dreamweaver usa esse endereço para 
verificar os links que utilizam URLs absolutas; 

- Case-sensitive links: essa opção verifica se as letras nos nomes de arquivos contidos 
em seus links são exatamente iguais as dos arquivos vinculados; 
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Por exemplo, o nome de arquivo link.html não é igual a Link.html 

- Cache: Quando marcada, é gerado um cache local, o que agiliza as tarefas de 
gerenciamento do site. 

Geralmente, marcaremos essa opção; no entanto, em sites muito grandes, a recriação do 
cache pode tornar as operações mais lentas. 

 
LABORATÓRIO 
TAREFA 1 
Fomos contratados para criar a loja virtual de artigos esportivos AlfaSports. 
Depois de criar o layout utilizando o Fireworks e fatiar as imagens necessárias, devemos 
começar o trabalho no Dreamweaver. 
Primeiramente devemos criar a estrutura do site. 

1. Nome: AlfaSports; 

2. Local root folder: pasta ADDW CS4 > AlfaSports; 

3. Default images folder: pasta: ADDW CS4 > AlfaSports > Imagens  

4. Marcar as opções: use case-sensitive links e enable cache. 

Podemos observar que no painel Files já teremos nossos arquivos visíveis: 

 

7.2 Criando uma Nova Página HTML 
Para criar um novo documento, devemos clicar na coluna Create New escolhendo o 
item HTML: 
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É aberto um documento HTML em branco. 

Para adicionarmos um título a este documento novo, utilizamos a barra de ferramentas 
do documento. 

 

7.3 Salvando uma Página HTML 
Para salvar um arquivo, devemos ir ao File > Save As. 
Podemos salvar arquivos HTML utilizando a extensão .html ou .htm. Por padrão o 
Dreamweaver salva utilizando a extensão .html. 

Para alterar esta preferência, devemos ir até opção Edit > Preferences > Category New 
Document. 
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Obs.: Se desejarmos salvar todas as páginas abertas utilizamos File > Save All. 

7.4 Preferências do Browser 
O teste no navegador é essencial para visualizarmos como está ficando nosso website, 
ou o Dreamweaver oferece o botão Live View para visualizar rapidamente como ficou 
página ativa. Existe um grande número de browsers na Web. Podemos definir no 
Dreamweaver quais queremos visualizar em nossas páginas. 

Clicar no menu: Edit > Preferences,  escolher a opção Preview in Browser ou no atalho 
na Barra de Ferramentas do Documento. 
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Por default o IExplore está marcado como Primary browser, ou seja, quando 
pressionarmos o F12 nossa página abrirá no IE. 

Selecionar o browser Firefox e marcar a opção: Secondary browser: 
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Agora quando pressionarmos CTRL + F12 vemos nossas páginas no Firefox. 

No sinal de (+) ao lado da palavra Browsers podemos adicionar mais browsers (no 
máximo 20), bastando apenas especificar os campos na janela Add Browser: 

 
Para deletar um browser da lista é só clicar no sinal de (-) . 

Clicar em OK e nossas alterações estarão salvas. 

 
LABORATÓRIO 
TAREFA 1 
1. Criar um arquivo em branco e salvar como quem_somos.html 

2. Título da página: AlfaSports: Quem Somos 

3. Utilizar o botão Live View ou a tecla F12 para ver como ficou a página. 
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Unidade 8 – Adicionando conteúdo a 
um Website 

 

 

 

Importando arquivos de texto 

Controlando a estrutura do documento 

Adicionando caracteres especiais 
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Unidade 8 
Adicionando Conteúdo a um Website 

8.1 Importando Arquivos de Texto 
Como Web Designer, uma das principais tarefas é inserirmos textos em uma página e 
formatá-la para que fique legível para os usuários.  

No Dreamweaver podemos importar um arquivo do Word, aproveitando a estrutura de 
parágrafos e estilos. 

Selecionar File > Import > Word Document e escolher o texto que desejado. 

Deixar marcada a opção: Text, structure, basic formating (bold, italic) que trará o 
texto somente com o formato: bold (strong) e italic (i). 

Se desmarcarmos a opção Clean up Word Paragraph Spacing, nosso texto virá com a 
tag <p> indicando os parágrafos que foram feitos no Word. Se deixarmos marcada esta 
opção o texto virá separado com a tag <br />. 

Deixe desmarcada a opção Clean up Paragraph Spacing. 

Importante: Os comandos Import Word ou Excel estarão desabilitados se o Word ou 
Excel não estiverem instalados na máquina. 

 
LABORATÓRIO 
TAREFA 1 

1. Abrir o arquivo quem_somos.html dentro da pasta site. 

2. Deixar o cursor posicionado na primeira linha deste documento: 

 
3. Importar o arquivo quem_somos.doc da pasta textos; 
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4. Salvar o arquivo; 

 

8.2 Controlando a Estrutura do Documento 
Após colocarmos o texto em uma página, passamos algum tempo estruturando suas 
informações. Podemos estruturar o conteúdo usando: 

8.2.1 Títulos 

Separa as seções do conteúdo. Há seis níveis de títulos, cada um com um tamanho 
diferente. Esse tamanho varia sempre do maior para o menor: 
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Para formatar uma linha de texto como um título, devemos selecionar o texto e escolher 
o nível do titulo no menu Format, no Painel Properties: 

 
Não é possível aplicar um título a uma palavra ou frase apenas, em um determinado 
bloco de texto. Por isso, podemos posicionar o cursor do mouse em qualquer lugar 
dentro do texto e alterar sua formatação, não sendo necessário selecionar todo o bloco de 
texto. 

A criação de um título envolve o texto com as tags de título HTML: <h1> </h1> até 
<h6> </h6>. 

 
LABORATÓRIO 
TAREFA 1 
1. Abrir o arquivo quem_somos.html. 

2. Inserir um parágrafo na primeira linha deste documento e escreva: Quem Somos 
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3. Formatar este novo parágrafo como Heading 1. 

Veja como ficou nosso arquivo: 

 
4. Salvar o arquivo. 

8.2.2 Parágrafos 

Sempre que pressionarmos "Enter" na página HTML será criado um novo parágrafo. 

Um parágrafo é destacado por uma quantidade de espaço definido acima e abaixo do 
texto. Quando ele é exibido no navegador, o texto é quebrado de acordo como tamanho 
da janela deste navegador. 

À medida que o usuário aumenta ou diminui o tamanho da janela, o texto flui para se 
acomodar. 

 
A criação de parágrafos no Dreamweaver envolve o texto com as tags de HTML: <p> 
</p>. 

8.2.3 Quebra de Linha 

As quebras de linha são utilizadas para inserir uma nova linha, não um novo parágrafo, 
dentro de um bloco de texto. 
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Diferentemente de um parágrafo, há uma quantidade menor de espaçamento dentro de 
uma quebra de linha. Assim, uma quebra de linha é útil para manter juntas as 
informações relacionadas. 

Esse recurso ajuda a exibir endereços, por exemplo. 

 

 
LABORATÓRIO 
TAREFA 1 
1. No mesmo arquivo (quem_somos.html) deixar o cursor do mouse no último 

parágrafo do documento: 

 
2. Digitar: “Avenida Conceição nº100”. Ao invés de pressionarmos "Enter", pressionar 

SHIF + ENTER para inserir uma quebra de linha. 

3. Na linha seguinte digitar: “Bairro Primavera  - Jandira”. Pressione SHIFT + ENTER. 

4. Na outra linha digite: “Fone (44) 3333.4444”. 

Veja como ficarão nossas linhas: 

 
5. Salvar o documento. 

8.2.4 Listas 

Podemos utilizar três tipos de listas em HTML: 

- Listas não-ordenadas: são freqüentemente chamadas de listas com marcadores. 

Para formatarmos a lista corretamente, cada item da lista, deve estar em um parágrafo 
separado. 

- Listas ordenadas: são as listas que permitem numerar os itens. Por exemplo, podemos 
ao invés de colocar os marcadores na lista anterior, numerar item a item  
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- Listas de definições: é uma lista formada por vários termos e suas respectivas 
definições. 

Para que essa formatação funcione, o termo e a respectiva definição devem estar (cada 
um) em um parágrafo separado. 

8.2.4.1 Criação de uma nova lista 

No documento do Dreamweaver, colocamos o ponto de inserção onde desejamos 
adicionar uma lista e devemos seguir um destes procedimentos: 

• No Painel Properties HTML, clicar no botão Unordered List ou Ordered List. 

 
• Selecionar Format > List e, em seguida, selecionar o tipo de lista desejada: Unordered 
List (com marcadores), Ordered List (numerada) ou Definition List. 

O caractere à esquerda do item de lista especificado aparece na janela Documento. 

Digitar o texto do item de lista e pressionar ENTER para criar outro item de lista. 

Para concluir a lista, pressionar ENTER duas vezes. 

 

8.2.4.2 Criação de uma lista usando um texto existente 

Selecionamos uma série de parágrafos para transformar em uma lista. 

No Painel Properties do HTML, clique no botão Unordered List ou Ordered List  ou 
selecionar Format > List e selecionar o tipo de lista desejada: Unordered List (com 
marcadores), Ordered List (numerada) ou Definition List. 

8.2.4.3 Mudando as propriedades de uma lista 

É possível aplicar dois estilos diferentes de marcadores a listas não-ordenadas: Boletim 
(círculo) e Square (quadrado). 

Posicionar o cursor em um item e clicar no botão List Item, localizado no Painel 
Properties. 
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Podemos aplicar estilos diferentes de numeração a nossa lista ordenada: 

Posicionar o cursor do mouse em uma lista ordenada e clicar no botão List Item no 
Painel Properties. 

No menu pop-up New style escolher o estilo que deseja usar: 

 
 

8.2.4.4 Remover uma lista 

Se quisermos remover a lista do texto, basta selecionar o texto (ou posicionar o cursor) e 
clicar no menu: Format > List > Nome ou clicar, novamente, em Unordered List ou 
Ordered List  no Painel Properties. 

 
LABORATÓRIO 
TAREFA 1 

1. Criar um novo arquivo HTML e salvar como: como_comprar.html na raiz da pasta 
site. 

2. Title: AlfaSports: Como Comprar. 
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3. Posicionar o cursor do mouse na primeira linha do documento e importar o texto 
como_comprar.doc que está dentro da pasta textos. 

Deixar desmarcada a opção: Clean up Word parágrafo spacing. 

 
4. Selecionar da segunda linha até o final do documento e criar uma lista não-ordenada 

(com marcadores). 

 
5. Mudar os marcadores para Square. 

6. Salvar o arquivo. 

 

TAREFA 2 
1. Criar um novo arquivo HTML e salvar como duvidas.html na raiz da pasta site. 

2. Title: “AlfaSports: Dúvidas”. 

3. Posicionar o cursor do mouse na primeira linha do documento e importar o texto 
“duvidas.doc” que está dentro da pasta textos. 

4. Criar uma lista de definição para todo o texto importado (Format > List > Definition 
List). 

Veja como ficou nosso texto: 

 
A criação de uma lista de definição gera um conjunto de tags para a lista, o termo e a 
definição: 

<dl> 
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      <dt> Este é o termo </dt> 

      <dd> Esta é a definição </dd> 

</dl> 

5. Salvar o arquivo. 

8.3 Adicionando Caracteres Especiais 
Algumas vezes precisamos usar caracteres que não estão acessíveis no teclado. Para 
isso, devemos ir até o item de menu Insert > HTML > Special Characters e selecionar 
o caracter desejado. 

Podemos obter mais caracteres especiais selecionando a opção: Other: 

 
 
LABORATÓRIO 
TAREFA 1 
1. Abrir o arquivo quem_somos.html  

2. No último parágrafo digitar: “2099 AlfaSports”. 

3. Posicionar o curso antes da palavra “AlfaSports” e adicionar o caracter de  
Copyright (Insert > HTML > Special Characters > Copyright). 

4. Veja como ficou o texto: 
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5. Salvar o arquivo. 
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Unidade 9 – Aplicando Folhas de Estilo 
em Cascata (CSS) 

 

 

 

Criando estilos 

Usando Pontos, Pixels ou Ems para tamanhos de fontes 

Editando regras de estilo 

Criando estilos de classe 

Anexando folhas de estilos externas 

Duplicando estilos 

Criando estilos avançados 

Criando uma folha de estilo externa 
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Unidade 9 
Aplicando Folhas de Estilos em Cascata 

(CSS) 

9.1 Criando Estilos 
A especificação Cascading Style Sheets (CSS) para páginas HTML permite definir o 
modo de exibição do nosso conteúdo. 

A CSS proporciona mais flexibilidade e controle da aparência da página do que o 
HTML puro, ou seja, mudando um atributo de um estilo formatamos, imediatamente, 
todo o texto controlado por este atributo. 

Na CSS temos os seguintes termos: 

- Regra de estilo: é um grupo de propriedades de formatação identificadas por um nome 
único, controla a formatação do texto. 

- Folha de estilo: é um grupo de estilos que definem a aparência das páginas na Web. 

Para trabalharmos com CSS no Dreamweaver, temos duas opções:  

• O Painel CSS Styles  

 
• O CSS no Painel Properties. 

 
No modo All, o painel CSS Styles exibe dois painéis: o painel All Rules na parte 
superior e o painel Properties na parte inferior. 
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No painel Properties, podemos editar ou adicionar novas propriedades CSS para 
qualquer regra de estilo selecionada, no painel Rules. 

Clicar no botão New CSS Rule , localizado na parte inferior do painel CSS Styles.  

 
A caixa de diálogo New CSS Rule permite criar quatro tipos de regras CSS: 

- Class: para definir um estilo e aplicá-lo a qualquer texto selecionado; 

- ID: idem a class;  

- Tag: para definir o modo de exibição de texto dentro de uma tag HTML; 

- Compound: para definir a formatação de uma combinação especifica de tags ou para 
ID. 

Dependendo da opção selecionada, informar o nome ou apenas selecionar a tag a ser 
definida os estilos CSS. 

Na opção Rule Definition: 

- This document only: cria a nova regra apenas para este documento; 

- New Style Sheet File: cria a nova regra numa folha de estilo. Neste passo, devemos 
informar o arquivo ou criá-lo se não existir. 
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Depois de clicarmos no OK, devemos informar todas as formatações para esta regra. 

Na caixa de diálogo CSS Rule Definition o Dreamweaver oferece diversas opções: 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

90                                    2009  Alfamídia LTDA. 
 

TYPE: atributos da fonte; 

 
− Font-family: define o nome da fonte; 

− Font-size: tamanho das fontes nas medidas px, pt, em, cm; 

− Font-weight: define a espessura de uma fonte; 

− Font-style: define o estilo da fonte; 

− Font-variant: exibe texto com fonte normal ou small-caps (letras minúsculas 
convertidas em maiúsculas). 

− Line height: define a distância entre as linha; 

− Text-transform: controla o formato das letras de um elemento ( 
maiúscula/minúscula) 

− Text-decoration: decoração do texto; 
 Underline: texto sublinhado; 
 Overline: texto sobrelinhado; 
 Line-through: texto com uma linha em cima; 
 Blink: faz o texto piscar (não funciona no IE); 
 None: nenhuma decoração; 
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− Color: define a cor do texto; 
 

BACKGROUND: cor ou imagem e outras propriedades do fundo; 

 
− Background-color: cor do fundo; 

− Background-image: imagem de fundo; 

− Background-repeat: define se uma imagem será repetida no plano de fundo, e 
como isso será feito; 

− Background-attachment: define se a imagem de fundo permanece fixa ou é 
paginada com barra de rolagem; 

− Background-position (X): onde a imagem de fundo é posicionada na horizontal; 

− Background-position (Y): onde a imagem de fundo é posicionada na vertical; 
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BLOCK: alinhamento e recuo do texto, juntamente com outras propriedades do bloco 
de texto; 

 
− Word-spacing: aumenta ou diminui o espaço entre palavras; 

− Letter-spaccing: aumenta ou diminui o espaço entre os caracteres; 

− Vertical-align: define o alinhamento vertical de um elemento; 

− Text-align: define o alinhamento do texto; 

− Text-indent: indenta a primeira linha de um texto em um elemento; 

− White-space: define como os espaços em branco dentro de um elemento são 
tratados; 

− Display: define se/como um elemento será exibido; 
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BOX: margens e preenchimentos ao redor do texto ou imagem; 

 
− Width: define a largura do elemento; 

− Height: define a altura do elemento; 

− Float: define onde um elemento será exibido em relação a outro elemento; 

− Clear: define qual(is) lado(s) de um elemento não permite(m) a presença de outros 
elementos flutuantes; 

− Padding: define o espaço que existe entre um elemento e as bodas da célula que o 
contém; 

− Margin: define o espaço que contorna um elemento; 
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BORDER: define uma borda ao redor do texto ou imagem; 

 
− Style: define o estilo da borda; 

− Width: define a largura da borda; 

− Color: define a cor da borda; 
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LIST: Muda o marcador e sua posição; 

 
− List-style-type: define o tipo de marcador para os itens da lista; 

− List-style-image: define uma imagem como marcador de lista; 

− List-style-Position: define onde o marcador do item da lista será posicionado em 
relação à lista. 
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POSITIONING: define o posicionamento exato do texto na página; 

 
− Position: posiciona um elemento em posição estática, relativa, absoluta ou fixa; 

− Width: define a largura do elemento; 

− Height: define a altura do elemento; 

− Visibility: define se um elemento será visível ou não em uma página; 

− Z-Index: define a posição de um elemento dentro de uma fila de elementos; 

− Overflow: define o que acontece com o conteúdo de um elemento caso ele 
ultrapasse sua área; 

− Placement:  

− Clip: define a forma de um elemento. O elemento é reduzido a esse formato e só 
então é exibido. 
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EXTENSIONS:  

 
− Page-break-before: define uma quebra ao imprimir depois do objeto controlado 

pelo estilo; 

− Page-break-after: define uma quebra ao imprimir antes do objeto controlado pelo 
estilo; 

− Visual Effect (Cursor): define o tipo de cursor que será exibido; 

− Visual Effect (Filter): define filtros que permitem alterar o nível de 
transparência/opacidade de um elemento; 

Importante: nem todos os navegadores suportam as opções contidas na 
categoria Extensions. Por isso é importante testarmos antes de publicar 
nosso site.  

9.2 Usando Pontos, Pixels ou Ems para Tamanhos de Fontes 
Ao modificarmos o tamanho de uma fonte, podemos observar que temos várias opções 
de medida. 
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9.2.1 Tamanhos Relativos 

• xx-small – xx-large: define as fontes em relação ao tamanho de fonte do 
navegador; 

• ems e exs: em relação ao elemento pai; 

• porcentagem: em relação ao texto ao redor 

A acessibilidade é um aspecto importante em uma página, por isso recomenda-se usar 
“ems” para tamanhos de fonte. Ems são dimensionados de modo que o tamanho da fonte 
seja relativa ao elemento pai (body).  

O problema na ems é a perda de controle sobre a aparência exata da página. Alguns 
usuários podem ter tamanho padrão maior ou menor do que aquele que costumamos 
utilizar. 

9.2.2 Tamanhos Absolutos 

• Pontos e picas: unidades de impressão; 

• Pixels: em relação à resolução da tela; 

• Polegadas, centímetros e milímetros: unidades de comprimento. 

Pontos são unidades recomendadas para serem utilizadas em fontes de estilo de 
impressão. Pixels são unidades baseadas na resolução da tela. 

A desvantagem de usar pixels é que os usuários não poderão ajustar o tamanho da fonte 
em seus navegadores. 

 
LABORATÓRIO 
TAREFA 1 
1. Retornar ao arquivo: quem_somos.html 
2. Criar uma nova regra para a tag “body”; 
3. Definir a regra num novo arquivo de Folha de estilos com o nome de site.css dentro 

da pasta CSS; 

4. Definir as formatações da Categoria Type conforme a figura abaixo 
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5. Definir as formatações da Categoria Box conforme a figura abaixo: 
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Obs.: Após anexarmos uma folha de estilo num arquivo HTML, o Dreamweaver mostra 
o arquivo CSS anexado ao lado de uma opção código fonte do arquivo ativo. 

 
6. Criar uma nova regra para a tag “p”; 

7. Definir as formatações da Categoria Block conforme a figura abaixo: 

 
8. Salvar todos os arquivos (File > Save All). 
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9.3 Editando Regras de Estilo 
Após criarmos uma folha de estilo, podemos facilmente adicionar ou alterar os estilos.  

Duplo clique em cima da regra selecionada. 

Podemos, ainda, selecionar a regra e editar suas propriedades no Painel Properties: 

 
Ou selecionar a regra e clicar no botão Edit Rule . 

Na caixa de diálogo CSS Rule Definition colocar o valor de 20 no item Line height e 
clicar em OK. 

 
No painel CSS Styles temos algumas opções de visualização que são úteis na edição de 
regras de estilos: 

 
- Show category view: mostra a visualização por categorias; 

- Show list view: mostra a visualização por listas; 

- Show only set properties: mostra apenas as propriedades definidas. 

9.4 Criando Estilos de Classe 
Os estilos de classe são os únicos tipos de estilos CSS que podem ser aplicados a 
qualquer texto em um documento, mesmo que as regras de tags também controlem esse 
texto. 

Por exemplo, se criarmos uma regra para de tag para o texto com nível de título 
Heading1, também poderemos selecionar uma palavra dentro deste texto e aplicar um 
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estilo de classe. A partir de então, a formatação do estilo da classe ignorará o estilo de 
tag na palavra selecionada. 

Para criar uma classe no Dreamweaver, devemos criar uma nova regra de estilo clicando 
no botão: New CSS Rule. 

Selecione a opção Class em Selector Type. 

 
Digitar o nome para a classe no campo Selector Name e definir onde será criada esta 
regra (somente neste documento ou numa folha de estilo) 

Definir as formatações para esta classe e OK. 

Os estilos de classe sempre começam com um ponto. 

A seguir, devemos aplicar esta classe a um texto ou objeto no arquivo HTML através do 
Painel Properties, no item Class selecionar a classe desejada. 

 
 
LABORATÓRIO 
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TAREFA 1 
1. Retornar ao documento quem_somos.html. 

2. Criar uma nova regra de estilo clicando no botão: New CSS Rule. 

3. Selecionar a opção Class em Selector Type. Digitar o nome da classe de “realcado”. 

4. Definir que a regra de estilo deve estar incorporada a folha de estilo externa 
“site.css”. 

 
5. Clicar em OK. Na janela CSS Rule Definition, marque as opções como na imagem: 
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6. Para aplicar o estilo de classe selecionar o texto “AlfaSports” que está no primeiro 

parágrafo do documento. 

7. No Painel Proprieties, no item Class selecione o “realcado”. 

 
Pronto, nosso texto, previamente selecionado, já está com o estilo de classe aplicado. 

8.  Aplicar este estilo a todos os textos “AlfaSports” do documento. 

9. Salvar o arquivo. 
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9.5 Anexando Folhas de Estilos Externas 
Folhas de estilos são arquivos com extensões .css que contém regras de estilos. É 
possível anexar uma ou mais folhas de estilos a uma página. Exceto para os estilos de 
classe, as regras de estilo são aplicadas automaticamente a esse documento. 

O arquivo .css da folha de estilo externa deverá ser vinculado ao documento HTML, 
clicando no botão Attach Style Sheet, localizado no final deste painel CSS Style: 

 
Também, podemos anexar uma folha de estilos pelo Painel Properties, selecionando a 
opção Attach Style Sheet no menu pop-up Style: 

 
Na caixa de diálogo Attach External Style Sheet, clicar em Browse e selecionar o folha 
de estilos desejada. Na opção Media, selecionar a mídia que será aplicada os estilos. 
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O tipo de mídia (media) especifica o modo como o documento será apresentado em 
diferentes mídias. Suas opções são: 

- All: adequada a todos os dispositivos; 

- Aural: voz; 

- Braille: para dispositivos de leitura tátil pelo método Braille; 

- Handheld: PDA, tela pequena, largura de limitada; 

- Print: para material impresso; 

- Projection: para projetores; 

- Screen: para telas de computador; 

- TTY: terminais oi dispositivos portáteis com capacidade de exibição limitadas; 

- TV: dispositivos do tipo televisão. 

Assim que uma folha de estilos estiver anexada, o arquivo constará no painel CSS Styles 
e o arquivo fonte ao lado do arquivo fonte HTML. 

 
LABORATÓRIO 
TAREFA 1 

1. Abrir o arquivo como_comprar.html 

2. Anexar a folha de estilo Site.css clicando no botão Attach Style Sheet, localizado no 
final do painel CSS Style. 
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3. Na caixa de diálogo Attach External Style Sheet, clicar em Browse e selecionar o folha 

de estilos “site.css”. Na opção Media selecionar screen: 

 

 
4. Salvar seu arquivo. 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

108                                    2009  Alfamídia LTDA. 
 

5. Abrir o arquivo duvidas.html e anexar a folha de estilo: “site.css” da mesma forma 
como fizemos no arquivo quem_somos.html 

9.6 Duplicando estilos 
No Dreamweaver podemos aproveitar um estilo já criado e aplicá-lo a outro seletor 
HTML ou classe. 

Devemos clicar com o botão da direita sobre o seletor a ser duplicado e selecionar a 
opção Duplicate. 

 
Após devemos definir qual será o elemento que utilizará as mesmas formatações do 
estilo duplicado. 
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LABORATÓRIO 
TAREFA 1 

1. Abrir o arquivo duvidas.html. 

2. No painel CSS Styles, clicar com o botão da direita sobre o estilo “p”, selecionar 
duplicate. 

3. Na opção Selector Name, selecionar a tag “dl”. 

4. OK. 

5. Devemos criar uma nova regra CSS para a tag “dt”, com a font-weight=bold. 

6. Salvar todos os arquivos. 

9.7 Criando Estilos Avançados 
Os seletores de pseudo-elementos servem para especificar o estilo para parte de um 
bloco de texto como, por exemplo, a primeira letra de um parágrafo. 

 
LABORATÓRIO 
TAREFA 1 

1. Abrir o arquivo duvidas.html. 

2. Criar uma nova regra e selecionar a opção Compound,  digitando: “dt:first-letter”. 
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3. Na tela CSS Rule Definition especificar as informações como na imagem: 

 
4. Clicar em OK e veja com ficou nosso texto. 
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9.7.1 Outro exemplo de pseudo-elemento : 

p:first-line – controla a formatação da primeira linha de texto da tag especificada. 

Temos, também, os seletores de combinação que podemos criar digitando uma 
combinação de tags. Temos dois tipos que são: 

- Contextual: especifica uma regra de estilo aplicada a uma tag somente quando 
aparecer no contexto de outra tag específica. Deve haver um espaço entre essas tags.  

Ex: td p strong 

No exemplo, a regra de estilo só é aplicada ao texto contido em um tag <strong> dentro 
de uma tag <p> que esta dentro de uma tag <td>. 

- Group: especifica uma única regra de estilo a ser aplicada a um grupo de tags. Cada 
tag será separada por uma vírgula. 

Ex: p,td,li 

No exemplo, a regra de estilo é aplicada a tag de parágrafo (<p>), a tag de dados de 
tabela (<td>) e a tag de item de lista (<li>). 

9.8 Criando uma Folha de Estilos Externa 
Anteriormente criamos um folha de estilo no momento que estávamos criando um regra 
de estilo, mas o Dreamweaver permite criar a folha de estilo primeiramente. 

 Clicar no menu File > new e selecionar no item Page Type a opção CSS. Clique no 
botão Create: 
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Selecionar File > Save e salvar o arquivo dentro da pasta CSS com o nome desejado. 

O Dreamweaver adiciona automaticamente a extensão .css ao nome do arquivo. 

Podemos aproveitar estilos que já foram definidos a outras folhas de estilos, utilizando o 
comando copiar/colar. 

Dica: Selecionado uma regra de estilos e clicando com o botão direito do mouse temos 
algumas opções: 

 
A opção Move CSS Rules, move a regra selecionada para outra folha de estilos que já 
tenhamos criada. Basta selecionar o botão Browse e escolher o arquivo: 

 

9.8.1 A Barra de Ferramentas Style Rendering 

A barra de ferramentas Style Rendering contém botões para exibir a página, usando 
tipos de mídias diferentes.  

Selecione o menu: View > Toolbars > Style Rendering para ativarmos esta barra: 

 
 
LABORATÓRIO 
TAREFA 1 

1. Criar um novo arquivo CSS e salvar como site_print.css, dentro da pasta CSS; 

2. Abrir a folha de estilos “site.css” 

3. Selecionar a regra da tag “p”,  copiar e colar dentro da folha de estilos “site_print.css”. 
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4. Selecionar a tag “p” no arquivo site_print.css e editar suas definições como na imagem: 

 
5. Salvar o arquivo site_print.css 

 

TAREFA 2 
1. Abrir o arquivo quem_somos.html; 

2. Clicar no botão Attach Style Sheet e escolher o folha site_print.css selecionando o tipo 
de mídia para print: 
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3. Clicar no botão Render Print Media Type  na barra de ferramentas Style Rendering 
(Ver as mudanças na visualização do documento). 

4. Agora, clicar no botão Render Screen Media Type   (Ver que nosso documento 
voltou ao modo de exibição screen). 

5. Salvar o arquivo. 

6. Abrir os arquivos: como_comprar.html e duvidas.html e anexe à folha de estilo 
“site_print.css” selecionando o tipo de mídia print. 

7. Ao final teremos todos os nossos arquivos html com uma folha de estilo com mídia screen 
e outra com a mídia print. 

8. Salvar todos os arquivos. 
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Unidade 10 – Inserindo diferentes 
mídias no Site 

 

 

 

Imagens na Web 

Usando a barra de inserção para imagens 

Redimensionando uma imagem 

Alinhamentos e espaçamentos em uma imagem 

Usando o Painel Assets 

Inserindo um arquivo do Flash 

Adicionando um Vídeo do Flash 
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Unidade 10 
Inserindo Diferentes Mídias no Site 

10.1 Imagens na Web 
As imagens proporcionam vida, interesse e funcionalidade as páginas da Web. Elas 
estão disponíveis em vários formatos, mas existem três formatos principais que são: 

Formato JPEG (extensão.jpg) 
O formato JPEG (Joint Pictures Expert Group) é um tipo de arquivo para 
armazenamento de imagens que trabalha com o esquema de cores de 24bits, ou seja, 
aceita 16,8 milhões de cores. É um dos formatos de imagens mais populares e isso se 
deve à capacidade de formar imagens fiéis à original.  

O JPEG utiliza um algoritmo de compactação que se baseia na capacidade do olho 
humano. Sabendo-se que o JPEG pode trabalhar com até 16,8 milhões de cores, o olho 
humano não é capaz de enxergar todas elas de uma vez. Assim, é possível tirar uma série 
de informações que representam cores em imagens e manter apenas aquelas visíveis ao 
olho humano, esse processo é conhecido como compressão. 

Este formato de imagem pode ter diferentes níveis de compressão. Quanto maior a 
compressão, menor será o tamanho do arquivo o que deixará a imagem com uma 
qualidade baixa. Menor a compressão, maior será o tamanho do arquivo e terá uma 
qualidade alta. Toda vez que o JPEG for salvo perderá qualidade. 

 
Formato GIF (extensão.gif) 
O formato GIF (Graphics Interchange Format) é um tipo de arquivo para imagens que 
trabalham com uma paleta de 256 cores, o que o torna um formato de imagem bastante 
reduzido. Isso faz com que o GIF não seja recomendável para figuras que precisam de 
aproximação com a realidade, a não ser que a imagem seja em preto e branco. Devido a 
esta característica, o uso deste formato é mais voltado para ícones ou imagens que não 
precisam de muitas cores, como logotipos, por exemplo.  

Apesar de trabalhar com um baixo número de cores, o GIF é muito utilizado pela sua 
capacidade de ter o fundo transparente e por aceitar que uma seqüência de imagens 
sejam salvas em um único arquivo, onde cada imagem surge no lugar da anterior após 
um tempo pré-determinado, isso dá a sensação de animação. O GIF utiliza um formato 
de compressão que não altera a qualidade da imagem a cada salvamento e aceita o 
entrelaçamento. 

 

Formato PNG (extensão.png) 
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O formato PNG (Portable Network Graphics) consegue trabalhar com esquema de cores 
de 24 bits, ou seja, 16,8 milhões de cores. Sua compressão é mais é mais eficiente e não 
proporciona perde de qualidade da imagem a cada salvamento. Possui o recurso da 
transparência como o formato gif. 

Este formato é eficaz na compactação de imagens de cor sólida e na conservação de 
detalhes de nitidez. O formato PNG - 8 utiliza uma paleta de 256 cores para representar 
uma imagem; o formato PNG - 24 utiliza uma paleta de 256 cores. 

10.2 Usando a Barra de Inserção para Imagens 
Para inserir uma imagem podemos utilizar a barra de inserção. 

Clicar em Image e selecionar Image no menu pop-up, escolher a imagem desejada. 

 
Definir o texto alternativo e clicar em OK 
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10.3 Redimensionando uma Imagem 
É possível modificar propriedades de uma imagem como: redimensioná-la, ajustar o 
texto ao redor da imagem, modificar o espaço e a borda da imagem, alinhar imagens ao 
texto e definir textos alternativos para e imagem. 

Selecionar a imagem e observar que no Painel Properties temos o seu tamanho: W 
(largura) e H (altura): 

 
Podemos especificar, por exemplo, que queremos 200 de largura (W) para a imagem e 
não marcar nem um valor na altura (H) que nossa imagem adquire um tamanho 
proporcional, sem distorções: 
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No entanto, nossa imagem permanece com o mesmo tamanho: 90k. O recomendável 
seria ajustar o tamanho desta imagem em um software com este fim. 

O Dreamweaver permite que executemos operações básicas de edição de imagens GIF e 
JPEG. 

Primeiro, vamos voltar a imagem em seu tamanho normal (que foi importada), clicando 

no botão Resample  no Painel Properties. 

Depois selecionar a imagem e escolher a opção Crop  .  
Aparece uma borda corte delimitando nosso corte. Reduzir a área da imagem dando um 
duplo clique em cima da área de corte ou <entre> para aplicá-lo: 

 
Do lado do Crop temos mais algumas opções: 

 
O terceiro botão é o Brightness and Contrast que modifica o brilho ou contraste dos 
pixels da imagem. 

E o último botão é o Sharpen que ajusta o foco da imagem, aumentando o contraste das 
bordas localizadas dentro da imagem. 

Um pouco mais acima, temos também a opção Edit  que abre o software para editar a 
imagem. Por padrão será executado o Photoshop, mas podemos alterá-lo no item Edit > 
Preferences > File Types/Editor. 
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O botão Edit Image Setting  abre a janela Image Preview para fazermos alguns 
ajustes na imagem, se necessário: 
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10.4 Alinhamentos e Espaçamentos em uma Imagem 
As imagens podem ser alinhadas a esquerda (padrão), no centro ou à direita da página. 

Os botões para alinhamento da imagem estão localizados no Painel Properties: 

 
Ao usarmos o menu pop-up Align para ajustar o texto ao redor da imagem, também 
podemos ajustar o espaço ao redor da imagem. No Painel Properties temos os seguintes 
atributos de espaçamento e borda: 
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- V Space: informa ao navegador quantos pixels haverá no eixo vertical (superior e 
inferior) da imagem; 

- H Space: informa ao navegador quantos pixels haverá nos lados horizontais (esquerdo 
e direito) da imagem; 

- Border: Largura da borda em pixels a ser incluída ao redor da imagem. 

10.5 Usando o Painel Assets 
O painel Assets exibe tipos diferentes de mídias e itens do site. É possível visualizar 
todos os recursos do site em um local e adicionar o conteúdo diretamente do painel a 
página com facilidade.  

Clicar na aba Assets localizada no painel Files: 

  
Todas as imagens no site atual são exibidas na categoria Images. 

Quando uma imagem é selecionada no painel, uma visualização é exibida na parte 
superior do painel. 

Rolar pela lista de imagens no painel Assets pode ser cansativo quando temos um 
número muito grande de imagens no site. Para facilitar o acesso a determinadas imagens 
podemos adicioná-las a lista de favoritos. 

No painel Assets selecionar a imagem logo_alfa_sports.gif e clicar com o botão direito 
do mouse. Selecionar a opção: Add to Favorites:  
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Nas opções na parte superior do painel Assets marcar Favorites: 

 
Observar que temos uma imagem na lista de favoritos do painel Assets 

Podemos adicionar aos favoritos usando o botão Add to favorites no painel de arquivos. 

 
 
LABORATÓRIO 
TAREFA 1 
1. Abrir o arquivo duvidas.html. 

2. Substituir o texto “Fale Conosco” por  “link”. 

3. Logo após, na categoria Common da barra de inserção, clicar em Image e 
selecionar Image no menu pop-up, escolhendo a imagem ico_carta.gif que está 
dentro da pasta Imagens. 
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4. Na caixa de diálogo definir as configurações de texto alternativo como na imagem 

abaixo e clique em OK. 

 
5. Repetir a operação para o Fale Conosco do final do texto. 

6. Pressionar SHIFT + ENTER após “Temos dois canais de comunicação para garantir 
a qualidade do atendimento ao cliente.” e após a imagem inserida anteriormente. 

7. Salvar o arquivo. 

 

TAREFA 2 
1. Abrir o arquivo quem_somos.html, colocar o cursor após a palavra “O Gigante”. 

2. Inserir a imagem prédio.jpg (Texto alternativo: O Gigante). 

3. Através da opção Align do Painel Properties, definir o alinhamento right. 

4. Depois selecionar a imagem e escolher a opção Crop  .  
5. Marcar uma região suficiente para destacar o prédio da figura e pressionar ENTER. 
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6. Definir 10 para as propriedades H Space e V Space. 

 

10.6 Inserindo um Arquivo do Flash 
O Adobe Flash CS4 é um aplicativo que gera arquivos swf que contém animações para 
inserirmos em nosso site.  

Alguns conteúdos podem ser incluídos em nossas páginas, independentemente do Flash 
estar ou não instalados em nossa máquina. 

Para inserir uma animação do flash, devemos ir ao Painel Insert, Categoria Common, 
opção Media e selecionar SWF no menu pop-up. 
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Na caixa de diálogo Select File, selecionar o arquivo flash desejado e clicar em OK: 

O conteúdo Flash aparece como uma caixa cinza na página que quando selecionado é 
exibido, no painel de propriedades, um botão de Play que serve para reproduzir o 
conteúdo do Flash: 

 
Selecionando o painel Assets e clicando no ícone Flash à esquerda do painel, podemos 
ver os conteúdos de Flash: 

 
Podemos inserir esse arquivo clicando e arrastando o arquivo Flash do painel para a 
página. 
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Também, podemos inserir um arquivo Flash do painel de arquivos, selecionando-o e 
arrastando-o para a página: 

 
 

10.7 Adicionando um Vídeo do Flash 
O formato Flash Vídeo é uma maneira fácil de exibir conteúdo de vídeo na web com o 
popular Flash Player. Em vez de depender de plug-ins ou reprodutores que os usuários 
devem obter por download, podemos ver o vídeo executado no reprodutor Flash, o que 
permite alcançar um número maior de pessoas com custos menores de desenvolvimento, 
teste e suporte. 

Antes de podermos adicionar o vídeo à página da web, devemos codificá-lo, o que 
envolve a conversão no formato Flash Vídeo (FLV). 

Para inserir o vídeo selecione: Insert > Media > FLV. 

Abre-se a caixa de diálogo Insert FLV permitindo definir várias opções: 
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- Video Type: no modo Progressive Download o arquivo de vídeo está localizado no 
servidor, é realizado o download para a unidade de disco do usuário e o arquivo é 
reproduzido. A reprodução do vídeo inicia antes de o arquivo ser inteiramente copiado; 
no modo Streaming Video requer um servidor de fluxo; 

- URL: define qual o arquivo de flash vídeo será inserido. Devemos clicar no botão 
Browse... para selecionarmos o arquivo dog.flv da pasta Video. 

- Skin: especifica a aparência do componente Flash Video. Podemos escolher a 
aparência no menu pop-up; 

- Width and Height: tamanho do arquivo de vídeo. Podemos clicar em Detect Size para 
que o Dreamweaver leia as informações de tamanho no arquivo FLV; 

- Auto Play: especifica se o vídeo será reproduzido quando a página abrir; 

- Auto Rewind: especifica se a cabeça de execução retornará à posição inicial após a 
reprodução do vídeo; 

Clicar em Ok e nosso vídeo será inserido na página. 

Para visualizarmos o vídeo, devemos clicar no Live View ou F12. 
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Unidade 11 – Usando bibliotecas e 
modelos 

 

 

 

Itens de biblioteca 

Colocando itens de biblioteca em uma página 

Modificando itens da biblioteca 

Desanexando e excluindo itens da biblioteca 

Criando modelo de site 

Definindo regiões editáveis 

Usando modelos 

Aplicando um modelo a uma página existente 

Modificando o modelo 
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Unidade 11 
Usando Bibliotecas e Modelos 

11.1 Itens de Biblioteca 
Um item de biblioteca é um arquivo Dreamweaver especial que contém uma coleção de 
elementos de página (por exemplo, texto e gráficos) que podem ser facilmente 
adicionados a qualquer página no site atual. Elas não são propriamente páginas HTML, e 
sim apenas elementos de página reutilizáveis.  

Para modificar um design de página ou adicionar novas páginas, é preciso apenas editar 
os itens de biblioteca associados em vez de cada página. 

Itens de biblioteca: 

- Podem ser reutilizados e atualizados em um só lugar; 

- São ideais para conteúdo como cabeçalhos de página, rodapés e barras de navegação; 

- São totalmente bloqueados e não podem ser editados nas páginas onde são usados. 

Podemos criar um item de biblioteca do zero ou selecionar um conteúdo em uma página 
que desejamos tornar item de biblioteca. 

A biblioteca é encontrada no painel Assets. Neste painel, clicar na categoria Library  
e, em seguida, no item New Library na parte inferior do painel: 

 
O novo item é adicionado à lista com o nome Untitled. Devemos alterar o nome dando 
clicando duas vezes sobre o nome pausadamente. 

 
Uma vez selecionado o conteúdo e criado um item de biblioteca, o conteúdo é realçado 
na cor definida em suas preferências (a cor padrão é o amarelo) para indicar que é um 
item de biblioteca e não pode ser atualizado: 
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Importante: Se houver um estilo aplicado ao conteúdo que está sendo transformado em 
item de biblioteca, será exibida uma caixa de alerta informando que a seleção pode ser 
diferente em outros documentos porque as especificações de estilo não estão incluídas 
nos itens de biblioteca. 

Para assegurar que as informações da folha de estilo estejam incluídas, use as folhas de 
estilo externas e lembre-se de vinculá-las a todos os documentos que precisam desses 
estilos. 

Os itens de biblioteca (extensão .lbi) são salvos na pasta /Library e armazenados na sua 
pasta de site. Se a pasta /Library ainda não existir, o Dreamweaver a adicionará ao nível 
raiz de sua pasta de site local: 

 
Para visualizar itens de biblioteca existentes no site, clicamos na categoria Library no 
painel Assets e, em seguida, selecionamos o item na lista. A visualização do item 
selecionado é exibida na parte superior do painel Assets: 
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11.2 Colocando Itens de Biblioteca em uma Página 
Para colocar o item de biblioteca na página, posicionar o cursor no local desejado, 
selecione o item de biblioteca e clicar em Insert na parte inferior esquerda do painel 
Assets. 

 
O conteúdo da biblioteca é exibido na página e realçado em amarelo. Não é possível 
editar diretamente nada que seja parte de um item na página do documento: 

 

11.3 Modificando Itens da Biblioteca 
Para modificar um item de biblioteca, devemos selecione-lo na lista de itens de 

biblioteca na categoria Library do painel Assets e, em seguida, clicar em Edit . O 
item de biblioteca é aberto em uma janela de documento, onde podemos fazer as 
alterações.  

Quando um item de biblioteca é editado e salvo, o Dreamweaver verifica todos os 
documentos que usam esse item e solicita que atualizemos os arquivos. Todos os 
arquivos que contêm o item de biblioteca e não estão abertos no momento são 
atualizados, salvos e fechados. Todos os arquivos abertos são atualizados, mas não 
salvos. 
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Ao clicarmos em Update, a caixa de diálogo Update Pages é aberta para escolhermos as 
opções de atualização: 

 

11.4 Desanexando e Excluindo Itens da Biblioteca 
Se desejarmos impedir que uma determinada instância de um item de biblioteca sofra 
mais atualizações, selecionar o item na página e clicar em Detach From Original no 
painel Properties: 

 
Também é possível clicar com o botão direito do mouse em qualquer lugar no item da 
página e, em seguida, escolher Detach from Original no menu de contexto: 
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É exibido um aviso informando que o conteúdo desanexado não está mais vinculado ao 
documento original. 

Se um item de biblioteca não for mais necessário, para excluí-lo da biblioteca, selecione-
o no painel Assets e clique em Delete .  
Uma vez excluído um item de biblioteca, não será possível utilizar o comando Undo 
para recuperá-lo. 

Se um item de biblioteca for excluído do painel Assets, ele poderá ser recriado a partir 
de documentos que o estejam usando, basta selecionar o item de biblioteca no 
documento e clicar no botão Recreate no painel Properties: 

 
 
LABORATÓRIO 
TAREFA 1 
1. Abrir o arquivo quem_somos.html. 

2. Selecionar o endereço no final da página. 

3. Criar uma biblioteca com o nome de endereco. (No painel Assets, clique na 
categoria Library  e, em seguida, no item New Library na parte inferior do 
painel) 

4. Editar a biblioteca anteriormente criada, alterando o ano para 2009. 
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11.5 Criando Modelos de Site 
Quando se tem um site grande ou várias páginas que compartilham o mesmo design, 
podemos criar um modelo (Template). Um modelo é uma página inicial que contém 
elementos de design para cada página no site. 

Podem ser criados modelos para serem usados na criação de cada página do site. Para 
que sejam úteis, os modelos podem conter: 

- Design geral da página: com cores, layout e uma folha de estilo anexada; 

- Itens de navegação comuns a todas as páginas; 

Regiões de página comuns, como um rodapé. 

Com um modelo, é possível atualizar a aparência do site, alterando várias páginas em 
poucos minutos. 

Os arquivos de modelo (extensão .dwt) são salvos na pasta Templates e armazenados na 
pasta de site local. Se a pasta Templates ainda não existir, o Dreamweaver a adicionará 
ao nível raiz de sua pasta de site local. A pasta Templates deve estar sempre no nível 
raiz. 

Os modelos podem usar qualquer combinação das seguintes regiões: 

- Regiões editáveis, onde os desenvolvedores e os provedores de conteúdo podem 
colocar o conteúdo do site; 

- Regiões opcionais, que podem ser exibidas ou não com base em alguma condição; 

- Regiões repetitivas, que podem exibir vários elementos, como em um conjunto de 
novos itens. 

O resto do conteúdo em uma página que não seja uma dessas regiões é considerado 
bloqueado. Por exemplo, se houver uma seção de navegação em uma página com 
gráficos para links, esses poderão ser definidos no modelo. Esses links serão então 
bloqueados na página. Se os links forem alterados, altere simplesmente o modelo e todas 
as páginas projetadas com ele serão atualizadas. 

No Dreamweaver, para criar um template, precisamos primeiramente de uma página (em 
branco ou já com conteúdo). 

Selecionar File > Save as Template e colocar o nome desejado para o modelo: 
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LABORATÓRIO 
TAREFA 1 

1. Abrir um arquivo HTML novo. 

2. Definir o título como AlfaSports 

3. Salvar este arquivo como um template. (File > Save as Template). 

4. Definir o nome de principal, no site AlfaSports. 

11.6 Definindo Regiões Editáveis 
Por definição, todas as áreas de um modelo são bloqueadas, a não ser que criemos 
regiões editáveis. Em uma página criada a partir de um modelo, podemos alterar 
somente as regiões editáveis. 

Para criar uma região editável, selecionar o texto ou objetos desejados, escolher Insert > 
Template Objects > Editable Region e digitar o nome para a região na caixa de 
diálogo New Editable Region. Não devemos usar caracteres especiais no nome da 
região: 
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A região editável é delimitada por um contorno retangular no modelo com uma guia 
exibindo o nome da região. Se os nomes de região não estiverem visíveis, escolher View 
> Visual Aids > Invisible Elements: 

 
Uma região editável pode ser removida de um modelo, tornando assim a região 
bloqueada para todas as páginas baseadas no modelo.  

Para remover uma região editável basta selecionar a região e escolher Modify > 
Templates > Remove Template Markup. 

Se uma região editável for removida de um modelo que já foi usado na criação de 
páginas, a região será revertida ao conteúdo original do modelo ou escolher a opção  de 
armazenar o conteúdo deslocado em outra região. 

11.7 Usando Modelos 
Depois de criarmos o modelo, podemos começar a criar páginas baseadas nele. Só 
alterar as partes da página definidas como editáveis. 

Para criar um novo documento a partir de um modelo: 

Escolher File > New e clicar na guia Templates na caixa de diálogo New Document 
selecionar o modelo que deseja usar na lista e clicar em Create: 
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O uso deste método permite que usemos um modelo de qualquer site definido no 
Dreamweaver. 

Selecionar o modelo na categoria Templates  no painel Assets e, em seguida, clicar 
com o botão direito do mouse e escolher New from Template no menu de contexto ou 
no menu Options do painel Assets: 

 
Também é possível aplicar um modelo a um novo documento em branco arrastando o 
modelo do painel Assets para o documento. 
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11.8 Aplicando um Modelo a uma Página Existente 
Uma vez criado o modelo, este poderá ser aplicado a outras páginas para atualizar e 
alterar seus designs rapidamente. Ao aplicar um modelo, o Dreamweaver tenta fazer a 
correspondência entre o conteúdo existente e as regiões no modelo. 

Para aplicar um modelo a uma página abra a página desejada, devemos selecionar o 
modelo no painel Assets e clicar no botão Apply na parte inferior do painel. Também é 
possível arrastar o modelo para a página, ou clicar com o botão direito do mouse no 
modelo e escolher Apply no menu de contexto: 

 

Se o Dreamweaver não conseguir fazer a correspondência de conteúdo, será exibida uma 
caixa de diálogo onde optaremos por fazer a correspondência entre o conteúdo e a região 
apropriada. 

Devemos definir para qual região queremos mover o Document body (corpo da página) 
e o Document head (cabeçalho da página). 
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Devemos ajustar as regras de estilos criando outras, se necessário, para adaptar e alinhar 
o conteúdo das páginas 

11.9 Modificando o Modelo 
Usando um modelo, a economia real de tempo acontece quando é necessário fazer 
alterações em todas as páginas criadas com base no modelo. Sem o modelo, seria 
necessário editar cada página. Com um modelo, é necessário editar apenas o modelo e 
todas as páginas criadas com base nele são atualizadas. 

Para isso, basta abrir o modelo na pasta Templates, fazer todas as alterações necessárias 
e salvar o modelo. 

Quando um modelo é alterado e salvo, a caixa de diálogo Update Template Files exibe 
uma lista de todos os arquivos criados a partir desse modelo: 
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Ao clicarmos em Update, os arquivos são atualizados com as suas alterações. Após as 
atualizações, as alterações feitas são listadas na caixa de diálogo Update Pages.  

Importante: Para salvar alterações em um modelo, use o comando Save. Se usarmos o 
comando Save as Template, o modelo será recriado e o novo modelo não será anexado 
às páginas existentes. 
 
LABORATÓRIO 
TAREFA 1 

1. Abrir o template principal.dwt. 

2. Anexar a folha de estilo site.css clicando no botão Attach Style Sheet, localizado no 
final do painel CSS Style. 

 
3. Na caixa de diálogo Attach External Style Sheet, clicar em Browse e selecionar a 

folha de estilos “site.css”. Na opção Media selecionar screen. 

4. Anexar a folha de estilo site_print.css com opção de Media print. 
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Unidade 12 
Projetando Layouts com CSS 

 
Até agora tivemos controle limitado sobre a criação de páginas. Existem alguns aspectos 
que devemos levar em consideração ao criar suas páginas: 

- Visitantes do site não costumam ler – eles percorrem o texto em busca de links e 
informações relevantes para encontrar rapidamente o que precisam; 

- Os leitores procuram da esquerda para a direita; portanto, conteúdos importantes 
devem ficar no lado esquerdo da página; 

- Para que eles leiam o que desejamos, a largura dos textos não deve ser superior a 400 
pixels; 

- A navegação pelo site deve ser consistente. A barra de navegação principal deve 
permanecer no mesmo lugar em todas as páginas; 

- Hoje, muitos sites são projetados para uma resolução de tela de 1024 x 768 pixels. 
Normalmente, limite o conteúdo a 990 x 650 pixels para permitir outros elementos de 
tela, como a barra de tarefas. 

É possível controlar o layout das páginas de várias maneiras: usando camadas, CSS ou 
tabelas. Agora, o uso de CSS é considerado a melhor forma de controle da página e esse 
é o principal destaque desta lição. 

O Dreamweaver permite inserir tags especiais (tags DIV) manualmente e adicionar 
regras de posicionamento CSS em tags DIV ou projetar visualmente a página com 
camadas. 

A tag DIV é apenas uma tag HTML que define uma seção ou divisão do conteúdo em 
uma página. É possível adicionar atributos de posicionamento a tag DIV com CSS, para 
permitir a criação de colunas ou blocos de texto, colocados e dimensionados de acordo 
com suas especificações. 

12.1 Usando Camadas para Layout 
No Dreamweaver, as camadas são elementos HTML aos quais é atribuído 
posicionamento absoluto. Como alternativa, quando desenhamos manualmente uma 
camada na página, o Dreamweaver atribui uma tag DIV à camada com o 
posicionamento CSS já aplicado. A criação de páginas se torna tão fácil quanto em um 
programa de layout de páginas. 

Após desenharmos camadas na página, podemos adicionar conteúdo (texto, imagens 
etc.) à camada, da mesma maneira como adicionamos conteúdo às páginas. Tudo que 
pode ser incluído em um documento HTML também pode ser colocado em uma camada. 
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1- Criar um novo arquivo. 

2- Selecionar a categoria Layout no Painel Insert. 

 

3- Clicar no ícone Draw AP Div  e desenhe uma camada, da mesma maneira como 
criamos um retângulo em um programa gráfico: 

 
Depois de criarmos uma camada, para adicionar conteúdo a ela, basta colocar o ponto de 
inserção na camada correspondente e adicionar o conteúdo como faríamos em uma 
página. 

4- Criar mais duas camadas abaixo desta, como na imagem abaixo: 

 
É necessário selecionar a camada antes de modificá-la. Existem vários métodos para 
seleção de uma camada: 
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- Após clicar dentro da camada, clique na alça que aparece no canto superior esquerdo; 

 
- Clique em qualquer ponto na borda da camada; 

 
- Selecione a respectiva camada no painel CSS na aba AP Elements: 

 
Após a seleção de uma camada, as alças de redimensionamento são apresentadas. 

O painel AP Elements permite gerenciar as camadas do documento. Podemos usá-lo 
para selecionar a camada, nomear a camada, alterar a visibilidade da camada, alterar a 
ordem de empilhamento ou selecionar várias camadas na página. 

As camadas são exibidas como uma lista de nomes; a primeira camada criada está na 
parte inferior da lista e a camada mais recente aparece no início da lista. 

12.1.1 Manipulando as Propriedades da Camada 

Após a criação e seleção de uma camada, é possível modificar várias propriedades da 
camada no Painel Property. Podemos: 

- Renomear uma camada digitando um novo nome na caixa de texto Layer ID do Painel 
Property. O Dreamweaver atribui um nome a cada camada (Layer1, Layer2 etc.), mas 
podemos atribuir um nome mais relevante e exclusivo. Não use espaços nem caracteres 
especiais: 
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- Posicionar a camada, arrastando-a na tela ou posicione-a de maneira precisa, 
especificando os valores L (esquerda) e T (superior). 

 
- Redimensionar a camada, arrastando as alças ou ajustando os valores W (largura) e H 
(altura). 

 
- Adicionar à camada uma cor de fundo, selecionando a cor na caixa Bg Color. 

 

12.2 Camadas Aninhadas 
A camada aninhada é aquela que está contida em uma outra camada. Em geral, 
aninhamos camadas quando desejamos agrupá-las. A camada aninhada é movida com 
sua camada-mãe. Para desenhar uma camada dentro de outra e aninhá-las, é necessário 
verificar se a opção Prevent Overlaps não está selecionada no painel AP Elements: 

 
Quando essa opção está marcada, não é possível sobrepor nem aninhar camadas em uma 
camada existente. 

Para criamos camadas aninhadas, antes precisamos definir algumas preferências. 

5- Selecionar o menu: Edit > Preferences e na opção AP Elements deixar marcada as 
opções como na imagem: 
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As opções para camadas são: 

- Visibility: determina a configuração padrão da visibilidade de uma camada. 

- Width and Height: define a largura e a altura padrão de camadas criadas com o menu 
Insert (Inserir). 

- Background-color: especifica a cor de fundo padrão. 

- Background-image: especifica a imagem de fundo padrão. 

- Nesting: quando selecionada, especifica se a camada desenhada em outra camada deve 
ser aninhada nessa camada. 

6- Clicar em OK para aplicar as preferências. 

7- Selecionar a Div3 e desenhar uma Draw AP Div dentro dela.  

Observar no painel Ap Elements que nossa camada apDiv4 esta aninhada dentro da 
apDiv3: 

 

12.3 Usando Réguas e Guias 
Ao criarmos nossas páginas, podemos usar alguns dos recursos de medição do 
Dreamweaver para ajudá-lo a posicionar itens na página e planejar o layout. As réguas 
aparecem nas bordas superior e esquerda da página e são marcadas em pixels, polegadas 
ou centímetros. 

8- Para exibir ou ocultar as réguas, selecionar View > Rulers > Show. 
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Para alterar a origem (ponto 0), arraste a origem da régua no canto superior esquerdo das 
réguas (na interseção das réguas superior e esquerda) para qualquer lugar na página.  

 
Para redefinir as réguas na posição superior esquerda, clique duas vezes no ponto de 
interseção ou selecione View > Rulers > Reset Origin. 

Para alterar a unidade de medida, selecione Pixels, Inches ou Centimeters no submenu 
View> Rulers. 

Com as réguas habilitadas podemos guias que são linhas que arrastamos para ajudar a 
colocar ou alinhar itens na página. As réguas devem estar visíveis para ser possível a 
colocação de uma guia na página.  

Para criar uma guia horizontal ou vertical, arraste a régua na parte superior ou esquerda, 
respectivamente, e libere o botão do mouse ao chegar à posição em que deseja manter a 
guia. 

 
Para alterar a posição de uma guia, execute um destes procedimentos: 

- Arraste a guia para a nova posição. 

- Clique duas vezes na guia e insira a nova posição na caixa de diálogo Move Guide. 
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Para remover uma guia da página, arraste a guia de volta para as réguas. 

Para limpar todas as guias na página, selecione View > Guides > Clear Guides. 

12.4 Adicionando CSS a Camadas 
Com o uso de camadas, torna-se fácil criar páginas. À medida que cada camada é 
desenhada, o Dreamweaver cria regras CSS internas, atribuindo à regra de estilo o 
mesmo nome da camada. Esse é outro motivo para a escolha de nomes lógicos para as 
camadas. 

Também é possível modificar ou adicionar atributos de posicionamento a cada regra de 
estilo para obter controle ainda maior sobre a aparência da página. 

9- No ícone Visual Aids deixe selecionada a opção CSS Layout Backgrounds: 

 
10- Selecionar, no painel CSS Styles, a regra apDiv1 e dê um duplo clique para 
entrarmos na janela CSS Rule Definition.  

11- No item Box definir o Padding e a Margin como na imagem abaixo: 
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Ao clicarmos em OK veremos um deslocamento na nossa Div. 

O preenchimento (Padding) é à distância do conteúdo a partir da borda. É possível 
adicionar preenchimento a todos os lados da caixa (opção same for all marcada) ou a 
cada lado individualmente.  

As margens (Margin) são definidas da mesma maneira que o preenchimento. A 
diferença entre as margens e o preenchimento é que as margens ficam fora da borda do 
objeto, enquanto o preenchimento fica dentro da borda. 

12- Para corrigirmos este deslocamento, redefinir o item Box como na imagem: 
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13- Configurar as outras regras de estilos, marcando a opção Padding ou Margin. 

12.5 Projetando com DIVs 

Anteriormente, criamos um projeto de página usando a opção de Draw AP Div  para 
desenhar as caixas do conteúdo. É um recurso útil do Dreamweaver para a realização de 
experiências com o projeto da página. O Dreamweaver insere automaticamente uma tag 
DIV para cada camada desenhada.  

12.5.1 Posicionamento Absoluto e Relativo 

Dois tipos de posicionamento, amplamente utilizados, podem ser especificados com o 
modelo de caixa: absoluto e relativo.  

O posicionamento absoluto é atribuído pela regra de estilo quando a camada é desenhada 
e colocada em um local exato na página usando as propriedades referentes às partes 
superior, esquerda, inferior e direita. 

O posicionamento relativo coloca o modelo de caixa usando os valores referentes à sua 
própria posição no fluxo de texto do documento. 

Quando uma camada é colocada na página e sua posição é alterada de absoluta para 
relativa, o Dreamweaver a remove do painel AP Elements.  
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Não é mais possível movê-la livremente na página arrastando a alça. De fato, as alças 
não aparecem mais na caixa. Não se confunda pelo fato de o Painel Property ainda 
identificar o objeto como uma camada. O objeto ainda é uma tag DIV. 

Para inserir uma camada com posição relativa no Dreamweaver devemos ir até o Painel 
Insert,  Layout, Insert Div Tag . 

 
- Insert: define onde será inserida a Div Tag: 

At insertion point: insere neste ponto; 

After tag: insere depois de outra div tag; 

Before tag: insere antes de outra div tag; 

Wrap Around Selection: insere ao redor da seleção; 

- Class: define a classe CSS aplicada para esta div tag; 

- ID: define o ID CSS aplicado para esta div tag; 

Se não possuímos classe ou ID para aplicar nesta div tag, podemos criá-las clicando no 
botão New CSS Rule. 
Normalmente os itens que precisamos definir para uma div é o width, height, padding, 
margin, background e formatação da fonte. 

Em geral, quando projetamos uma página da web, a largura do conteúdo que aparece na 
página merece mais atenção do que a altura. 

 
LABORATÓRIO 
TAREFA 1 

1- Abrir o arquivo de template principal.dwt 
2- Clicar no ícone Insert Div Tag, localizada no Painel Insert, item Layout. 
3- Clicar na opção Insert Div Tag, deixar a opção At insertion point marcada e clicar 

no botão New CSS Rule: 
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4- Selecionar ID no Selector Type. Digitar o nome “geral” no item Selector e certifique-
se que está na folha se estilo site.css. Clicar em OK: 

5- Na janela CSS Rule Definition, escolher a opção Box e colocar 770 pixels de largura 
para esta Div. 

6- Apagar o conteúdo da Div geral, clicar no ícone Insert Div Tag, localizada no Painel 
Insert, item Layout. 

7- Clicar na opção Insert Div Tag, deixar a opção At insertion point marcada e clicar 
no botão New CSS Rule: 

8- Selecionar ID no Selector Type. Digitar o nome “topo” no item Selector e certifique-
se que está na folha se estilo site.css. Clicar em OK: 

9- Na janela CSS Rule Definition, escolher a opção Box e definir conforme a imagem 
abaixo: 

 
 
TAREFA 2 

1. Posicionar o cursor logo após o final da Div “topo”. Se necessário, habilitar o modo de 
visualização Split.  

2. Clicar no ícone Insert Div Tag. Na janela Insert Div Tag, escolher a opção After tag 
(depois) especificando no menu pop-up <div id=”topo”> e clicar no botão New Css 
Rule: 
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3. Selecionar ID no Selector Type. Digitar o nome “menu_superior” no item Selector e 

certifique-se que está na folha se estilo site.css. Clicar em OK: 

4. Na janela CSS Rule Definition, na categoria Background selecionar a imagem 
fundo_menu.jpg no item Background-image. Marcar no item Repeat a opção: repeat-x; 

5. Ainda na div “menu_superior”, na categoria Box definir conforme a figura abaixo: 

 
TAREFA 3 

1. Deixar o cursor piscando no final da div “menu_superior” e clicar em Insert Div Tag. 

2. Selecionar a opção After Tag e no menu pop-up escolha: <div id=”menu_superior”> e 
clicar no botão New CSS Rule: 
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3. Na janela New CSS Rule escolher a opção ID e colocar o nome de “meio” como na 

imagem: 

 
4. Na janela CSS Rule Definition, na categoria Background, escolher a imagem 
gradiente_topo.jpg no item Background-image. Marcar no item background-repeat a 
opção: repeat-x.  

5. Na categoria Box, definir como na figura abaixo. 
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TAREFA 4 
1. Deixar o cursor do mouse no final da div “meio” e clicar na opção Insert div Tag. 

2. Escolher a opção After Tag com a <div id=”meio”> selecionada. 

3. Colocar o nome do ID desta Div de “rodape”. 

4. Na janela CSS Rule Definition, na categoria Background, definir na background-
image a imagem gradiente_rodape.jpg. Na background-repeat, selecionar a opção 
repeat-x. 

5. Na categoria Box definir a de altura de 140 px e padding-top de 10 px. 

 

12.5.2 Float 

A propriedade Float determina onde um elemento será exibido em relação a outro, sem 
que uma posição fixa seja definida, ou seja, como se este elemento estivesse flutuando 
na página. Define a disposição dos elementos, podendo criar colunas, fazer um texto 
contornar uma imagem, etc., de forma flexível.  

A propriedade Float permite três valores: Left, Right ou None: 

• Left exibe o objeto na margem esquerda do objeto selecionado;  
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• Right exibe o objeto na margem direita ; 

• None define o valor flutuante igual ao padrão do navegador; 

 
LABORATÓRIO 
TAREFA 1 
1.  Excluir o conteúdo da div “topo” e clicar na opção Insert div Tag. 
2. Escolher a opção At insertion point.  

 
3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “data”. 

 
4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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5. Na categoria Block, na opção Text-align definir como right. 

6. Digite a data corrente no seguinte formato: dia_da_semana, dia de mês de ano. 
Ex.: segunda-feira, 02 de março de 2009.  

7. Salvar todos os arquivos 

 

TAREFA 2 
1. Deixar o cursor dentro da Div “data” e clicar em Insert Div Tag. 

2. Escolher a opção After Tag com a <div id=”data”> selecionada.  

3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “carrinho”. 

4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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5. Excluir o conteúdo da div e selecionar a opção Image na categoria Cammon. 
Selecionar a imagem ico_carrinho.jpg, com texto alternativo de Meu carrinho. 

6. Inserir uma div após a Div “carrinho”, com o nome do ID de “contato” e as mesmas 
formatações do ID carrinho. 

7. Excluir o conteúdo da div e selecionar a opção Image na categoria Cammon. 
Selecionar a imagem ico_carta.jpg, com texto alternativo de Contato. 

8. Salvar todos os arquivos 

 

Tarefa 3 
1. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“borda_topo” na folha de estilo site.css. 

2. Na janela CSS Rule Definition, na categoria Border, definir conforme a figura abaixo: 
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3. Aplicar esta Class nas Divs data, carrinho e contato através da opção Class do Painel 
Properties. 

 
4. Salvar todos os arquivos 

 

Tarefa 4 
1. Selecionar a Div menu_superior e excluir o conteúdo. Deixar o cursor dentro da div e 
selecionar a opção Image na categoria Cammon. Selecionar a imagem lateral_menu.jpg 
e sem texto alternativo. 

2. Após, inserir a imagem logo_alfasports.jpg com texto alternativo de AlfaSports. 

3. Inserir as imagens quem_somos.jpg, como_comprar.jpg, duvidas.jpg e política.jpg 
logo em sequência. 

4. Salvar todos os arquivos. 

 
Tarefa 5 
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1. Selecionar a Div meio e excluir seu conteúdo. Deixar o cursor dentro da div e clicar 
em Insert Div Tag. 
2. Escolher a opção At insertion point.  
3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “esquerda”. 

4. Na janela CSS Rule Definition, na categoria Box, definir a opção Float como left, 
Padding-left igual a 10 px e Width igual a 173 px. Na categoria Background, opção 
Background-color definir #FFF (branco). 
5. Deixar o cursor dentro da Div “esquerda” e clicar em Insert Div Tag. 

6. Escolher a opção After Tag com a <div id=”esquerda”> selecionada.  

7. Clicar no New CSS Rule e colocar o nome do ID desta Div de “conteudo”. 

8. Na janela CSS Rule Definition, na categoria Box, definir a largura com 577 px e o 
Float como left. 

9. Na categoria bakcground, definir a background-color como #FFF; 

10. Salvar todos os arquivos. 

 
Tarefa 6 
1. Excluir o texto da Div “conteudo”. 

2. Inserir uma região editável com o nome de conteudo ( Insert > Templates Objects> 
Editable Region > conteudo) 

 
3. Salvar o modelo. 

 

Tarefa 7 
1. No arquivo quem_somos.html. 

2. Selecionar todo o conteúdo do arquivo (Dica: clicar no comando body do seletor de 
tags). 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

162                                    2009  Alfamídia LTDA. 
 

 
3. Clicar em Insert Div Tag. 

4. Deixar a opção “Wrap around selection” selecionada. 

 

5.  Clicar no New CSS Rule e colocar o nome do ID desta Div de “interna”. 

6. Na janela CSS Rule Definition, na categoria Box, definir padding 10 px para todos. 

7. Aplicar o template “principal” ( Modify > Templates > Apply templates to Page... 
> selecionar a opção de template “principal”). 

 
2.  Definir para o Document body a região editável conteudo e para o Document head 
a opção Head 
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9. Repetir os passos desta tarefa para os arquivos como_comprar.html e duvidas.html. 
Obs.: Não será necessário criar novamente o ID “interna”, basta apenas selecioná-la. 

 
10. Salvar todos os arquivos. 

11. Criar um novo arquivo seguindo o template com o nome de “politica.html” 

 

Tarefa 8 
1. No arquivo principal.dwt, selecionar a Div rodape e excluir seu conteúdo. Deixar o 
cursor dentro da div e clicar em Insert Div Tag. 
2. Escolher a opção At insertion point.  
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3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “pagamento”. 

4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 

 
5. Excluir o conteúdo da div criada e digitar: EM ATÉ 12X SEM JUROS. 

6. Inserir uma quebra de linha (SHIFT+ENTER). 

7. Inserir na linha criada, uma após a outra, as seguintes imagens: logo_mastercard.jpg 
(texto alternativos: MasterCard),  logo_visa.jpg (texto alternativos: Visa), logo_amex.jpg 
(texto alternativos: América Express), logo_diners.jpg (texto alternativos: Diners Club) 
e logo_hipercard.jpg (texto alternativos: Hipercard). 

8. Salvar todos os arquivos 

 
Tarefa 9 
1. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“texto_rodape” na folha de estilo site.css. 

2. Na janela CSS Rule Definition, na categoria Type, definir conforme a figura abaixo: 
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3. Selecionar o texto “EM ATÉ 12X SEM JUROS” e aplicar a Class texto_rodape 
através da opção Class do Painel Properties. 

 
4. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“img_rodape” na folha de estilo site.css. 

5. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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6. Aplicar a Class através da opção Class do Painel Properties em cada imagem da Div 
pagamento. 
7. Salvar todos os arquivos 

 

Tarefa 10 
1. Deixar o cursor dentro da div pagamento e clicar em Insert Div Tag. 
2. Escolher a opção After Tag com a <div id=”pagamento”> selecionada. 

3. Clique no New CSS Rule e colocar o nome do ID desta Div de “bancos”. 

4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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5. Excluir o conteúdo da div criada e digitar: TRABALHAMOS COM. 

6. Inserir uma quebra de linha (SHIFT+ENTER). 

7. Inserir na linha criada, uma após a outra, as seguintes imagens: logo_itau.jpg (texto 
alternativos: Itaú), logo_bb.jpg (texto alternativos: Banco do Brasil) e  
logo_bradesco.jpg (texto alternativos: Bradesco). 

8. Selecionar o texto “TRABALHAMOS COM” e aplicar a Class texto_rodape através 
da opção Class do Painel Properties. 

9. Aplicar a Class img_rodape através da opção Class do Painel Properties em cada 
imagem da Div bancos. 
10. Salvar todos os arquivos 

 

Tarefa 11 
1. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“borda_rodape” na folha de estilo site.css. 

2. Na janela CSS Rule Definition, na categoria Border, definir conforme a figura abaixo: 
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3. Aplicar a Class borda_rodape através da opção Class do Painel Properties para as 
Divs pagamento e bancos. 

4. Salvar todos os arquivos. 

 

Tarefa 12 
1. Deixar o cursor dentro da div bancos e clicar em Insert Div Tag. 
2. Escolher a opção After Tag com a <div id=”bancos”> selecionada. 

3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “atendimento”. 

4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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5. Excluir o conteúdo da div criada e digitar: CENTRAL DE ATENDIMENTO. 

6. Inserir uma quebra de linha (SHIFT+ENTER). 

7. Inserir na linha criada, a imagem ico_fone_rodape.jpg (texto alternativos: Telefone) e 
formatar com o align middle. 

8. Ao lado da imagem, digitar: 0800-000-000 . 

9. Inserir uma quebra de linha (SHIFT+ENTER). 

10. Inserir na linha criada, a imagem ico_carta_rodape.jpg (texto alternativos: Contato) 
e formatar com align middle. 

11. Selecionar o texto “CENTRAL DE ATENDIMENTO” e aplicar a Class 
texto_rodape através da opção Class do Painel Properties. 

12. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“ico_rodape” na folha de estilo site.css. 

13. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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14. Aplicar a Class ico_rodape através da opção Class do Painel Properties nas imagens 
da Div atendimento.  

15. Salvar todos os arquivos 

 

12.5.3 Clear 

Complementando a função da propriedade Float, a propriedade Clear define quais lados 
de um elemento ficará limpo, sem a presença de nenhum outro elemento. Por padrão, 
todo elemento flutuante inserido em uma página será posicionado imediatamente ao lado 
do elemento anterior. Isso significa que essa propriedade só terá efeito a partir do 
segundo elemento colocado na página. 

A propriedade Clear permite quatro valores: Left, Right, Both ou None. 

 
LABORATÓRIO 
TAREFA 1 
1. Deixar o cursor dentro da div atendimento e clicar em Insert Div Tag. 
2. Escolher a opção After Tag com a <div id=”atendimento”> selecionada. 

3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “copyright”. 
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4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 

 
5. Na janela CSS Rule Definition, na categoria Block, definir a propriedade Text-align 
como Center. 

6. Excluir o conteúdo da div criada e importar o texto copyright.doc (File > Import > 
Word Document... > Pasta Textos > Arquivo copyright.doc). Na opção Formatting, 
escolher a opção: Text only. 
7. Salvar todos os arquivos. 

 

TAREFA 2 
1. Selecionar a Div esquerda e excluir seu conteúdo. Deixar o cursor dentro da div e 
clique em Insert Div Tag. 
2. Escolher a opção At insertion point.  
3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “busca”. 

4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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5. Excluir o conteúdo e deixar o cursor dentro da mesma. Clicar em Insert Div Tag. 
6. Escolher a opção At insertion point.  
7. Clicar  no New CSS Rule e colocar o nome do ID desta Div de “item_busca”. 

8. Na janela CSS Rule Definition, na categoria Border, definir conforme a figura abaixo: 
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9. Excluir o conteúdo da Div criada e digite “Busca de Produtos”. 

10. Colocar o cursor antes da palavra “Busca” e inserir o caracter especial » (Insert > 
HTML > Special Characters > Other ), pressionar um espaço em branco. 

11. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“cod_padrao” na folha de estilo site.css. 

12. Na janela CSS Rule Definition, na categoria Type, definir a propriedade Color com a 
cor #FF5015 

13. Aplicar a Class cor_padrao através da opção Class do Painel Properties no caracter 
especial ». 
14. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“destaque” na folha de estilo site.css. 

15. Na janela CSS Rule Definition, na categoria Type, definir a propriedade Font-weight 
como bold. 

16. Na categoria Box, definir as propriedades padding-top e padding-bottom com 3px. 

17. Na categoria Border, definir a propriedade style-bottom com solid, width-bottom 
com 1 px e color-bottom com #E0E1DD. 

18. Aplicar a Class destaque através da opção Class do Painel Properties na Div 
“item_busca”. 
19. Salvar todos os arquivos 

 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

174                                    2009  Alfamídia LTDA. 
 

TAREFA 3 
1. Deixar o cursor dentro da div item_busca e clicar em Insert Div Tag. 
2. Escolher a opção After Tag com a <div id=”item_busca”> selecionada. 

3. Clique no New CSS Rule e colocar o nome do ID desta Div de “lupa”. 

4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 

 
5. Na categoria Border, definir conforme a figura abaixo: 
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6. Excluir o conteúdo da Div criada e inserir a imagem ico_lupa.gif (texto alternativo: 
lupa). 

7. Deixar o cursor dentro da div lupa e clicar em Insert Div Tag. 
8. Escolher a opção After Tag com a <div id=”lupa”> selecionada. 

9. Clicar no New CSS Rule e coloque o nome do ID desta Div de “form_busca”. 

10. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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11. Na categoria Border, definir conforme a figura abaixo: 

 
12. Deixar o cursor dentro da div busca e clicar em Insert Div Tag. 
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13. Escolher a opção After Tag com a <div id=”busca”> selecionada. 

14. Clicar no New CSS Rule e colocar o nome do ID desta Div de “menu_esq”. 

15. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 

 
16. Salvar todos os arquivos. 

 

TAREFA 4 
1. Criar um arquivo novo, usando o template “principal” e salvar como nome de 
index.html 

2. Excluir o conteúdo da região editável e clicar em Insert Div Tag. 
3. Escolher a opção At insertion point. 
4. Clicar no New CSS Rule e colocar o nome do ID desta Div de “banner”. 

5. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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6. Excluir o conteúdo da Div, clicar na categoria Common do Painel Insert, botão Media 
e selecionar SWF no menu pop-up: 

7- Na caixa de diálogo Select File, selecionar o arquivo flash banner.swf que está na 
pasta flash: 
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8- Clicar no botão Play para visualizar o arquivo reproduzido: 

 
9. Deixar o cursor dentro da Div banner e clicar em Insert Div Tag. 
10. Escolher a opção After tag, selecionar a opção <div id=”banner”> 

11. Clicar no New CSS Rule e colocar o nome do ID desta Div de “newsletter”. 

12. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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13. Na categoria Background, definir a opção background-image com o arquivo 
fundo_newsletter.jpg. 

14. Deixar o cursor dentro da Div “newsletter” e clicar em Insert Div Tag. 
15. Escolher a opção After tag, selecionar a opção <div id=”newsletter”> 

16. Clicar no New CSS Rule e colocar o nome do ID desta Div de “corpo”. 

17. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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18. Deixar o cursor dentro da Div “corpo” e clicar em Insert Div Tag. 
19. Escolher a opção After tag, selecionar a opção <div id=”corpo”> 

20. Clicar no New CSS Rule e colocar o nome do ID desta Div de “publicidade”. 

21. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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22. Excluir o conteúdo desta Div e clicar em Insert Div Tag. 
23. Escolher a opção At insertion point. 
24. Clicar no New CSS Rule e colocar o nome do ID desta Div de “texto_publicidade”. 

25. Na janela CSS Rule Definition, na categoria Box, definir o width com 145 px e a 
margin-bottom com 10 px. 

26. Excluir o conteúdo desta Div e digitar “Publicidade”. 

27. Inserir o caracter especial » antes da palavra publicidade e definir a classe 
“cor_padrao” para o mesmo. 

28. Definir a classe destaque para a Div texto_publicidade. 

29. Deixar o cursor após a Div texto_publicidade e inserir a imagem publicidade.gif 
(texto alternativo: Publicidade). 

30. Definir border 0 e um link  “alternativo” (digitar # no campo link) para a imagem 

31. Salvar todos os arquivos. 

Obs.: Visualizar o arquivo no navegador FireFox.  

32. Para solucionar o problema constatado no rodapé apenas para o FireFox, definir na 
Div rodape, categoria Box, o Clear com Left. 
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Unidade 13 – Navegando no site 
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Unidade 13 
Navegando no site 

13.1 Links de Hipertexto 
Após determinarmos os objetivos do nosso site, o público alvo e as necessidades de 
dados, estaremos preparados para começar a conceitualizar o esquema de navegação do 
site.  

A navegação do site é a representação de como nossas páginas da Web se relacionam 
entre si. Em termos específicos, ele revela como os usuários percorrem seu site ao 
clicarem nos links e interagirem com as interfaces dos aplicativos.  

A navegação é implementada por: 

- Uma barra de navegação, que pode ser composta por texto ou imagens que atuam 
como links; 

- Uma série de links de hipertexto incorporados às páginas da Web. 

O Hipertexto foi o principal conceito que levou à invenção da World Wide Web, que 
não é nada mais (ou menos) do que uma enorme quantidade de conteúdo conectado por 
um enorme número de links de hipertexto. 

Links de hipertexto: 
- São geralmente representados por um texto sublinhado em uma página da Web 
(embora os usuários possam desativar esse formato em seus navegadores); 

- Podem “saltar” o usuário para outro documento contido na página da Web atual ou 
para uma página em outro site; 

- São usados na navegação global do site, em que um conjunto de links é criado em uma 
barra de navegação consistente. 

13.1.1 Tipos de Link 

Os links que usamos em texto ou gráficos para navegar para outras páginas são 
conhecidos como links de hipertexto. É possível criar vários tipos de links, usando texto 
ou um gráfico: 

- Link para outras páginas existentes no mesmo site; 

- Link para outros sites; 

- Link para um local com nome, existente na mesma página; 

- Link para criar uma mensagem de e-mail. 
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13.2 Criando Links para Arquivos no Site 
Há várias maneiras de criar links para documentos existentes no mesmo site: 

- Apontar para um arquivo usando o ícone Point to File ; 

- Navegar até o arquivo usando o ícone da pasta  no Painel Property; 

- Digitar o caminho e o nome do arquivo na caixa de texto Link 

, no Painel Property. 

Quando criamos um link em uma página, o nome de caminho para esse link é 
incorporado ao código HTML. Se movermos um arquivo com links para outra pasta fora 
do Dreamweaver, o nome do caminho para o link pode ser diferente e o link não 
funcionará. 

- Use o painel de arquivos para mover quaisquer arquivos. Quando movemos cada 
arquivo, o Dreamweaver atualiza cada link e gráfico na página, de modo a manter o 
caminho correto; 

- Se movermos os arquivos pelo Windows Explorer será necessário atualizar essas 
páginas manualmente. 

Na opção target podemos selecionar um alvo para o link, ou seja, o local onde ele irá 
abrir: 

 _blank: fará com que o link abra em uma nova janela; 

None (em branco): fará com que o link abra na mesma janela; 

_Self: a página abrirá no mesmo frame; 

_Top: a página abrirá no mesmo frame. 

 
LABORATÓRIO 
TAREFA 1 
1. Selecionar a imagem Quem Somos do arquivo de template principal.dwt e clicar em 
cima do Point to File  e apontar para o arquivo quem_somos.html: 
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2. Definir para a propriedade Border o valor 0 (zero); 

3. Fazer o mesmo processo para as imagens Como Comprar (como_comprar.html), 
Dúvidas (duvidas.html) e Política (politica.html). 
4. Definir um link para a imagem do logo AlfaSports para a página index.html. 
5. Definir para a propriedade Border o valor 0 (zero). 

Obs.: Outra maneira de criar um link é usar o ícone de pasta .  

Basta selecionar a imagem ou o texto que deve se tornar um link e clicar no ícone de 
pasta. 

Na caixa de diálogo Select File, localizamos o arquivo para o link: 
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5- Salvar todos os arquivos. 

13.3 Adicionando Links de E-mail 
Adicionar um link de e-mail à sua página é uma maneira de fornecer aos usuários um 
método de entrar em contato com alguém para falar sobre as informações 
disponibilizadas em seu site.  

Um link de correio eletrônico abre uma nova janela de mensagem no programa de 
correio eletrônico associado ao navegador do usuário. 

No Dreamweaver podemos adicionar um link de e-mail ao texto existente na página ou 
usar a caixa de diálogo para adicionar o texto e o link. 

1. No Painel Insert, na categoria Common, clicar na opção Email Link ou item de menu 
Insert > Email Link. 
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2. Na caixa de diálogo Email Link, digitar o texto e o e-mail desejado e clique em OK. 

  
 
LABORATÓRIO 
TAREFA 1 
1. No arquivo de template, deixar o cursor após a imagem ico_carta_rodape.jpg 

2. Clicar na opção Email Link, da categoria Common do Painel Insert. 

3. Na caixa de diálogo Email Link, digitar como na imagem abaixo: 

 
5- Salvar o arquivo. 

 

13.4 Alterando Cores do Link 
Para alterarmos as cores dos links, basta adicionarmos uma regra de estilo chamada 
pseudo-classes, à folha de estilo externa ou interna da página.  

Os links possuem quatro pseudo-classes: 
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a:link define o estilo do link no estado inicial; 

a:visited define o estilo do link visitado; 

a:hover define o estilo do link quando se passa o mouse sobre ele; 

a:active define o estilo do link ativo ( o que foi “clicado”) 

Com CSS, é perfeitamente possível definir um estilo diferente para cada um dos quatro 
seletores, de forma semelhante como é definido para qualquer texto HTML. 

Ao alterar as cores do link, considere o seguinte: 

- Não escolha cores que possam confundir os usuários. Se trocarmos o link e as cores 
visitadas, os visitantes terão a impressão de já terem visto as páginas em seu site e talvez 
não cliquem em um link para explorar ainda mais; 

- As cores do link devem contrastar com a cor de fundo da página para preservar a 
legibilidade. 

1. No Dreamweaver, para mudar as cores do links e criar essas pseudo-classes, devemos 
criar uma New CSS Rule, no painel CSS STYLES. 

2. Na caixa New CSS Rule, selecionar a opção Compound no selector type. 

3. No campo Selector Name, selecionar qual das quatro opções deseja formatar. 
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4. Definir as cores e propriedades desejadas na caixa CSS Rule Definition. 

 
LABORATÓRIO 
TAREFA 1 
1. Com o arquivo do template aberto (principal.dwt), adicionar uma nova regra de estilo 
e selecionar a opção Compound na caixa de diálogo New CSS Rule. No menu pop-up 
Selector Name, escolher o estados de link: a:link: 

 
2. Na caixa CSS Rule Definition, definir as opções conforme a imagem abaixo: 
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3. Clicar em OK. 

 

13.5 Prioridades das declarações dos links 
A ordem de definição das regras para os estados dos links é muito importante. Lembre-
se de que pelo efeito cascata as regras mais próximas do elemento prevalecem sobre as 
mais distantes. 

A ordem das declarações deve seguir a sequência demonstrada a seguir. 

1 a:link 

2 a:visited 

3 a:hover 

4 a:active 

 
LABORATÓRIO 
TAREFA 1 
1. No arquivo principal.dwt, duplicar a regra de estilo a:link ( botão da direita sobre a 
regra a:link, opção duplicate); 
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2. No menu pop-up Selector Name, escolher o estados de link: a:visited: 

 
3. Criar  uma nova regra do tipo Compouns com a opção: a:hover 
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5- Na Caixa de diálogo CSS Rule Definition marcar as opções como na imagem. 

 
6- Salvar todos os arquivos e testar o arquivo no navegador. 

13.6 Adicionando Links para páginas externas numa nova 
janela 

O Dreamweaver possibilita criar um link para uma página da Web e exibir esta numa 
nova janela. Para isso devemos: 

1. Selecionar o texto ou imagem que desejamos inserir o link. 

2. Digitar o endereço completo (http://www...) na propriedade link do Painel Properties. 

3. No item Target, selecionar a opção _blank. 

 
 

 
LABORATÓRIO 
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TAREFA 1 
1. Selecionar a imagem logo_itau.jpg (logo do Itaú) da Div Bancos. 
2. Definir a propriedade Border com o valor 0 (zero); 

3. Inserir um link para o endereço http://www.itau.com.br com target _blank. 

4. Repetir o processo 2 e 3 para as imagens logo_bb.jpg (http://www.bb.com.br) e 
logo_bradesco.jpg (http://www.bradesco.com.br) 

13.7 Criando vários Links de uma Imagem 
Se tivermos uma imagem com diversas áreas para conduzir o usuário para diferentes 
destinos, criaremos um mapa de imagens. 

Por exemplo, vamos supor que temos um mapa mundi e desejamos criar um link para 
cada país. Usaremos um mapa de imagens para distinguir os diferentes formatos de cada 
país e depois atribuir um link diferente a cada formato. 

As áreas de link em um mapa de imagens são conhecidas como pontos ativos. Uma área 
de ponto ativo em um mapa de imagens pode ter uma dentre três formas: um retângulo, 
um círculo ou um polígono. 

1- Criar um novo arquivo e salvar como nome de imagem_mapeada 

2- Inserir a imagem frutas.jpg que está na pasta imagens, colocando o texto alternativo 
para a imagem de “frutas” 

Para criarmos nosso mapa de imagens, usaremos as ferramentas de mapas localizadas no 
Painel Properties: 

 
3- Com a imagem selecionada, clicar no ícone Oval Hotspot e fazer um círculo ao redor 
da laranja:  
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Quando finalizamos o ponto ativo, o painel Properties muda exibindo as opções desse 
ponto ativo. Inserimos um link do ponto ativo e o texto Alternativo, exibido quando o 
usuário movimenta o ponteiro sobre essa área: 

 

As ferramentas de ponto ativo Rectangle e Oval trabalham de modo semelhante às 
ferramentas existentes em aplicativos de desenho; arrastamos a ferramenta sobre a área 
para desenhar a forma do ponto ativo. 

Para mover ou alterar o tamanho do ponto ativo, selecione a ferramenta do ponto ativo 
Pointer para fazer a mudança: 

4- Selecionar a ferramenta Polygon Hotspot e clicar ao redor da imagem da pêra: 
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Cada clique cria um ponto ativo na imagem. Cada ponto é conectado ao ponto anterior 
por uma linha. 

Ao final teremos um ponto ativo em no formato semelhante ao da imagem abaixo: 

 
Nas demais frutas, podemos utilizar o retângulo ou novamente uma das duas opções já 
utilizadas. 

13.8 Projetando Links de Navegação com CSS 
É possível definir diferentes estilos para os quatro seletores de links a serem utilizados 
em uma mesma página. Conseguimos isso, utilizando os IDs da divs, juntamente com  
os seletores. 

1. No Dreamweaver, devemos criar uma New CSS Rule, selecionar a opção Compound 
no campo Selector Name. 
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2. Digitar o nome da(s) Div(s) precedida por # e após o seletor desejado. 

 
Todas os formatos definidos no CSS Rule Definition será aplicado apenas no seletor 
<li> que estiver dentro da Div com ID “conteudo”. 

 
LABORATÓRIO 
TAREFA 1 
1. Excluir o conteúdo da Div menu_esq e digitar “CATEGORIAS”. 

2. Ao invés de pressionarmos ENTER, pressionar SHIF + ENTER para inserir uma 
quebra de linha. 

3. Importar o arquivo menu_esq.doc da pasta Textos (File>Import>Word 
Document...>Pasta Textos>Arquivo menu_esq.doc). 

4. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“titulo” na folha de estilo site.css. 

5. Na janela CSS Rule Definition, na categoria Type, definir conforme a figura abaixo: 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

198                                    2009  Alfamídia LTDA. 
 

 
5. Na categoria Background, definir para a background-color a cor #666. 

6. Na categoria Block, definir a opção Display como “block”. 

7. Na categoria Box, definir conforme a figura abaixo: 
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8. Selecionar a palavra “CATEGORIAS” e aplicar a Class “titulo” através da opção 
Class do Painel Properties. 

9.  Selecionar a lista de produtos inserida anteriormente e definir uma lista com 
marcadores. 

10. Pressionar ENTER na frente de cada produto para criar os itens. 

11. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Compound. Definir o 
Selector Name conforme a figura abaixo, na folha de estilo site.css. 
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5. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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6. Na categoria List, definir a opção List-style-type como “none”. 

 

TAREFA 2 
1. Selecionar cada item da lista do menu e inserir um link “temporário”. (Digite # na 
opção link do Painel Properties). 

2. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Compound. Definir o 
Selector Name conforme a figura abaixo, na folha de estilo site.css. 

 
3. Na janela CSS Rule Definition, na categoria Type, definir conforme a figura abaixo: 
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4. Na categoria Background definir conforme a figura abaixo: 

 
5. Na categoria Block, definir a opção Display como “block”. 
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6. Na categoria Box, definir conforme a figura abaixo: 

 
7. Na categoria Border, definir conforme a figura abaixo: 
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8. Salvar todos os arquivos. 

9. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Compound. Definir o 
Selector Name conforme a figura abaixo, na folha de estilo site.css. 

 
10. Na janela CSS Rule Definition, na categoria Box, definir a propriedade background-
color como #F3F3F3. 

11. Duplicar a regra #menu_esq ul li a:hover. No campo Selector Name digitar 
#menu_esq ul li a:active. 

12. Salvar todos os arquivos. 
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Unidade 14 – Usando tabelas 
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Unidade 14 
Tabelas 

14.1 Criando Tabelas 
Para inserir uma tabela na página, devemos posicionar o cursor no ponto de inserção 
onde a tabela ficará e selecione Insert > Table. Também podemos clicar no botão Table 
da categoria Common da Barra Insert. 

 
Na caixa de diálogo Table, inserir o tamanho da tabela e outros atributos visuais. Essas 
configurações podem ser alteradas após a inserção da tabela na página: 

 
Após inserirmos a tabela na página, é necessário selecioná-la para fazer qualquer 
alteração. Existem várias formas de selecionar uma tabela: 
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- Clicar no canto superior esquerdo da tabela, em qualquer área na margem superior ou 
inferior da tabela ou na borda de uma linha ou coluna: 

 
- Clicar em uma célula da tabela e selecionar a tag <table>, no seletor de tags: 

 
- Clicar em uma célula da tabela e, no menu de cabeçalho da tabela, escolha Select 
Table: 

 
Também podemos selecionar somente algumas células da tabela. Há várias formas de 
selecionar células e linhas no Dreamweaver: 

- Arrastar o mouse ao longo de uma linha; 

 
- Arrastar o mouse para baixo em uma coluna: 
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- Clicar pressionando as teclas Shift ou Ctrl, para selecionar várias colunas e linhas: 

 
- Posicionar o mouse à esquerda de uma linha ou sobre uma coluna e selecione a linha 
ou coluna com a seta de seleção: 

 
Após a seleção, todas as alterações de propriedades são aplicadas a todas as células da 
seleção. 

14.2 Propriedades da Tabela 
Com a tabela selecionada suas propriedades são exibidas no painel Properties: 

 
- Rows: Número de linhas que você deseja na tabela. Sempre é possível adicionar ou 
excluir linhas posteriormente; 

- Columns: Número de colunas que você deseja na tabela. Sempre é possível adicionar 
ou excluir colunas posteriormente; 

- Width: Largura da tabela na página, especificada em pixels ou porcentagem; 

- Height: Altura da tabela na página, especificada em pixels ou porcentagem; 
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- Cell Padding: Margem ao redor do conteúdo de cada célula, em pixels; 

- Cell Spacing: Espaçamento em pixels entre as células; 

- Border: Largura da borda ao redor de cada célula da tabela, em pixels.; 

- Align: Alinhamento da tabela na página; 

- Bg Color: Cor de fundo da tabela; 

- Border color: Cor da borda; 

- Bg Image: Imagem que aparece no fundo da tabela. 

14.3 Propriedades da Célula 
Com uma ou mais células selecionadas suas propriedades são exibidas no painel 
Properties: 

 
- Alinhamento horizontal (Horz): Alinha o conteúdo da célula à esquerda (padrão), no 
centro ou à direita; 

- Alinhamento vertical (Vert): Alinha o conteúdo na parte inferior, no meio (padrão) 
ou na parte superior da célula; 

- Largura (W): Define a largura mínima da célula em pixels (a célula é expandida 
automaticamente, quando a largura do conteúdo ultrapassa a largura mínima); 

- Altura (H): Define a altura mínima da célula em pixels (a célula é expandida 
automaticamente, quando a altura do conteúdo ultrapassa a altura mínima); 

- Imagem de fundo (Bg) (campo de texto superior): Define a imagem de fundo de 
uma célula, linha ou tabela; 

- Cor de fundo (Bg)(amostra de cores e campo de texto inferiores): Define a cor de 
fundo de uma célula, linha ou tabela; 

- Cor da borda (Brdr): Define a cor da borda da tabela. Se a borda da tabela for 
definida como 0, a cor da borda das células não será afetada; 

- Merge Cells: Mescla células adjacentes em uma única célula; 

- Split Cell: Divide uma célula em várias, horizontal ou verticalmente (apenas células 
individuais); 

- No Wrap: Impede a quebra de linha do conteúdo de uma célula, linha ou tabela; 
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- Header: Transforma uma ou mais células em cabeçalho (th). Os cabeçalhos ficam em 
negrito e centralizados. 

14.4 Editando Linhas 
As operações para modificarmos colunas e linhas da tabela são: 

14.4.1 Adicionando Linhas e Colunas 

Após criarmos a tabela, podemos adicionar linhas ou colunas. É possível executar 
qualquer um destes procedimentos: 

- Clicando na última célula de uma linha e pressione a tecla Tab. Uma nova linha é 
adicionada no final da tabela; 

- Selecionando Insert > Table Objects > Insert Row Above. A nova linha é adicionada 
acima da linha selecionada; 

- Selecionando Insert > Table Objects > Insert Row Below. A nova linha é adicionada 
abaixo da linha selecionada; 

- Selecionando Insert > Table Objects > Insert Column to the Left. A nova coluna é 
adicionada à esquerda da coluna selecionada. 

- Selecionando Insert > Table Objects > Insert Column to the Right. A nova coluna é 
adicionada à direita da coluna selecionada; 

- Clicando com o botão direito do mouse e selecionando uma opção no submenu Table: 

 
- Selecionando Modify  > Table e escolha uma opção no submenu Table. 
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14.4.2 Excluindo uma Linha 

Para remover uma linha da tabela, posicionamos o ponto de inserção na linha e 
executamos uma das opções: 

- Selecionar Modify > Table > Delete Row; 

- Clicando na tabela com o botão direito do mouse e selecionando Table > Delete Row 
no menu. 

14.4.3 Mesclando Linhas e Colunas 

Após selecionarmos as células a serem mescladas, executamos um destes comandos: 

- Clicamos em Merge Cells no painel Properties: 

 
- Selecionamos Modify > Table > Merge Cells; 

- Clicamos com o botão direito do mouse e selecionamos Table > Merge Cells no 
menu. 

14.4.4 Dividindo Linhas e Colunas 

Após selecionarmos a célula a ser dividida (CTRL + um clique com o botão esquerdo do 
mouse seleciona a célula), executamos um destes comandos: 

- Clicamos em Split Cell, no painel Properties: 

 
-Selecionamos Modify > Table > Split Cell; 
- Clicamos com o botão direito do mouse e selecionamos Table > Split Cells no menu. 

O número original de células é restabelecido, caso algumas células tenham sido 
mescladas anteriormente, ou uma célula pode ser dividida em qualquer número de linhas 
ou colunas: 
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14.5 Ordenando Tabelas 
É possível ordenar uma tabela simples pelo conteúdo de uma única coluna ou, em uma 
ordenação mais complexa, pelo conteúdo de duas colunas. 

Importante: Não é possível ordenar tabelas que contenham células mescladas. 
1. Criar um arquivo Novo; 

2. Clicar no menu: File > Import > Excel Document e selecionar o arquivo tabela.xls que 
esta na pasta tabelas. 

3. Para ordenar a tabela, clique na tabela ou selecione-a escolhendo Commands > Sort 
> Table.  

 
Na caixa de diálogo Sort Table, escolha a coluna a ser ordenada e o método de 
ordenação. A configuração padrão não ordena a primeira linha da tabela. 

Observe que nossa tabela já esta ordenada: 
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Unidade 15 – Usando formulários 
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Processando o formulário 

Validando um formulário 
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Unidade 15 
Usando Formulários 

Os formulários são parte essencial da maioria dos sites profissionais, pois são a única 
maneira, em HTML, para que um usuário envie dados para o site. Geralmente, os 
formulários são usados para: 

- Pedidos de produtos; 

- Registro de usuários; 

- Especificação de critérios de pesquisa de bancos de dados; 

- Gerenciamento de bancos de dados em sistemas intranet e extranet. 

Os formulários incluem diversos objetos que permitem que os usuários insiram dados ou 
selecionem opções, além de um botão para envio de dados para o servidor. 

15.1 Criando um Formulário 
Para adicionarmos um formulário, primeiro precisamos inserir uma tag de formulário na 
página. O formulário contém objetos em que os usuários inserem informações e 
especifica o que deve ser feito com os dados. Para inserir um formulário, devemos 
escolher Insert >  Form > Form ou clicar em Form na categoria Forms do Painel 
Insert. 

 
Linhas pontilhadas vermelhas definem visualmente a área do formulário na janela do 
documento. Devemos colocar todos os elementos do formulário dentro da área 
delimitada por pontilhados vermelhos. As linhas pontilhadas se expandem quando 
inserimos conteúdo na área de formulário. 

Para selecionarmos o formulário, podemos: 

- Clicar na linha pontilhada vermelha: 
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- Clicar em qualquer lugar dentro da área de formulário e clicar em <form #form1> no 
seletor de tags: 

 

O painel de Properties exibe as propriedades do formulário: 

 
- Form Name: usada para validação do formulário com JavaScript. O nome deve ser 
exclusivo na página; 

- Action: caminho para a página ou o script que processará o formulário; 

- Method: determina como os dados do formulário são transmitidos para o servidor; 

- Enctype: especifica o tipo de codificação MIME dos dados enviados; 

- Target: especifica a janela de exibição dos dados retornados pelo aplicativo que 
processa o formulário; 

- Class: regra de estilo de classe para aplicar ao formulário. 

15.2 Usando Objetos de Formulário 
Os objetos de formulários são usados para que o usuário possa inserir dados no 
formulário. Podemos permitir que os usuários insiram dados ou façam seleções das 
seguintes maneiras: 

- Campos de texto: para inserção de caracteres alfanuméricos; 

- Caixas de seleção: para seleção de várias opções; 

- Botões de opção: para seleção de uma ou várias opções; 

- Lista/menus: para seleção de várias opções em uma lista rolante ou uma única opção 
em um menu pop-up; 

- Botões: para executar uma ação 

Os objetos de formulário podem ser inseridos por meio de Insert > Form e, em seguida, 
selecionando-se um dos objetos no submenu ou selecionando a categoria Forms na 
barra de inserção e clicar em um dos botões da barra. 

4- Posicionar o cursor dentro do formulário e clicar na opção Text Field, para 
inserirmos um campo de texto: 
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5- Assim que inserimos um objeto de formulário, devemos inserir um nome de rótulo 
(label) para ele, selecionando um estilo e escolhendo se queremos que o rótulo fique 
antes ou depois do item de formulário. 

 
A opção Attach label tag using for attribute é a preferida para acessibilidade, mas 
pode ter desempenho diferente em cada navegador. Se o navegador der suporte a essa 
opção, veremos um retângulo de foco em torno do texto ou do objeto de formulário 
quando usar a tecla Tab para navegar pela página no navegador, facilitando a seleção do 
objeto. 

Também podemos inserir um equivalente de teclado (uma tecla) na caixa de texto 
Access key para selecionar o objeto de formulário no navegador. Por exemplo, se 
queremos inserir B como tecla de acesso, o usuário pressionará Control+B para ir para o 
objeto de formulário no navegador. 

O Tab index define a ordem de tabulação do objeto de formulário. Isso é útil se houver 
links ou objetos de formulário na página e queremos que o usuário navegue com tab por 
eles em uma ordem específica. Se definirmos o índice de tabulação de um objeto, 
certifique-se de definir também para os outros objetos. 
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Importante: Se clicarmos em Cancel na caixa de diálogo, o Dreamweaver inserirá o 
objeto de formulário, mas não adicionará qualquer atributo de acessibilidade a ele. 

Quando selecionamos um objeto de texto temos as seguintes propriedades para ele: 

 

- TextField: o nome do campo de texto; 

- Char Width: o número máximo de caracteres visíveis no campo; 

- Max Chars: (campo de texto e de senha) o número máximo de caracteres que o 
usuário pode digitar no campo; 

- Type: Single line (uma única linha), Multiline (várias linhas) e Password (senha); 

- Class: regra de estilo para formatar o campo de texto; 

- Init Val: texto padrão que aparece no campo quando a página é carregada. 

- Disabled: o campo fica desabilitado. 

- Read-only: o campo fica habilitado, porém não será possível editá-lo 

 

Para inserir uma caixa de seleção, que permite que os usuários escolham uma ou mais 
opções em um grupo de opções relacionadas, devemos clicar na opção Checkbox e 
digitar o texto correspondente a opção. Os usuários podem marcar ou desmarcar uma 
opção de caixa de seleção.  

As propriedades da caixa de seleção são: 

- Checkbox Name: um nome exclusivo para a caixa de seleção; 

- Checked Value: valor enviado se a caixa de seleção for selecionada; 

- Initial State: Checked (a caixa de seleção é marcada inicialmente) e Unchecked (a 
caixa de seleção não é marcada). 

Podemos inserir um campo list/menu com várias opções de escolha para o usuário. 

No final, devemos inserir os botões, que são usados para enviar formulários ou para 
redefinir todos os campos a seus valores iniciais. 

 
As outras propriedades para o Button são as seguintes: 
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- Action : Submit form (enviar formulário), Reset form (redefinir formulário) e None (os 
botões sem ação são usados para vincular a outros documentos ou para executar 
comandos JavaScript); 

- Class: regra de estilo de classe a ser aplicada para formatação. 

15.3 Processando o Formulário 
Um formulário HTML sempre acompanha uma ação, que é uma das propriedades do 
formulário. 

A ação especifica uma URL que processa o formulário. A URL pode apontar para: 

- Um endereço de e-mail. Neste caso, os dados do formulário são enviados em um e-
mail para um endereço especificado e o navegador recarrega a página do formulário; 

- Uma página de aplicativo no servidor, como uma página do ColdFusion ou JSP, que 
processa os dados do formulário, talvez os usando para pesquisar ou atualizar uma tabela 
de banco de dados e, em seguida, retornando os resultados para o navegador como 
HTML; 

- Um programa CGI (Common Gateway Interface), escrito em uma linguagem como 
Perl ou Java, que processa os dados da mesma maneira que uma página de aplicativo no 
servidor, e redireciona a solicitação para outra página HTML a ser retornada para o 
navegador. 

 
O atributo Method do formulário determina a maneira como os dados são enviados para 
o servidor. Os valores possíveis são: 

- GET: o valor padrão para HTML. Os dados do formulário são enviados na seqüência 
de caracteres de consulta da URL, como neste exemplo: 
http://www.site.com/action.cgi?name=Jane&age=33 

Em que as duas entradas de formulário name=Jane e age=33 são enviadas para 
action.cgi para processamento. 

- POST : os dados são enviados no cabeçalho HTML, invisível para o usuário. 

15.4 Validando um Formulário 
A ação Validate Form verifica o conteúdo de campos de texto especificados em um 
formulário a fim de garantir que o usuário tenha inserido as informações adequadas. Seja 
acidental ou intencionalmente, às vezes os usuários inserem informações erradas ou 
ignoram campos. Em vez de aguardar até que o formulário seja enviado, podemos 
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verificar os dados à medida que os usuários os inserirem ou antes que o formulário seja 
enviado para o servidor.  

Podemos anexar a ação a um campo de texto no formulário, que valida os campos à 
medida que os usuários digitam valores neles, ou pode anexar a ação ao botão de envio, 
que então verifica diversos campos de uma só vez. Anexar essa ação a um formulário 
impede que o usuário envie o formulário se houver erros. 

Para validarmos o formulário de uma só vez, selecione o botão “Enviar” e, no painel 
Behaviors, clique no sinal de + escolhendo a opção: Validate Form. 

Na caixa de diálogo Validate Form, selecione um campo nomeado na lista e seleciona as 
regras de validação desejadas para cada campo de texto: 

- Required: selecione se for obrigatório que o campo contenha dados; 

- Use Anything: selecione se o campo puder conter qualquer tipo de dado; 

- Use E-mail address: verifica se o campo contém o símbolo @; 

- Use Number: verifica se o campo contém somente números; 

- Use Number From: verifica se o campo contém um número em um determinado 
intervalo. 

 

 
Assim que adicionarmos um comportamento, podemos alterar o evento que ativa a ação, 
neste caso, a ação Validate Form.  

Quando adicionamos a ação Validate Form ao botão de envio, o evento que ativa a ação 
é quando o usuário clica no botão. No painel Behaviors, ação seria onClick: 

 
Se quisermos selecionar um campo de texto no formulário e anexar a ação Validate 
Form, o evento que deve ativar a ação é quando o usuário usa a tecla Tab ou passa para 
o campo seguinte no formulário a ação no painel Behaviors seria onBlur. 
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LABORATÓRIO 
TAREFA 1 
1. Abrir o arquivo principal.dwt (Template), excluir o conteúdo da Div form_busca e 
inserir um formulário através da opção Form. 

2. Inserir o campo Text Field sem label. 

3. Na propriedade Init Val digitar “Digite o que você procura” 

4. Após o campo Text Field anterior, inserir o campo List/Menu. 

5. Clicar no botão List Values... e digitar Todas as marcas. 

6.  Após o campo List/Menu anterior, inserir mais um campo List/Menu. 

7. Clicar no botão List Values... e digitar Todas as categorias. 

8. Após o campo List/Menu anterior, inserir a imagem btn_ok.gif (texto alternativo: 
OK). 

9. Criar uma New CSS Rule ( no Painel CSS Style) do tipo Class, com o nome de 
“formulário_esq” na folha de estilo site.css. 

10. Na janela CSS Rule Definition, na categoria Type, definir conforme a figura abaixo: 

 
11. Na categoria Box, definir conforme a figura abaixo: 
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12. Aplicar a classe formulario_esq nos três campos de formulários da Div form_busca. 

13. Salvar todos os arquivos. 

 
TAREFA 2 
1. Abrir o arquivo index.html, excluir o conteúdo da Div newsletter e clicar em Insert 
Div Tag. 
2. Escolher a opção At Insertion point. 
3. Clicar no New CSS Rule e colocar o nome do ID desta Div de “texto_news”. 

4. Na janela CSS Rule Definition, na categoria Box, definir o width com 145 px. 

5. Excluir o conteúdo da Div texto_new e digitar “Newsletter”. 

6. Inserir o caracter especial » antes do texto Newsletter e aplicar a classe “cor_padrao” 
no mesmo. 

7. Aplicar a classe destaque na Div text_news. 

8. Deixar o cursor dentro da Div text_news e clicar em Insert Div Tag. 
9. Escolher a opção After tag e selecionar a <div id=”texto_news”>. 

10. Clicar no New CSS Rule e colocar o nome do ID desta Div de “form_news”. 

11. Na janela CSS Rule Definition, na categoria Box, definir o width com 145 px e 
padding-top com 10 px. 
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12. Excluir o conteúdo da Div form_news e digitar o texto: “Cadastre-se e receba 
novidades da AlfaSports”. 

13. Inserir um formulário através da opção Form, da categoria Forms do Painel Insert. 

14. Inserir o campo Text Field sem label. 

15. Na propriedade Init Val digite “Nome” 

16. Após o campo Text Field, inserir mais um campo Text Field sem label. 

17. Na propriedade Init Val digitar “e-mail” 

18.  Após o último campo Text Field, inserir a imagem cadastrar.gif (texto alternativo: 
Cadastrar). 

19. Aplicar a classe formulario_esq nos dois campos do formulário da Div form_news. 

20. Salvar todos os arquivos. 
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Unidade 16 – Spry Framework 
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Unidade 16 
Spry Framework 

16.1 Menus no Dreamweaver CS4 
Com a nova versão do Dreamweaver, criar menus ficou bem mais simples e prático, 
através da aba Spry. 

O Spry é o framework da Adobe para desenvolvimento usando Ajax e está licenciado 
sob BSD License. O Spry foi projetado com a intenção de facilitar o desenvolvimento, 
ele inclui bibliotecas de código, linguagens de script e outros recursos para ajudar a 
desenvolver diferentes componentes de um projeto.  

Devemos selecionar a categoria Spry no Painel Insert. 

 
Selecionar a opção Spry Menu Bar. 

Devemos selecionar qual será a posição do menu. 

 
Observe que o Dreamweaver CS4 já montou o menu horizontal ou vertical na página: 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

226                                    2009  Alfamídia LTDA. 
 

 
Devemos clicar na guia Spry Menu Bar que esta em volta do menu na cor azul para 
mostrarmos todas as propriedades do menu 

 
1- Nome do menu. 

2- Botões para adicionar ou remover itens ao menu do primeiro nível, o sinal de mais 
adiciona e o sinal de menos remove. 

3- Botões para ordenar os itens do menu do primeiro nível. 

4- Caixa que mostrar os itens do menu do primeiro nível, selecione um item nessa caixa 
para pode mudar seu nome e adicionar um link nas etapas 7, 8 e 9. 

5- Caixa com as itens do segundo nível do menu, possui os botões para adicionar ou 
remover itens e para ordenar os itens, selecione um item nessa caixa para pode mudar 
sua configuração nas etapas 7, 8 e 9. 

6- Caixa com as itens do terceiro nível do menu, possui os botões para adicionar ou 
remover itens e para ordenamento, selecione um item nessa caixa para pode mudar sua 
configuração nas etapas 7, 8 e 9.  

7- Nome do item ou nome da opção do menu selecionado.  

8- Link do item selecionado. 

9- Título e Target do item selecionado. 

10- Botão para remover o estilo do menu.  

Agora é só personalizar o menu, conforme sua necessidade. 

Veja alguns exemplos deste menu no link: 

http://labs.adobe.com/technologies/spry/samples/menubar/MenuBarSample.html  

16.2 Tabbed Panels 
Na aba Spry, temos os Spry Tabbed Panels, os quais são um jogo dos painéis que 
podem armazenar um conteúdo em um espaço compacto. Os visores do local escondem 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

227                                    2009  Alfamídia LTDA. 
 

ou revelam o índice armazenado nos painéis tabulados fazendo aparecer à aba do painel 
correspondente. Os painéis do widget abrem conforme o usuário navega na página.  

 
http://labs.adobe.com/technologies/spry/samples/tabbedpanels/tabbed_panel_sampl
e.htm 

16.3 Accordion 
Temos também o Spry Accordion, o qual é um jogo dos painéis dobráveis que podem 
armazenar uma quantidade grande de conteúdo em um espaço. Os usuários escondem ou 
revelam o conteúdo armazenado no acordeão abrindo a aba do painel.  

 

16.4 Collapsible Panel 
Por fim temos o Spry Collapsible Panel: 
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Quando utilizamos algum recurso do Spry e posteriormente salvamos a página (ou site), 
é exibido o painel Copy Dependent Files, o qual copia para o seu site, configurado no 
Dreamweaver, os arquivos relacionados ao recurso utilizado. Além de copiar os 
arquivos, ele lhe informa quais são os arquivos e exibe um alerta para lembrar-lhe de 
enviar os arquivos para o servidor na Web: 

 
 
LABORATÓRIO 
TAREFA 1 
1. Abrir o arquivo index.html. 

2. Excluir o conteúdo da Div corpo. 

3. Clicar na opção Spry Tabbed Panels da categoria Spry do Painel Insert. 

4. Selecionar o spry que foi criado na região azul da página. 

5. Selecionar a Tab 2 no Painel Properties  e adicionar uma nova Tab através do botão 

Add panel  . 

 
6. Na Tab 1, mudar o texto para “Produtos em destaque”. 

7. Na Tab 2, mudar o texto para “Lançamentos”. 

8. Na Tab 3, mudar o texto para “Mais vendidos”. 
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9. Salvar o arquivo. 

10. Na janela abaixo, selecionar a opção Sim para Update links. 

 
O Dreamweaver cria uma pasta SpryAssets com os arquivos css e javascript necessários 
para o uso dos Sprys. 

 
 

TAREFA 2 
1. No Painel CSS Styles, clicar no + na frente da folha de estilo SpryTabbedPanels.css. 

2. Editar o estilo .TabbedPanelsTab (duplo clique sobre o estilo desejado no Painel 
CSS Styles) 

3. Na categoria Type, alterar conforme a figura abaixo: 
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3. Na categoria Background, alterar a propriedade backgruond-color para #E0E1DD. 

4. Na categoria Border, alterar conforme a figura abaixo: 
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5. Editar o estilo .TabbedPanelsTabSelected. 

6. Na categoria Type, alterar a propriedade color para #FFF. 

7. Na categoria Background, alterar a propriedade background-color para #666. 

8. Editar o estilo .TabbedPanelsContentGroup. 

9. Na categoria Background, alterar a propriedade background-color para #FFF. 

10. Na categoria Border, alterar conforme a figura abaixo: 

 
11. Editar o estilo .TabbedPanelsContent. 
10. Na categoria Box, alterar conforme a figura abaixo: 



Adobe Dreamweaver CS4 Desenvolvimento de Websites Interativos         
 

 
 

232                                    2009  Alfamídia LTDA. 
 

 
11. Salvar todos os arquivos 

 

TAREFA 3 
1. No painel Produtos em destaque, excluir o conteúdo Content 1 e clicar em Insert Div 
Tag. 
2. Escolher a opção At insertion point. 
3. Clicar no New CSS Rule e colocar o nome da Class de “produtos”. 

4. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 
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5. Na categoria Border, definir conforme a figura abaixo: 
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6. Criar mais 3 Divs ao lado desta com a mesma Class aplicada (se necessário, utilizar a 
visualização split e copiar o código <div class="produtos">Content for  class "produtos" 
Goes Here</div>). 

7. Inserir uma imagem de produto em cada das Divs. 

8. Colocar o cursor após a última div e clicar em Insert Div Tag. 

9. Escolha a opção At insertion point. 
10. Clicar no New CSS Rule e colocar o nome da Class de “texto_produtos”. 

11. Na janela CSS Rule Definition, na categoria Box, definir conforme a figura abaixo: 

 
12. Criar mais 3 Divs ao lado desta, com a mesma Class aplicada (se necessário, utilizar 
a visualização split e copiar o código <div class="texto_produtos">Content for  class 
"texto_produtos" Goes Here</div>). 

13. Salvar todos os arquivos. 
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Unidade 17 – Testando o site 

 

 

 

 

Verificando acessibilidade 

Verificando links 

Verificando a compatibilidade do Navegador 

Executando Relatórios em um site 
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Unidade 17 
Testando o Site 

17.1 Verificando Acessibilidade 
Quando terminamos de construir as páginas do site, é conveniente testar todos os 
arquivos localmente, para ter certeza de que todos os links estejam funcionando e de que 
não estão faltando arquivos. 

A verificação da acessibilidade cria um relatório que detalha os conflitos ocorridos entre 
o conteúdo e as diretrizes de acessibilidade da seção 508 do Rehabilitation Act (Lei de 
reabilitação) de 1998, dos EUA.  

É possível validar a acessibilidade do documento atual, de arquivos selecionados e do 
site inteiro. 

1- Abrir o arquivo index.html 

2- Para verificar a página atual, selecionar File > Check Page > Check Accessibility. 
O grupo de painéis Results exibe todos os avisos ou erros relacionados à acessibilidade: 

 
Clique em More Info  para abrir o painel Reference a fim de mostrar a diretriz de 
acessibilidade relevante. Também será destacada a linha do código com a violação, na 
visualização de código: 
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17.2 Verificando Links 
Links quebrados são muito desagradáveis para os usuários. Embora o Dreamweaver 
funcione bem para corrigir links quando modificamos arquivos no site, deveremos 
verificá-los antes de fazer o upload das páginas para o servidor. 

É possível verificar links no documento atual, em uma pasta dentro do site ou no site 
inteiro. O Dreamweaver só verifica os links para outros documentos no site. Os links 
externos são listados, mas não verificados. 

Quando definiu nosso site inicialmente, selecionar a verificação de links com distinção 
de maiúsculas/minúsculas. Se seu site estiver hospedado em um computador com UNIX, 
como muitos estão, convém selecionar essa opção. Ao verificar seus links, o 
Dreamweaver verifica o tamanho das letras no nome do arquivo, assim como o nome do 
caminho. 

Por exemplo, se existisse um arquivo chamado dvd.htm, um link para DVD.htm seria 
indicado como erro. 

Para alterar as definições de um site, selecione Site > Manage Sites e edite o site atual. 
Na categoria Local Info, selecione Use case-sensitive link checking. 

3- Com o mesmo arquivo aberto clicar em Site > Check Links Sitewide. 

O relatório é exibido no painel Link Checker do grupo de painéis Results: 

 
O Dreamweaver retorna diversos relatórios sobre os links existentes em sua página. Para 
ver outro relatório, selecione-o no menu pop-up Show: 

As opções de relatório são: 

- Broken Links: links quebrados; 

- External Links: links externos no site; 

- Orphaned Files: Arquivos órfãos (Orphaned files) não têm links direcionados para 
eles em outras páginas do site; portanto, esse painel só conterá dados se estivermos 
verificando o site inteiro, não uma página individual. Alguns desses arquivos podem ser 
recursos, como arquivos fonte do Fireworks (png), que convém manter dentro do site. 
Outros podem ser arquivos desatualizados, que convém excluir antes de fazer o upload 
dos arquivos para o servidor. 
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17.3 Verificando a Compatibilidade do Navegador 
Em algum momento na etapa de desenvolvimento da web, talvez seja necessário prever 
os navegadores dos usuários, com base no objetivo do site e no que já sabemos sobre 
eles. 

Geralmente, os sites de intranets são os mais fáceis, porque provavelmente existirá um 
navegador padrão na organização. 

Entretanto, até mesmo para os sites públicos, é possível fazer suposições razoáveis sobre 
os usuários. Por exemplo, se seu site fornece notícias e vende produtos relacionados ao 
desenvolvimento da Web, podemos esperar que os usuários tenham versões atualizadas 
do Internet Explorer, Netscape, Firefox ou Safari. 

A verificação dos navegadores testa o HTML existente em suas páginas, para verificar 
se alguma tag ou atributo não é suportado pelos navegadores de destino. No 
Dreamweaver, é possível verificar a compatibilidade dos navegadores de duas maneiras: 

- Usando o recurso de verificação automática de navegador; 

- Verificando manualmente a compatibilidade do navegador. 

4- Para escolher os navegadores de destino para o Dreamweaver verificar, selecionar 

Settings no menu Check Page , na barra de ferramentas do documento. 
Selecione cada navegador a ser verificado e depois a versão mínima, no menu pop-up 
correspondente. Por exemplo, na caixa de diálogo abaixo, o Firefox 1.0 e posterior, o 
Internet Explorer 5.0 e posterior, e o Netscape 6.0 e acima estão selecionados para a 
verificação de navegador: 

 
Quando clicamos em OK é exibido o painel Results e na opção Browser Compatibility 
Check são exibidos todos os erros encontrados: 
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É possível clicar duas vezes em um erro para selecionar o código que o gerou. 

17.4 Executando Relatórios em um Site 
É possível gerar relatórios do site para vários itens HTML por meio do comando 
Reports. Pode procurar tags de fonte aninhadas, Texto Alt ausente, documentos sem 
título e outros itens. Após executar o relatório, poderemos salvá-lo como um arquivo 
XML. 

5- Selecionar Site > Reports e, na caixa de diálogo Reports, escolher as opções a serem 
verificadas: 

 
Podemos verificar no documento atual, no site inteiro, em arquivos selecionados ou em 
uma pasta existente no site.  

- Checked Out By: lista de arquivos verificados por um membro da equipe; 

- Design Notes: lista de todas as notas do projeto; 

- Recently Modified: lista de todos os arquivos atualizados recentemente; 
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- Combinable Nested Font Tags: lista de tags de fonte aninhadas que podiam ser 
combinadas em uma única tag para simplificar o HTML; 

- Accessibility: lista de diretrizes ausentes da Seção 508; 

- Missing Alt Text: lista textos alternativos ausentes para imagens. Esses textos são 
importantes para atender aos padrões de acessibilidade; 

- Redundant Nested Tags: lista de tags aninhadas inúteis; 

- Removable Empty Tags: lista de tags vazias que podem ser removidas sem afetar o 
conteúdo ou o layout da página; 

- Untitled Documents: lista de documentos sem títulos. 

6- Clicar no botão Run e veja o resultado no painel Results: 

 

7- Agora é só clicar no botão Save Report  para salvar o relatório. 
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Unidade 18 – Fazendo Upload de 
arquivos 

 

 

 

 

 
 

 

 

Conectando a um site remoto 

Definindo um site remoto 

Mascarando pastas e arquivos 

Conectando-se ao servidor 

Sincronizando arquivos 
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Unidade 18 
Fazendo Upload de Arquivos 

18.1 Conectando a um Site Remoto 
Quando terminamos o teste local de nossos arquivos, temos que enviá-los para o 
servidor Web. Quando transferimos arquivos de um site local para um site remoto, o 
Dreamweaver mantém uma estrutura exata de pastas nos dois sites. Se uma pasta não 
existir no site remoto, o Dreamweaver a criará. Esse recurso assegura que os links 
relativos criados no site local continuem funcionando no site remoto, porque os sites são 
idênticos. 

Usaremos o comando Manage Sites para configurar a conexão remota. Após 
configurarmos a pasta remota e o método de conexão com o site remoto, é possível 
transferir os arquivos locais. 

1- Selecionar Site > Manage Sites. 
2- Selecionar o site que necessita da conexão remota. 

3- Clicar em Edit. 
4- Selecionar a opção FTP no item Remote Info: 

 
- FTP Host: nome Internet ou endereço IP do host de FTP; 

- Host Directory: diretório no site remoto onde seus documentos estão armazenados; 

- Login and Password: informações de acesso; 

- Use Passive FTP Usad: se a configuração do firewall exigir um FTP passivo; 
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- Use Firewall: selecione esta opção caso esteja se conectando a um servidor remoto 
protegido por firewall; 

- Use Secure FTP (SFTP): selecione esta opção se precisar criar uma conexão segura. 
O SFTP utiliza criptografia e chaves públicas para proteger a conexão com o servidor de 
teste; 

- Maintain Synchronization Information: sincronizar arquivos entre sites locais e 
remotos; 

- Automatically Upload Files to Server on Save: sempre que salvarmos um arquivo, 
será feito um upload desse arquivo para o servidor remoto; 

- Enable File Check In and Check Out: permite bloquear arquivos quando um usuário 
do grupo estiver editando um arquivo. 

18.2 Definindo um site Remoto 
À medida que trabalharmos com os arquivos no site, ocasionalmente será necessário 
mover, excluir ou renomear um arquivo. Assim que definirmos um site, convém utilizar 
o painel de arquivos para fazer mudanças em nossos arquivos. Ao fazer a manutenção 
dos arquivos no painel de arquivos, teremos certeza de que as informações de nossos 
links permanecerão corretas. 

O navegador de arquivos integrado ao painel de arquivos permite acessar os arquivos 
existentes na área de trabalho, disco rígido ou em qualquer unidade da rede local. 
Usamos o navegador de arquivos da mesma forma como utilizamos o Windows 
Explorer para mover, excluir ou renomear arquivos. 

Para utilizar o navegador de arquivos integrado, clique no menu pop-up Manege Sites. 
Podemos ver o disco rígido local e todas as unidades da rede. Selecionar a opção: 
Desktop: 

 
Clicar com o botão direito do mouse em Desktop items e selecionar New Folder menu 
contextual: 
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7- Digitar “siteremoto” como nome da pasta e pressione ENTER. 

18.3 Mascarando Pastas e Arquivos 
O mascaramento de sites permite excluir tipos de arquivos específicos e pastas de 
operações, como um Get (Obter) ou Put (Colocar). Por exemplo, não é necessário que os 
arquivos fonte do Photoshop ou do Flash fiquem no servidor. Os arquivos mascarados 
permanecem no site local e não são transferidos por upload para o servidor, a não ser 
que anulemos manualmente as configurações mascaradas. 

É possível indicar tipos de arquivos específicos para o Dreamweaver mascarar, usando a 
extensão do arquivo ou qualquer padrão existente no final do nome do arquivo. 

8- Para mascarar tipos de arquivos clicar em Site > Manege Sites > AlfaSports e clicar 
no botão Edit. 

9- No item Cloaking marcar a opção: Enable cloaking. 

10- Selecionar Cloak Files Ending With e digitar o tipo dos arquivos na caixas de 
texto. Separar os tipos de arquivos com um espaço; não utilizar vírgulas ou caracteres de 
ponto-e-vírgula: 
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11- Clicar em OK e aparecerá uma linha vermelha riscando os ícones dos arquivos que 
estarão mascarados: 

 

18.4 Conectando-se ao Servidor 
Com o site remoto definido (siteremoto), poderemos utilizar o Dreamweaver para fazer 
o upload de arquivos.  

12- Selecionar Site > Manage Sites > AlfaSports e clicar no botão Edit. 

13- Selecionar Remote Info e escolha Local/Network no menu pop-up. 
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14- Clicar no ícone da pasta. Ir até a área de trabalho e selecionar pasta “siteremoto”. 

 
15- Para exibir os sites locais e remotos simultaneamente, clicar em Expand/Collapse 

 na barra de ferramentas do painel de arquivos. 

16- Para ver os arquivos existentes no site remoto, antes de colocarmos os arquivos, 

clique em Connect . Se o painel de arquivos se expandir, veremos o site remoto à 
esquerda e o site local à direita. 

Para copiar arquivos do site local para o site remoto, Podemos usar Put ou Check In. Se 
formos à única pessoa trabalhando no site, podemos utilizar os comandos Get e Put 

 para copiar arquivos. Se estiver trabalhando em equipe, poderá utilizar o recurso 
Check In/Check Out para copiar arquivos. 

17- Selecionar a pasta “AlfaSports”, que será copiada para o site remoto e clique em Put 
Files . Se não existir uma conexão estabelecida, o Dreamweaver se conectará ao site 
remoto e depois copiará os arquivos: 
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18.5 Sincronizando Arquivos 
Assim que fizermos o upload dos arquivos locais para o site remoto, poderemos 
sincronizar os arquivos entre os dois sites. Essa ação só faz o upload dos arquivos mais 
recentes, modificados localmente. 

17- Para sincronizar os arquivos devemos selecionar: Site > Synchronize Sitewide: 

18- Na caixa de diálogo Synchronize Files, escolher entre sincronizar arquivos 
selecionados ou o sistema inteiro no menu pop-up Synchronize. 

Escolher a opção desejada no menu pop-up Direction. As opções são: 

Put newer files to remote, Get newer files from remote ou Get and Put newer files. 

 
4. Clicar em Preview para iniciar o processo. 
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É exibido um relatório dos arquivos que precisam ser sincronizados. Assim, podemos 
atualizar todos os arquivos ou desmarcar os arquivos na lista. 

Quando clicarmos em OK, todos os arquivos selecionados serão atualizados: 
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Unidade 19 – Anexo 1 – Principais Tags 
HTML 
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Unidade 19- Anexo 1 
Principais Tags 

Neste anexo apresentamos todas as tabelas de tags HTML apresentadas nas unidades 
anteriores, para facilitar a consulta: 

 
TAG O QUE FAZ 

<!-- comentários --> Insere comentários nas páginas 

<html> Toda página HTML deve estar entre o tag de início de um 
documento HTML e o tag de fim deste documento.  

<head> Envolvem a seção de cabeçalho do documento, no qual são 
especificadas informações que não são exibidas na página, 
como título do documento e informações sobre o assunto da 
página. 

<title> Indica o título do documento para o Browser. Geralmente os 
Browsers apresentam este título na barra de título da sua 
Janela no Windows 

<body> Envolvem a seção de corpo do documento. Aqui fica o 
conteúdo principal da Home Page. Opcionalmente podemos 
indicar um arquivo de imagem para formar o fundo, usando 
a opção: BACKGROUND. 

<br> Insere uma quebra de linha 

 
TAG O QUE FAZ 

<hn> Marca um título. Sendo que “n” representa um valor que 
pode ser de 1 a 6, o tamanho muda de forma decrescente, 
ou seja, o número 1 é o maior tamanho do título. 

<hr> Insere uma linha horizontal 

<p> Marca um parágrafo 

<strong> Coloca o texto em negrito 

<em> Coloca o texto em itálico 

<font> Modifica a formatação do texto. 

Atributos: 

Size = define o tamanho da letra. Ex: <font 
size=5>Texto</font> 

Face = define o estilo da letra. Ex: <font 
face=verdana>Texto</font> 
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Color = define a cor da letra. Ex: <font 
color=red>Texto</font> 

 

 
TAG O QUE FAZ 

<ol> Marca o início e o fim de uma lista ordenada. Recebem na 
primeira linha um número ou letra.  

Atributos: 

Start = especifica o número a partir do qual os itens 
começam a ser contados. Ex: <ol start=3> 

Type = modifica o tipo do numerador que pode ser: número, 
letras ou algarismo romano. 

<ul> Marca o início e o fim de uma lista não ordenada, ou seja, 
os itens da lista recebem símbolos na primeira linha.  
 

Atributos 

Type = modifica o tipo do marcador (símbolo), que pode ser:  

Circle = um círculo vazio.               

Disc =  um círculo cheio.                

Square = um quadrado cheio         

<li> Marca um item de uma lista, ordenada ou não ordenada. 

 
TAG O QUE FAZ 

<img> Insere uma imagem 

Atributos 

src  indica o nome da imagem a ser carregado. 

align=middle  centraliza o base do texto com o centro da 
imagem 

align=left  faz a imagem flutuar a esquerda enquanto o texto 
circunda imagem à direita. 

align=top  alinha o texto no topo  

align=right faz a imagem flutuar a direita enquanto o texto 
circunda imagem à esquerda. 

alt=”n” indica o texto para ser exibido quando o navegador 
não exibe a imagem. Sendo que n é o título que identifique 
a imagem. 

Exemplo: <img src=fig.jp alt= “Esta é uma imagem legal” > 
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TAG O QUE FAZ 

<a> Define um link  

Atributos 

Href: indica o endereço do link. 

Target: define onde o link será aberto: _blank define que 
será aberta uma nova janela. 

 
TAG O QUE FAZ 

<table> Define uma tabela. Antes e depois de uma tabela, acontece 
sempre uma quebra de linha. 

Atributos 

Border: define espessura da borda da tabela 

Cellspacing: espaço entre cada célula 

Cellpadding: distância entre borda e conteúdo de cada 
célula. 

Width: largura da tabela, em pixels ou valor percentual. 

<tr> Define uma linha normal da tabela (table row). 

Atributos 

Align: valores left, right e center definem o alinhamento 
horizontal. 

Valign: valores top, middle e bottom definem o alinhamento 
vertical. 

<td> Esta é a marcação que define cada célula de uma tabela. 
As células de uma tabela devem sempre aparecer entre as 
marcações de linhas (<tr> e </tr>). Como padrão, o texto 
nas células é alinhado a esquerda.  

Atributos 

Align: valores left, right e center definem o alinhamento 
horizontal. 

Valign: valores top, middle e bottom definem o alinhamento 
vertical. 

Nowrap: não há quebra de linhas dentro das células 

Colspan: número de colunas que a célula irá ocupar 

Rowspan: número de linhas que a célula irá ocupar 

Width: largura da célula, em pixels ou valor percentual 
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<th> Desta forma são definidos os títulos de uma tabela. Estes 
podem ser posicionados em qualquer célula. A diferença 
entre a marcação de célula e título de célula é que o título 
aparece em negrito. 

Atributos: os mesmos apresentados acima, para td 

 
TAG O QUE FAZ 

<form> Define um formulário 

Atributos 

method: get, que envia as informações na própria URL, ou 
post, que envia de forma não visível para o usuário 

action: url que será chamada, a priori um aplicativo capaz 
de tratar os dados enviados pelo formulário (PHP, ASP, 
JSP). 

<input> Define uma entrada de dados 

Atributos 

Type: text, campo tipo texto; password, para senhas; 
hidden, não aparece para o usuário; checkbox, para 
marcar; radio, para escolher entre um conjunto de opções. 
submit cria um botão para enviar os dados e reset um 
botão para limpar o formulário. 

Name: nome do campo 

Value: valor pré-definido para o campo 

Size: tamanho do campo a ser exibido 

Maxlength: tamanho máximo de caracteres 

Checked: para campos checkbox e radio, define como 
marcado 

<textarea> Define uma entrada de texto com várias linhas 

Atributos 

Rows: número de linhas 

Cols: número de colunas 

<select> Define uma lista de opções para selecionar 

Atributos 

Name: nome do campo 

Multiple: permite selecionar vários campos da lista 

Site: define o número de linhas a serem exibidas  
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<option> Item de uma lista aberta 

Atributos 

Value: valor do campo se este item for selecionado 

Selected: indica que este valor está selecionado 
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Unidade 20- Anexo 2 
Layouts 

Página index.html 
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